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Introduction
This guide describes end-user tasks for the Siebel Sales application. Managers and 
administrators of Siebel applications should also read this book to understand the 
impact of their configuration and implementation decisions.

Specialized applications administration tasks are covered in a number of other 
books. See the Siebel Bookshelf CD-ROM.

This guide is primarily useful to people whose title or job description matches one 
of the following:

Sales 
Professionals

Persons who use Siebel Sales to manage sales leads, opportunities, 
accounts, quotes, proposals, and so on.

Database 
Administrators

Persons who administer the database system, including data 
loading, system monitoring, backup and recovery, space 
allocation and sizing, and user account management.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel Application 
Developers 

Persons who plan, implement, and configure Siebel applications, 
possibly adding new functionality.

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel applications. 
Version 7.5, Rev. A Siebel Sales User Guide 11



Introduction

How This Guide Is Organized
How This Guide Is Organized
This guide includes general information and procedures for Siebel Sales end users. 
Information included in this guide can also help administrators and application 
developers who need to understand the Siebel Sales application to customize it.

Chapters are organized according to a typical sales methodology process flow:

■ Prospecting. These chapters include procedures for managing contacts, 
accounts, opportunities, and D&B integration.

■ Qualification. These chapters include procedures for managing decision issues, 
competitors and products.

■ Managing a Customer Relationship. These chapters include procedures for 
managing activities, correspondence, literature, categories, and messages.

■ Proposing a Solution. This chapter includes information on proposals, 
presentations, quotes and orders.

■ Closing. These chapters include information on establishing referenceable 
accounts, Target Account Selling, the Enterprise Selling Process, and Strategic 
Selling sales methodologies.
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Introduction

Additional Resources
Additional Resources 
The following Siebel application guides contain information relevant to your use of 
Siebel Sales:

■ For information on administrative procedures and tasks, see Applications 
Administration Guide.

■ For information on campaigns, see Siebel Call Center User Guide. 

■ For information on list management, see Siebel Marketing Guide. 

■ For information on SmartScripts, see Siebel SmartScript Administration Guide.

■ For more information on quotes and orders, see Siebel Order Management Guide.

■ For information on forecasting, see Siebel Forecasting Guide.

■ For information on creating agreements which specify the terms and conditions 
of a sale, see Siebel Field Service Guide.

■ For development resources and information, see Siebel Tools Reference and Siebel 
Tools Online Help.
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Introduction

Revision History
Revision History
Siebel Sales User Guide, Version 7.5, Rev. A

January 2003 Bookshelf
Table 1. Changes Made in Rev. A for January 2003 Bookshelf

Topic Revision

“Associating a Contact with an Account” on 
page 41

Added information about deleting a 
contact record in the Accounts screen’s 
Contacts view.

“Assessing an Opportunity” on page 71 Added substep to Step 3, noting that an 
explicit save is required after selecting 
an assessment template. Removed 
repeated information.

“Opportunity Charts” on page 86 Removed section, Querying for Sales 
Method Chart, and amplified steps to 
include required queries in Viewing the 
Opportunity Sales Pipeline Analysis 
Chart, and Viewing the Sales Pipeline 
Phases Analysis Chart sections.

Chapter 18, “Enterprise Selling Process” Added amplification to introductory text 
to underscore that the ESP module is 
designed to support users who are 
already familiar with the ESP 
methodology. 

“Using ESP Methodology to Manage Accounts” 
on page 250

Edited intro to define support.

Chapter 19, “Target Account Selling” Changed TAS view tab reference to 
Target Account Selling view tab to 
reflect User Interface change.

“Using Target Account Selling to Manage 
Opportunities” on page 274

Headline was incorrect.

“Developing Strategy with TAS Competitive 
Analysis” on page 283

Added amplification text after Step 7 in 
procedure, To add competitive analysis 
information.
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Revision History
“Using the TAS Coach for Competitive 
Analysis” on page 284

Added additional information to first 
paragraph in section.

Revised Step 8 in procedure, To use the 
TAS Coach for competitive analysis, to 
correct method used to return to 
assessments view.

Revised information in paragraph after 
Step 8.

“Conducting an Organizational Analysis” on 
page 286

Revised text in first paragraph.

In procedure, To create the 
organizational map:

■ Revised last sentence of Step 1, 
substituting contacts for customers.

■ Revised Step 2 to correct drag-and-
drop method for contact node.

In procedure, To delete contacts on the 
Organizational Map, added note that 
contacts are only removed from the 
map, not the Contacts list.

“Adding Customer Milestones” on page 291 In Step 4 of procedure, To add a 
milestone, added a note in Step 4 to 
advise user to save the selected Event 
type.

Table 1. Changes Made in Rev. A for January 2003 Bookshelf

Topic Revision
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Additional Changes
■ Overview section for each chapter removed. Information was incorporated in 

the chapter introduction text, or elsewhere in the chapter.

■ Appendix A, Common Views, removed as the information is carried in other 
books on the Bookshelf.

■ Business scenarios edited, and minor edits throughout book completed 
according to Siebel document style guidelines.

“Developing a Relationship Strategy” on 
page 294

Revised first paragraph, removing 
account reference, since 
relationshipship strategy involves key 
players for an opportunity.

In procedure, To add relationship 
strategy information, added a note after 
Step 6 to amplify step.

In procedure, To add decision criteria, 
added a note about creating a custom 
record.

“Viewing PRIME Activities” on page 296 Added a paragraph noting relationship 
between activities created in PRIME 
activities and opportunity activities.

Table 1. Changes Made in Rev. A for January 2003 Bookshelf

Topic Revision
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Overview 1
This chapter explains how a typical sales organization is structured, the sales 
workflow process, and a typical sales organization’s goals and strategies.
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The Sales Organization
The Sales Organization
The primary purpose of a sales organization is to increase revenues while 
maximizing profits. The sales process varies by organization. However, certain 
similarities do exist. Siebel Sales allows each organization to adapt its usage to 
current business needs, while building on similarities in practices found across 
many sales organizations.

Siebel Sales assists sales professionals throughout the entire sales cycle with tools 
and information that help the sales team manage opportunities, the sales pipeline, 
customer profiles, accounts, products, pricing, competitors, decision issues, and 
sales brochures, data sheets, and presentations.
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Sales Strategy
The workflow shown in Figure 1 describes the sales process. Sales strategy and 
prospecting begin the pipeline process, followed by leads qualification, 
opportunities management, customer proposals, and closing the deals.

Siebel Sales provides the sales professional with a view of each customer interaction 
across multiple channels including the Web, call center, field service, and partner 
organizations. Using Siebel Sales, the sales team has the account, contact, and 
history information it needs to make better decisions. 

Siebel Sales offers tools for each sales task. These tools include:

■ Contacts and Accounts management

■ Opportunities

■ Quotes

■ Correspondence and Literature

■ Activities

■ D&B

■ Proposal and Presentation generation 

■ Support for Target Account Selling, Strategic Selling, and Enterprise Selling 
Process methodologies.

Figure 1. Sales Process Workflow
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Sales Goals and Strategies
Table 2 shows a typical sales organization’s goals and corresponding strategies. An 
example of a goal is maximize profits. The corresponding strategy is instituting 
uniform sales methods and practices.

Table 2. Typical Sales Organization Goals and Strategies

Goal Strategy

Sell products and services Generate new sales opportunities

Shorten sales cycle Deliver a well-trained sales force

Maximize profits Institute uniform sales methods and practices

Maximize customer satisfaction Build and maintain relationships with existing 
customers
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Contacts are individuals with whom your company conducts business or expects to 
conduct business in the future. These individuals can be employees of other 
companies, independent consultants, vendors, or personal acquaintances. Contacts 
can be associated with several accounts, but a contact is the primary on only one 
account. Contacts can also be associated with a number of opportunities.

This chapter describes how sales professionals can use the Contacts screen to 
record information about individuals who interact with their company.
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Business Scenario for Contacts
This scenario provides an example of a business process performed by a sales 
representative managing new and existing contacts. Your company may follow a 
different process according to its business requirements.

In the course of a business day, a sales representative interacts with other 
professionals. These formal and informal exchanges can result in potential leads or 
sales opportunities. 

A sales representative determines if her company has done business with a 
particular company by reviewing account and contact records. In cases where 
contacts are not listed, the sales representative creates new contact records in the 
Siebel Sales application, and associates the contacts with new or existing accounts.

If the possibility of doing business—an opportunity—arises, the sales representative 
creates the opportunity and associates activities and contacts with the opportunity. 
This helps the sales representative track important milestones for obtaining and 
closing deals.
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Adding a Contact
When a sales representative identifies an individual as a possible source for leads, 
that individual’s information is added to Siebel Sales as a contact. Team members 
can access this contact information while they are working on potential business 
opportunities. 

A contact team is a group of employees or partners who can view the contact 
information in the My Contacts view. If you work in a Mobile Web Client 
environment and are a member of the contact team, the contact information is 
downloaded to your local database the next time you synchronize. 

Use the following procedure to add a contact record.

To add a contact

1 Navigate to the Contacts screen.

2 In the Contacts list, add a record, and complete the fields.

A contact record only appears on the My Contacts view if you are on the contact 
team for the contact.

Click the show more button to display additional fields in the More Info form.

The following table describes some of the fields in the Contact form.

Field Comments

Account Displays the account with which the contact is 
associated.

Address Line 1 Inherits the primary address for the account associated 
with the contact. You cannot add address information in 
this field.

Comments A text field that shows any additional information 
associated with the contact.

Contact Method A list of values established by your company that is used 
to define the contact’s preferred method of interaction. 
Default values include Email, Fax, Pager, and Phone.
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Contact Team A default value based on your user ID. After you create a 
contact, you are automatically listed as the primary team 
member. You can add individuals to the contact team by 
selecting them from the employee list. Only a manager or 
administrator can change the primary contact team 
member, or can delete the primary contact team member.

Disable Cleansing A check box which, when selected, does not allow data 
cleansing.

Employee Flag If checked, this flag indicates that the contact is an 
employee of your company.

First Name A required field that displays the contact’s first name.

Global Owner Displays the name of the team member who is the global 
account owner. In cases of multinational or global 
companies, this designates one main account team 
member to oversee the account.

Households Displays the household to which the contact is affiliated. 
Households allow you to track and target contact 
affiliations, and often these contacts share an address. For 
more information on Households, see Siebel Call Center 
User Guide.

Job Title A text field that displays the contact’s professional title.

Last Name A required field that displays the contact’s last name.

Lock Assignment A check box which, when selected, locks the contact 
team assignment from reassignment by Siebel 
Assignment Manager.

Manager Last Name Displays the manager’s last name. This field must be 
populated before you can perform an organizational 
analysis. For more information, see Chapter 4, 
“Opportunities.”

Middle Initial An optional field that displays the contact’s middle initial.

Never Call A check box which, when selected, indicates that the 
contact should not be telephoned as a method of contact.

Never Email A check box which, when selected, indicates the contact 
does not want to receive email.

Field Comments
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Contact Team A default value based on your user ID. After you create a 
contact, you are automatically listed as the primary team 
member. You can add individuals to the contact team by 
selecting them from the employee list. Only a manager or 
administrator can change the primary contact team 
member, or can delete the primary contact team member.

Disable Cleansing A check box which, when selected, does not allow data 
cleansing.

Employee Flag If checked, this flag indicates that the contact is an 
employee of your company.

First Name A required field that displays the contact’s first name.

Global Owner Displays the name of the team member who is the global 
account owner. In cases of multinational or global 
companies, this designates one main account team 
member to oversee the account.

Households Displays the household to which the contact is affiliated. 
Households allow you to track and target contact 
affiliations, and often these contacts share an address. For 
more information on Households, see Siebel Call Center 
User Guide.

Job Title A text field that displays the contact’s professional title.

Last Name A required field that displays the contact’s last name.

Lock Assignment A check box which, when selected, locks the contact 
team assignment from reassignment by Siebel 
Assignment Manager.

Manager Last Name Displays the manager’s last name. This field must be 
populated before you can perform an organizational 
analysis. For more information, see Chapter 4, 
“Opportunities.”

Middle Initial An optional field that displays the contact’s middle initial.

Never Call A check box which, when selected, indicates that the 
contact should not be telephoned as a method of contact.

Never Email A check box which, when selected, indicates the contact 
does not want to receive email.

Field Comments
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Never Mail A check box which, when selected, indicates that the 
contact does not want to receive mail from your company.

Organization A default value displaying the name of the organization 
to which you belong. Your system administrator sets up 
organizations in your Siebel application. You can 
associate multiple organizations with an opportunity, but 
your organization is listed as the default organization.

Send Email Updates A check box which, when selected, indicates that the 
contact is willing to receive email updates about products 
and services.

Status Examples are Active, Qualified, Marked for Deletion.

    
 
 

     
  
  
 

Time Zone Displays the time zone in which the contact works or 
lives.

Field Comments
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Associating a Contact with an Account
A contact can be associated with one or more accounts, although the contact is 
designated as the primary on only one account. Use the Accounts view to list 
accounts associated with a contact.

To associate a contact with an account

1 Navigate to the Contacts screen.

2 In the Contacts list, select the contact, and then click the Accounts view tab.

3 In the Accounts list, click New.

4 In the Add Accounts dialog box, select the account associated with the contact, 
and then click OK.

In the Add Accounts dialog box, click New to add a new account.
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Associating a Contact with an Opportunity
A contact can be a source of revenue for the organization. Potential revenue-
generating events are called opportunities. You can associate a contact with an 
opportunity to track information about both the opportunity and the contact.

To associate a contact with an opportunity

1 Navigate to the Contacts screen.

2 In the Contacts list, select the contact, and then click the Opportunities view tab.

3 In the Opportunities list, click New.

4 In the Add Opportunities dialog box, select the opportunity to associate with the 
contact, and then click OK.
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Associating Attachments with a Contact
An attachment is a file created in another application that you can associate with a 
contact record. Documents can be attached to contact records to maintain an 
interaction history for the contact or the opportunity. Attachments can include 
email correspondence, pending contracts, and product data sheets. Associating 
attachments with a contact record allows the sales team to share information about 
the contact.

To associate an attachment with a contact

1 Navigate to the Contacts screen.

2 In the Contacts list, select the contact, and then click the Attachments view tab.

3 In the Attachments list, click New.

The Update File check box is automatically selected as a default. If you do not 
want the attached file automatically updated as the source file changes, clear the 
check box.

4 In the Attachment Name field, click the select button.

5 In the Add Attachment dialog box, click Browse.

6 In the Choose File dialog box, select the file, and then click Open.

7 In the Add Attachment dialog box, click Add.

The attachment appears in the Attachments list.
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Promoting a Personal Contact to a Sales Contact
Contact records can be promoted from the My Personal Contacts view to the My 
Contacts view.

To promote a contact from My Personal Contacts to My Contacts

1 Navigate to the Contacts screen.

2 From the Show drop-down list, choose My Personal Contacts.

3 In the Contacts list, select the contact for promotion.

4 In the Contact form, click the show more button to display additional fields.

5 In the Contact form, clear the check box in the Private field.

The Contact record appears in the My Contacts list.

NOTE: You cannot designate a contact as Private (My Personal Contacts) from the 
My Contacts list.
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Creating a Profile for a Contact
A profile consists of information that is collected about a contact. This information 
can include a contact’s expenditure approval, hobbies, education, and the name of 
the contact’s spouse.

To create a profile

1 Navigate to the Contacts screen.

2 In the Contacts list, select the contact, and then click the Profile view tab.

3 In the Profile form, complete the fields.
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Updating Contact Information in External Systems
If the Siebel administrator has set up real-time integration of contacts between 
Siebel Sales and a back-office system or other systems in your organization, you can 
use the Update External System command to send new and modified contact 
information from Siebel Sales to another system.

This Application Services Interface (ASI) feature allows a real-time contact data 
update between Siebel and a third-party external system, maintaining consistent 
customer information across the enterprise and eliminating manual entry of 
customer data in multiple systems.

The Update External Systems command also can be used to synchronize account 
data with external systems. For more information, see “Updating Account 
Information in External Systems” on page 46.

This procedure assumes that the Siebel administrator has completed the work 
necessary to allow real-time contact integration through ASI. For information about 
how to set up the Web services administration to communicate with the external 
system, ASI structures, configuring and customizing the ASI, see Application 
Services Interface Reference and Applications Administration Guide.

To update contact information in an external system

1 Navigate to the Contacts screen.

2 In the Contacts list, add a new record and complete the fields.

3 (Optional) Click the Accounts view tab.

4 (Optional) In the Accounts list, click New, and then complete the fields to 
associate an account with the contact.

5 In the Contacts list, click the menu button, and then choose Update External 
System.
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Accounts 3
An account represents the relationship between a company and the companies or 
individuals with whom it conducts business. Sales representatives use the Accounts 
screen and its associated views as the primary navigation tool for customer 
interactions.

This chapter describes how sales professionals can use the Accounts screen to 
create new customer accounts, modify and add account information for existing 
customers, respond to customer inquiries, and view account information.
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Business Scenario for Accounts
This scenario provides an example of the business process performed by a sales 
representative managing new and existing accounts. Your company may follow a 
different process according to its business requirements.

At a vendor site, a sales representative meets a prospect. After a brief discussion, 
the sales representative determines that the prospect is interested in learning more 
about the products and services that the sales representative’s company sells. The 
sales representative sets up a sales call with the prospect.

During the sales call, the sales representative asks a number of questions to 
determine the account structure of the prospect’s business and to decide how best 
to meet the prospect’s needs.

The sales representative learns that the prospect’s business has four locations, and 
that each service is billed through the main office, and each location receives a 
billing statement. 

After the meeting, the sales representative returns to the office and begins creating 
the account structure for the prospect’s business.
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Business Scenario for Global Accounts
This scenario provides an example of the business process performed by a sales 
representative managing new and existing global accounts. Your company may 
follow a different process according to its business requirements.

A large multinational corporation has three major subsidiaries. Each subsidiary has 
two child companies. The Global Accounts Manager plans to review all 
opportunities at the multinational company and its subsidiaries. 

Account records have already been created for the multinational corporation and its 
subsidiaries and the company’s administrator has already created the Global 
Account hierarchy.

The Global Accounts Manager navigates to the Accounts screen, and selects the 
Global Accounts view tab. In this view, the manager can see the opportunities for 
the multinational corporation and its subsidiaries.
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After a business relationship is identified, you can enter the details about the 
account. As account details evolve or change, you can update the account 
information. Before adding a new account, search the accounts list to make sure the 
account does not already exist.

To create an account

1 Navigate to the Accounts screen.

2 In the Accounts list, create a new record and complete the fields.

Click the show more button to view additional fields.

The following table describes some of the fields.

Field Comments

Account Type A list of values established by your company defines the 
type of account. Default values include Commercial, 
Competitor, Consultant, and Customer.

Assignment Area Code Displays an area code for the account. This indicates 
that a sales representative from the same area code 
should be assigned to the account.

Assignment Country Code Displays a country code for the account. This indicates 
that a sales representative from the same country code 
should be assigned to the account.

PO Auto-Approval Limit The amount for which a Purchase Order can be 
automatically approved.

Competitor A check box which, when selected, indicates the 
account is a competitor.

Current Volume Displays a monetary amount that represents the 
account’s current sales volume.

Disable Cleansing A check box which, when selected, does not allow data 
cleansing.
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Domestic Ultimate DUNS Displays the D-U-N-S number for the domestic ultimate, 
which is the highest member in the hierarchy for the 
same business entity within the same country. A case 
can be its own domestic ultimate.

DUNS# The Data Universal Numbering System (D-U-N-S) 
numeric serial number for a company. The D-U-N-S 
number is unique for each company.

Expertise A list of values established by your company that 
defines the area of expertise for the account. Default 
values include Technology, Quality Control, and Client 
Management.

Global Owner Displays the ID of the team member who is the global 
account owner. In cases of multi-national or global 
companies, this designates one main account team 
member to oversee the account.

Global Ultimate DUNS Displays the D-U-N-S number for the global ultimate, 
which is the highest member in the hierarchy for the 
same business entity worldwide.

Inventory Location Displays the physical location of the inventory.

Lock Assignment A check box which, when selected, locks the sales team 
assignment from reassignment by Siebel Assignment 
Manager.

Name A required value that identifies the account.

Organization Displays the name of the organization with which the 
account is associated in your Siebel application.

Parent Displays a parent account if the account is a subsidiary 
of a larger company.

Parent/HQ DUNS D&B number for the account's parent account.

Partner A check box which, when selected, indicates the 
account is a business partner.

PO Approval Limit Displays a monetary limit up to which a PO is approved.

PO Approved A check box which, when selected, indicates the 
Purchase Order (PO) has been approved.

Field Comments
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NOTE: When a company change names or merges with another company, you must 
transfer account names and contacts to the new account name. Contact Siebel 
Technical Support or your implementation team for more information on how to 
rename an account.

Potential Volume Displays a monetary amount that represents the 
account’s potential sales volume.

Price List Displays a price list associated with the account. Your 
application administrator establishes price lists based 
on criteria defined by your company.

Reference A check box which when selected indicates the account 
offers a reference for your company’s products or 
services.

Referenceable as of Displays the date when the account first became a 
reference

Shipping Information A text field for additional shipping details.

Shipping Terms A list of values established by your company that 
defines the terms for shipping. Default values include 
Due, FOB, TBD, and No Charge. 

Stage A list of values established by your company that 
defines the account stage according to your sales or 
other methodology. Default values include Project 
Planning and Strategy, Analysis and Design, Testing and 
Production Pilot, Rollout, and On Hold.

Status A list of values established by your company that 
defines the account status. Default values include 
Active, Contract Pending, Gold, and Inactive.

Synonyms Displays a synonym for the account.

URL Displays the Universal Resource Locator (URL) for the 
account Web site.

Field Comments
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Associating a Contact with an Account
As you work with a prospective account, you develop business relationships with 
the contacts associated with an account. 

Contacts can belong to multiple accounts, only one of which can be the primary 
account. Deleting a contact record in the Accounts screen’s Contacts view only 
removes the contact’s association with the account. The original contact record is 
still available in the Contacts list. 

To associate a new contact with an account 

1 Navigate to the Accounts screen.

2 In the Accounts list, select the account, and then click the Contacts view tab.

3 In the Contacts list, click New, and complete the fields for the contact.

To associate an existing contact with an account

1 Navigate to the Accounts screen.

2 In the Accounts list, select the account, and then click the Contacts view tab.

3 In the Contacts list, click Add.

4 In the Add Contacts dialog box, enter query criteria for the contact, and then 
click Go.

5 Select the contact to add, and then click OK.

To update an external system with an account contact

1 Navigate to the Accounts screen.

2 In the Accounts list, select an existing account, and then click the Contacts view 
tab.

To create a new account, see “Creating an Account” on page 38.

3 In the Contacts list, select the contact.

4 In the contact record, drill down on the contact name hyperlink, and then in the 
contact form, complete any additional fields. 

5 In the Contact form, click the menu button, and then choose Update External 
System.
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Associating an Account with an Activity
An activity is a task or event that is generally, but not always, performed for a 
contact, an account, or an opportunity. You will most likely attend meetings, calls, 
presentations, and perform other activities associated with an account. You can use 
the Activities list to enter and track account-related activities. If the activity has a 
time associated with it, the activity appears in the Activities list and Calendar. For 
more information, see Chapter 9, “Activities.”

An account can have a number of activities associated with it. You can associate an 
activity with an account to track which activities you have completed and track 
those you want to accomplish in the future as you manage the account relationship.

To associate an account with an activity

1 Navigate to the Accounts screen.

2 In the Accounts list, select the account associated with the activity, and then 
click the Activities view tab.

3 In the Activities list, add a new record and complete the fields.

a In the Type field, drill down on the hyperlink for the default value to change 
the type of activity. 

b In the Display In field, choose the display method for the activity.

For example, the activity can appear in Calendar and Activities, To Do and 
Activities, and Activities Only.
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Associating an Account with an Opportunity
Accounts are a source of business for your company. An opportunity is a potential 
revenue-generating event and the opportunity record stores information that you 
can use to manage accounts.

To associate an account and an opportunity

1 Navigate to the Accounts screen, and in the Accounts list, select the account.

2 Click the Opportunities view tab.

3 In the Opportunities list, add a new record and complete the fields.

The Account field and the Primary (team member) field are automatically 
populated. The Close Date field value defaults to the opportunity creation date.

To display more fields, in the Opportunities list click the menu button and then 
choose Columns Displayed.

The following table describes some of the fields.

Field Comments

Account A value inherited from the selected account. 

Close Date Allows you to enter the expected date on which the opportunity 
closes. The default date is the opportunity creation date. Modify 
the close date if the opportunity closes on a different date, 
because this date is used in revenue forecasting.

Name Displays the name of the opportunity.

Primary Displays your User ID when you create the opportunity. This 
value can be changed. For more information see, Chapter 4, 
“Opportunities.”

Priority Flag A check box which indicates that an account is a high priority 
(urgency for sales team). When the priority is set by selecting the 
check box, a flag appears in the priority column.
Version 7.5, Rev. A Siebel Sales User Guide 43



Accounts

Associating an Account with an Opportunity
For more information about opportunities, see Chapter 4, “Opportunities.”

Revenue Allows you to enter the currency amount of the opportunity. This 
field defaults to zero. 

Sales Stage A list of values established by your company that defines the 
sales stages associated with the sales method you selected.

Field Comments
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Performing Account Assessments
Account assessments can be used to compare accounts to one other, compare them 
to a model, or to determine what information is present or not for an account. You 
complete the assessment by selecting the appropriate values for the different 
opportunities.

To perform an account assessment

1 Navigate to the Accounts screen.

2 In the Accounts list, select the account, and then click the Assessments view tab.

3 In the Assessments list, add a new record, and then complete the fields.

a In the Template Name field, click the select button.

The Select Assessment Template dialog box appears.

b Select the template, and then click OK.

4 Click the Assessment Attribute subview tab, and then click the show more 
button.

■ In the Value field, click the select button and then select the appropriate 
value for the account.

A composite assessment score for the account appears as a percentage value in 
the parent Assessment list. This percentage compares the score you entered in 
the assessment attribute line items to the maximum possible score for the 

account. You can use this percentage to profile the account.

NOTE: Your application administrator sets up the assessment templates based on the 
criteria defined by your company. For more information on administering 
assessment templates, see Applications Administration Guide.
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Updating Account Information in External Systems
If your Siebel administrator has set up real-time account integration between Siebel 
Sales and a back-office system or other systems in your organization, you can use 
the Update External System command to send new and modified account 
information from Siebel Sales to another system in real-time.

This Application Services Interface (ASI) feature allows you to initiate a real-time 
account data update between Siebel and external system, maintaining consistent 
account information across the enterprise and eliminating manual entry of account 
data in multiple systems.

By default, in the Accounts screen, the Update External System command triggers 
the business process Synchronize Account ASI. This business process sends 
account information to the external system, and updates Siebel with the response 
from the external system. This business process can be viewed by navigating to the 
Business Processes screen from the Site Map, and querying for the business process 
name.

The following procedure explains how to send account information from Siebel 
Sales to another system. The contacts that are associated with the account must 
sent separately to the external system. For more information, see “Updating Contact 
Information in External Systems” on page 33. 

This procedure assumes that your Siebel administrator has completed the work 
necessary to allow real-time account integration through ASI. For information about 
how to set up the Web services administration to communicate with the external 
system, ASI structures, configuring and customizing the ASI, see Application 
Services Interface Reference and Applications Administration Guide.

To synchronize account information with an external system

1 Navigate to the Accounts screen.

2 In the Accounts list, select an account record.

To create a new account record, see “Creating an Account” on page 38.

3 In the Account list, click the menu button, and then choose Update External 
System.
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Viewing Account Credit Profiles
If your organization uses back-office software or another external credit 
management system to store customer credit information, you can use the Credit 
Profile read-only view to get the most current account credit profile information.

The Accounts screen’s Credit Profile view allows you to improve employee 
productivity by providing visibility to complete customer information within your 
Siebel application, and streamlines the quote-to-cash process by allowing the sales 
professional to identify potential credit problem early.

This procedure assumes that your Siebel administrator has completed the work 
necessary to allow real-time account integration through Application Service 
Interfaces (ASI). For information about how to set up the Web services 
administration to communicate with the external system, ASI structures, 
configuring and customizing the ASI, see Application Services Interface Reference 
and Applications Administration Guide.

To view account credit profile information

1 Navigate to the Accounts screen.

2 In the accounts list, select the account, and then click the Credit Profile view tab.

The Credit Profile form appears, and includes information on credit status, risk 
category, credit limit, and so on.

Fields in this form are read-only, except for the Skip Credit flag check box and 
Credit Auto Approval Limit. For more information on how to use these fields, see 
Siebel Order Management Guide.

3 Click Refresh to update the information in the Credit Profile form.
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Viewing Global Accounts 
Available as an option, Global Accounts allow users to see opportunities, activities, 
contacts, and account team information for an account and its subsidiary accounts. 

Global Accounts consist of a parent account, the child accounts, the child accounts’ 
children, and so on. These hierarchies are determined in one of two ways:

■ Hierarchies are determined by the value in the parent field on the Account 
Record.

■ Hierarchies are determined by the administrator who creates custom hierarchies. 

Global Accounts are created and maintained by the administrator. If an account has 
no child account or the administrator has not defined a hierarchy for an account, 
then a message appears advising you that the selected record is not included as part 
of your defined hierarchy.

For more information on creating Global Accounts and account hierarchies, see 
Applications Administration Guide.
48 Siebel Sales User Guide Version 7.5, Rev. A



Accounts

Viewing Global Accounts
To view global accounts information

1 Navigate to the Accounts screen, and from the Show drop-down list, choose My 
Global Accounts.

Other Show drop-down list options include All Global Accounts, and Global 
Accounts Across Organizations.

The Global Accounts subviews appear, as shown in the following figure, with 
the explorer at left showing the hierarchy of account, subaccounts, contacts and 
opportunities, and the list at right showing records associated with each 
subview.

2 Click the individual view tabs for Subaccounts, Contacts, Activities, 
Opportunities, and Account Team.

Records associated with these subviews appear in a list at the right of the 
explorer.
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An opportunity is defined as a potential revenue-generating event. Opportunity-
related information is recorded and tracked in the views associated with the 
Opportunities screen. This chapter describes how sales professionals can use the 
Opportunities screen to perform the following tasks:

■ Receive and respond to new leads that are assigned to you

■ Create new opportunities and enter related information such as accounts, 
contacts, activities, and products

■ View, qualify, and update opportunities assigned to you and your sales team (if 
you are a manager)

■ Track the status of an opportunity through the sales cycle from creation to 
closure

■ Share information about the opportunity with sales team members 

■ Generate quotes, presentations, and other types of information needed to close 
the deal
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Business Scenario for Opportunities
This scenario provides an example of how a sales representative works with leads 
and opportunities. Your company may follow a different process according to its 
business requirements.

Opportunity Lead Conversion
A company uses Siebel Marketing to develop a campaign as part of a new product 
introduction. During the campaign, a telemarketing agent uses Siebel Call Center to 
contact prospects associated with the campaign. During her conversations with 
prospects, the agent qualifies leads by determining whether each prospect is 
interested in the new product offering. When a prospect expresses interest in 
learning more about the new product, the agent creates a new lead.

Using Siebel Assignment Manager, the lead is automatically routed to the sales 
representative who is most qualified to work on the lead and whose schedule can 
accommodate the new assignment.

When the sales representative log onto the Siebel Sales application, she sees the 
new lead in the Opportunities list on her home page. Drilling down on the lead takes 
the sales representative to the Opportunities screen. After reviewing details about 
the lead, such as the customer information, probability of closing, and the products 
that the customer is interested in purchasing, the sales representative decides to 
accept the lead by changing the Status field to Accept.

After the sales representative accepts the lead, she begins to work on the lead by 
assembling members of the sales team, conducting further research on the 
customer and its requirements, coordinating and recording activities, uploading 
agreements, and generating proposals and presentations for the customer. As the 
sales representative works through the sales cycle, she updates information about 
the sales stage and keeps private notes as well as notes that she shares with other 
members of the sales team. Eventually, the sales representative develops a quote 
from the Opportunities screen. When the customer accepts the quote, it is converted 
into an order.

NOTE: Siebel Marketing, Siebel Call Center, Siebel Sales, and Siebel Quotes are fully 
integrated, separately licensed product offerings. You need to license these products 
to access the views.
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Opportunity Tracking
At a trade show, a sales representative meets a prospective customer who could be 
a lead for a new business opportunity. When the sales representative returns to the 
office, he discovers the company is listed in Siebel Sales as an account, but the 
person he met is not listed as a contact.

The sales representative proceeds to add the prospective customer as a contact, and 
then creates the opportunity. He then schedules meetings and creates associated 
activities, and enters other potential contacts associated with the opportunity.

As the sales process continues, the sales representative gathers and updates 
information about the account, its contacts, and the opportunity that he is pursuing. 
As the relationship grows, the sales representative can add, view, and share stored 
information and key knowledge with other members of the sales team.

Opportunity Generated Quote
A sales representative is assigned to the sales team for an opportunity. As the sales 
representative gathers product information about the customer requirements, she 
enters that information in the Siebel Sales application. After she presents to the 
customer, the customer indicates that the representative’s company is on the short 
list for the deal, and that the representative should submit a quote. 

The sales representative creates a quote automatically based on the information she 
has already entered into the Siebel Sales application. After she generates the quote, 
she synchronizes the quote information with the revenues associated with the 
opportunity. By making sure these numbers are in sync, the sales representative 
establishes that the data associated with her opportunity is current and that her 
forecasts are accurate.
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Opportunities Screen Views
The Opportunities Screen includes several views that allow you to create, update, 
and track opportunities. These views make it easier to find and review relevant 
opportunities and associated data. For example, you can use the views to access 
opportunities belonging to you, your team, or your organization. 

Table 3 describes each of the views within the Opportunities screen.

NOTE: The views in Table 3 (except for the Manager's Explorer view) are based on 
a default predefined query (PDQ) shown in the Queries drop-down list. The PDQ is 
labeled * Current Opportunities. Only opportunities that have a Close Date within 
the last 30 days or in the future (>= Today's Date - 30 days) appears in the view. 
Opportunities without a primary sales representative or an unspecified organization 
do not appear in the views. The administrator can access these opportunities from 
the Site Map > Data Administration > Opportunities view.

Table 3. Opportunities Screen Views

View Description

All Opportunities Displays opportunities whose organization is the same as 
the organization of the user. The user may or may not be on 
the sales team for these opportunities. 

All Opportunities Across 
My Organizations

Displays opportunities which have an organization or a 
suborganization that is the same as the user's organizations.

All Opportunities Across 
Organizations

Displays opportunities for all organizations. Typically only 
select users have access to this view.

Explorer This view makes it easier to visualize the relationship of 
records that have been added to each opportunity. For each 
opportunity, you can view associated child opportunities, 
contacts, products, partners, quotes, activities, and notes. 

Manager’s Explorer Gives managers a view of their team's opportunities by team 
member.

My Opportunities Displays opportunities for the user’s sales team. 

My Team’s Opportunities This manager's view displays opportunities associated with 
either the manager’s sales team or the sales team of one of 
his team members. 
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Other Views Associated with the Opportunities Screen
Several view tabs are frequently associated with the Opportunities screen. Table 4 
provides an explanation of each view. Some of these views only appear if you have 
purchased optional add-on modules. Views included in add-on modules are 
indicated by an asterisk (*).

Table 4. Views Associated with the Opportunity Screen

 Opportunity Screen 
Associated Views Comments

Activities Allows sales professionals to identify and track activities required to 
win the deal. Examples of activities are customer calls and team 
meetings. Activities can also be viewed in the Calendar and To Do 
views. For more information see Chapter 9, “Activities.”

Activity Plans Provides templates predefined by the administrator that identify a set 
of activities that should be completed. Activity Plans help sales 
managers to indicate required activities and also saves time for sales 
professionals because the activities are automatically generated based 
on the selected template. For more information see Chapter 9, 
“Activities.”

Assessments Used to help sales professionals qualify opportunities and verify 
resource allocation.

Attachments Allows sales professionals to associate relevant documents with the 
opportunity. An example is a Microsoft Word Request for Proposal 
document.

Audit Trail Allows users to track changes that have been made to an opportunity 
record. Any time a member of the opportunity sales team creates, 
updates, copies, or deletes opportunity data, the action is tracked in 
the Opportunity Audit Trail view. Audit Trail details which employees 
made the modifications and when these changes were made. Changes 
to the Revenue Class, Probability, Stage, Stage ID, and Status fields are 
automatically tracked. Your administrator can help you set up change 
tracking for additional fields. For more information, see Applications 
Administration Guide. 

Calendar A Calendar format view that shows activities associated with the 
opportunity.

Campaign Leads* Primarily used by call center agents to record a campaign response 
that represents a sales opportunity. See Siebel Call Center User 
Guidefor more info.
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Categories Allows you to sort and track information related to the opportunity. 
For more information, see Chapter 13, “Categories.”

Charts Allows you to view graphical analyses of opportunity data.

Competitors Allows you to track competition in the deal. For more information, see 
Chapter 7, “Competitors.”

Contacts Allows you to maintain list of key customer contacts in the 
opportunity.

Decision Issues Allows you to anticipate and respond to your contacts' key buying 
criteria. For more information, see Chapter 6, “Decision Issues.” 

Estimate 
Compensation*

Used in Siebel Incentive Compensation application. For more 
information, see Siebel Incentive Compensation Administration 
Guide.

Messages Allows you to associate phone messages with the opportunity. For 
more information, see Chapter 10, “Messages.”

More Info Used to create, update, and track the status of opportunities.

Notes Allows you to create private notes or public notes that can be shared 
with your sales team.

Organization 
Analysis

Allows you to analyze key contacts and relationships in the 
opportunity and display them graphically in an organization chart.

Organizations Allows you to view organizations associated with the selected record.

Partners Allows you to add partners who can help you win the opportunity.

Presentations* Allows you to automatically generate presentations using the data 
associated with the opportunity. For more information, see 
Applications Administration Guide and Chapter 16, “Presentations.”

Products Allows you to associate products with the opportunity.

Profile Allows you to capture key info to qualify the deal. You can attach a 
SmartScript to support this view. For more information, see Siebel Call 
Center User Guide.

Table 4. Views Associated with the Opportunity Screen

 Opportunity Screen 
Associated Views Comments
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Projects* Allows you to create projects to track activities and resources for the 
opportunity. For more information, see Siebel Professional Services 
Automation Guide.

Proposals* Allows you to automatically generate a proposal for the opportunity. 
For more information, see Chapter 15, “Proposals” and Applications 
Administration Guide.

Quotes* Allows you to automatically generate a quote for the offering. For 
more information, see Siebel Order Management Guide and 
Chapter 14, “Quotes.”

Revenue Plans* Allows you to develop revenue plans. For more information, see Siebel 
Forecasting Guide.

Revenues* Allows you to forecast revenue. Fore more information, see Siebel 
Forecasting Guide.

Sales Team This read-only view allows you to see who is on the sales team for the 
opportunity.

Strategic Selling* Includes views that support the Strategic Selling Opportunity 
Management methodology developed by Miller Heiman, Inc. For 
more information, see Chapter 20, “Strategic Selling.” 

Target Account 
Selling*

Includes views that support the Target Account Selling Opportunity 
Management methodology developed by Siebel MultiChannel 
Services. For more information, see Chapter 19, “Target Account 
Selling.”

Transfer Used to reassign an opportunity to a partner.

Table 4. Views Associated with the Opportunity Screen

 Opportunity Screen 
Associated Views Comments
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Opportunities Processes and Procedures
When you are working with opportunities, you perform the following key tasks:

■ Lead assignment, response, and qualification. For more information, see 
“Opportunities Lead Assignment” on page 59, “Lead Response” on page 60, and 
“Lead Qualification, Sales Methods and Stages” on page 61.

■ Create an opportunity. For more information, see “Creating an Opportunity” on 
page 63.

■ Change the primary team member. For more information, see “Changing the 
Primary Sales Team Member” on page 69.

■ Monitor transactions. For more information, see “Monitoring Significant 
Opportunity Transactions” on page 70.

■ Assess opportunities. For more information, see “Assessing an Opportunity” on 
page 71.

■ Manage decisions. For more information, see “Viewing Decision Issues for an 
Opportunity” on page 73.

■ Add contacts. For more information, see “Associating a Contact with an 
Opportunity” on page 74.

■ Add activities. For more information, see “Activities Associated with an 
Opportunity” on page 75.

■ Associate products. For more information, see “Associating a Product with an 
Opportunity” on page 76.

■ Create quotes. For more information, see “Creating a Quote from an 
Opportunity” on page 77.

■ Performing an organization analysis. For more information, see “Creating an 
Organization Analysis” on page 79.

■ Adding attachments, and notes. For more information, see “Adding Attachments 
and Notes to Opportunities” on page 84.

■ Generate and viewing charts and reports. For more information, see “Opportunity 
Charts” on page 86 and “Generating Opportunity Reports” on page 89.
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Opportunities Lead Assignment
You can view new leads in the Opportunities list on your home page, or you can 
navigate to the Opportunities screen to view new leads that you did not create but 
were assigned to you. There are a number of ways in which a lead might be 
assigned to you:

■ A lead is generated through a campaign, and then automatically routed to you 
using Siebel Assignment Manager and predefined rules.

■ A lead is entered into the system by an administrator, and then automatically 
routed to you using Siebel Assignment Manager and predefined rules.

■ An opportunity is created by a sales manager or sales representative who adds 
you to the sales team.

In each of these scenarios, you are able to view the lead or opportunity because you 
have been added to the sales team, either as the primary on the sales team or as a 
sales team member. If you are receiving a lead for the first time and you are the 
primary on the sales team, the Status field in the More Info view is set to Pending 
by default. You can accept, reject, or reroute the lead by changing the value in the 
Status field.

If the administrator has activated the email notifications, predefined processes send 
email messages to you, alerting you of the following events.

■ You have received a new lead and should accept, reject, or reroute the lead 
within seven days.

■ You received a new lead five days ago and should accept, reject, or reroute the 
lead within two days.

■ You have accepted a lead but have not worked on the lead in 30 days.

■ You have won the sales opportunity and should enter the reason in the system.

■ You have lost the sales opportunity and should enter the reason in the system.

The wording of the emails and the wait periods can be modified. Opportunity 
Workflows only sends email if the opportunity has revenue greater than $50,000. 
For more information, see the Opportunity Workflows chapter in Applications 
Administration Guide.
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After you receive a lead, you can choose to accept, reject, or reroute the lead.

■ Rejecting the Lead. You can reject a lead by changing the Status field to Reject in 
the More Info view. Enter the reason for rejecting the lead in the Reason field. 
The lead remains in your queue until it is reassigned by your manager.

■ Rerouting the Lead. If you decide to reroute a lead by changing the Status field in 
the More Info form to Reroute, a Reroute activity automatically is created. Enter 
the reason for rerouting the lead in the Reason field. The lead remains in your 
queue until it is rerouted by your manager.

■ Accepting the Lead. You can accept a lead by changing the Status field in the More 
Info form to Accept. Enter the reason for accepting the lead in the Reason field.
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Lead Qualification, Sales Methods and Stages
When you accept a lead, you can begin to work on the lead in the Opportunities 
screen. The records in the Opportunities list include both leads and opportunities. 
Leads are defined as opportunities that have not yet been qualified. 

Lead qualification status is indicated in the Sales Stage field. The list of values in 
the Sales Stage field varies depending on which sales method you are using. 

A sales method is a formalized approach or methodology used during the sales 
process. A sales method can encompass all activities associated with the sales 
process, from prospecting to forecasting to closing deals. This approach allows sales 
representatives to use the method most appropriate for their opportunities. 

The application administrator establishes values in your Siebel application that 
represent the sales methods and sales stages for your company. It is a recommended 
business practice to designate a default sales method in your Siebel application. 
This practice allows a sales method to be associated with each opportunity and aids 
in charting and reporting accuracy.

Sales methods can differ within a company. For instance, a sales method for 
managing a complex multimillion dollar opportunity can include 15 stages, while a 
sales method for a simple low-dollar opportunity may require only four stages.

Your application administrator creates and implements the sales stages that your 
company uses. For more information about creating or implementing sales stages, 
see Applications Administration Guide.

Table 5 shows sales methodologies (Accelerated, Default, Standard, Strategic 
Selling), and the associated sales stage for each methodology (for example, 01 - 
Prospecting). The table also shows if the record is a lead or is an opportunity at each 
sales stage.

Table 5. Sales Methods and Sales Stages

Accelerated Default and Standard Strategic
Lead or 
Opportunity

01 - Prospecting 01 - Prospecting 01 - Universe Lead

02 - Potential Lead 02 - Above Lead
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02 - Qualification 03 - Qualification 03 - In the Funnel Opportunity

04 - Opportunity 04 - Best Few Opportunity

05 - Building Vision Opportunity

06 - Short List Opportunity

07 - Selected Opportunity

03 - Closing 08 - Negotiation 05 - Won Opportunity

09 - Closed or Won Opportunity

04 - Lost 09 - Closed or Lost 00 - Lost Opportunity

Table 5. Sales Methods and Sales Stages

Accelerated Default and Standard Strategic
Lead or 
Opportunity
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You should create a new record each time you identify an opportunity.

To create an opportunity

1 Navigate to the Opportunities screen, and in the Opportunities list, create a new 
record.

2 In the More Info form, click the show more button.

3 Complete the necessary fields.

The following table describes some fields in the Opportunity form.

Field Comments

Account Allows you to associate an opportunity with an account. 

Address Line 1 Allows you to associate an address with an opportunity. If 
the account has more than one address associated with it, 
you can select the appropriate address for the opportunity.

Best Case Allows you to enter the currency amount the deal could 
generate in the best-case scenario. This amount is higher 
than the value in the Revenue field.

Channel A list of values established by your company that defines 
the sales channel. Default values include Direct and 
Indirect.

Close Date Allows you to enter the expected date on which the 
opportunity closes. The default date is the same as the 
Created Date. It is important to modify the date, if the 
opportunity closes on a different date, because this date is 
used in revenue forecasting.

Committed A check box which, when selected, indicates there is a 
high probability that the deal will close, and that the deal 
should be included in your revenue forecast.

Cost Expense associated with the opportunity.

Created A default value that displays the date and time you created 
the opportunity.
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Created By A default value based on the user ID of the employee who 
created the opportunity.

Description A text area for additional information about the 
opportunity.

Domestic 

Ultimate D-U-N-S

Displays the D-U-N-S number for the domestic ultimate, 
which is the highest member in the hierarchy for the same 
business entity within the same country. A case can be its 
own domestic ultimate.

DUNS# The Data Universal Numbering System (D-U-N-S) numeric 
serial number for a company. The D-U-N-S number is 
unique for each company.

Executive Priority This check box can be used to flag a significant 
opportunity. Sales executives can query for high-priority 
opportunities for tracking purposes.

Expected value Displays a currency value that is calculated based on the 
potential revenue field multiplied by the value in the 
probability field. A lower percentage in the probability 
field reduces the expected value that is included in your 
revenue forecast.

Global Ultimate DUNS Displays the D-U-N-S number for the global ultimate, 
which is the highest member in the hierarchy for the same 
business entity worldwide.

Lead Partner The lead partner field is populated automatically when the 
source of the opportunity is a campaign with a lead 
partner. 

If you create an opportunity from a response, and the 
response had a campaign associated with it, the 
opportunity inherits the lead partner from the campaign. 

If you create a new opportunity and select a campaign as 
the source, the opportunity inherits the campaigns lead 
partner, if it has one. 

Lead Quality A list of values established by your company that allows 
you to rank the quality of the lead. Default values include 
1-Excellent, 2-Very High, 3-High, 4-Fair, 5-Poor.

Field Comments
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Lock Assignment A check box which, when selected, locks the sales team 
assignment so that Siebel Assignment Manager does not 
alter the current opportunity assignment.

Margin A calculated field that displays the revenue figure minus 
the cost.

Name A required value that identifies the opportunity.

Opportunity Currency A list of values established by your company that allows 
you to specify the currency type associated with the 
opportunity. The selected value does not affect 
forecasting.

Organization A default value that displays the organization name 
associated with the person creating the opportunity. Your 
system administrator sets up organizations in your Siebel 
application. 

You can associate multiple organizations with an 
opportunity.

Parent HQ DUNS Displays the D-U-N-S number of the parent organization’s 
HQ location, if this is a subsidiary record.

Parent Opportunity Allows you to associate an opportunity with a parent 
opportunity. For instance, if you are working a sale for a 
division of a company in which there are numerous 
opportunities, you may associate this opportunity with a 
larger parent opportunity for the entire company.

Partner Approval Status A list of values established by your company that allows 
you to specify the approval status of the lead partner for 
the opportunity.

Primary Displays the user ID of the primary sales team member. 
This value defaults to your user ID if you are creating a 
new opportunity.

Priority A check box which, when selected, indicates that an 
opportunity is a high priority (urgency for sales team). 
When the priority is set to Y, a check mark appears in the 
priority column. This column can appear in the 
Opportunities list and the Opportunities Explorer. The 
default value for this column is N.

Field Comments
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Probability % The Probability reflects the percentage of confidence you 
have that the deal will close with the specified revenue on 
the specified close date. By default, the probability adjusts 
automatically based on the sales stage of the opportunity. 
You can manually override the probability value.

Reason A list of values established by your company that allows 
you to specify a reason that the opportunity was accepted, 
rejected, rerouted, won, or lost.

Revenue Allows you to enter the currency amount of the 
opportunity. If you are using the Products, Quotes or 
Revenue view tabs, you can make sure your summary 
revenues are calculated and are in sync. The amount 
entered affects forecasting.

Revenue Class A list of values established by your company that allows 
you to define the quality of the expected revenue. For more 
information, see “Revenue Class and Revenue Type” on 
page 67.

Revenue Type A list of values established by your company that allow 
you to define the kind and source of the expected revenue. 
For more information, see “Revenue Class and Revenue 
Type” on page 67.

Sales Method A list of values established by your company that includes 
the sales methodologies. Default values include Strategic 
Selling, Accelerated Sales Process, Default Sales 
Methodology and Standard Sales Process.

Sales Stage A list of values established by your company that allows 
you to specify the sales stages associated with the selected 
sales method. 

Sales Team This list shows who is on the sales team for the 
opportunity. When you create an opportunity, you are 
automatically listed as the primary sales team member. 
You can add employees to the sales team by selecting them 
from the employee list. Only a manager or administrator 
can change or delete the primary sales team member.

Site A default value that is automatically entered when you 
associate the opportunity with a specific account and 
location.

Field Comments
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Revenue Class and Revenue Type
Revenue Class and Revenue Type fields appear on both the Opportunity and the 
Revenue forms. These two fields are the same fields in the database, and they are 
linked through a database join, which means changes made in the Opportunity 
form are reflected on the Revenue form and changes made in the Revenue form 
appear in the Opportunity form. 

The Revenue Class and Revenue Type lists of values are based on the internal 
business process for each company. The standard values can be adapted to your 
business, or the lists of values changed by your application administrator to reflect 
the stages of your company’s sales process and the manner in which your company 
recognizes revenue.

Source A dialog box that allows you to associate the sources of the 
sales lead with the opportunity. Typical source values 
include specific events, campaigns, or conferences.

Source Type A default value that displays the category of the primary 
source. For instance, a specific seminar that is the source 
of the opportunity is identified with a value of Seminar in 
this field.

Split Flag A system populated check box that indicates a split 
revenue record has been created.

Status  A list of values established by your company that 
describes the status of the opportunity. The Status field is 
Pending by default. A user can change the field to 
Accepted, Rejected, Rerouted, Won, or Lost.

Territories A default value based on the territories defined by your 
company. Your system administrator controls the territory 
assignment function set up by your sales manager.

Worst Case Allows you to enter the currency amount the deal could 
generate in the worst-case scenario. This amount is lower 
than the value in the Revenue field.

Field Comments
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■ Revenue Class Field. Your company can define the quality of the revenue at a 
given time by setting the list of values in the Revenue Class field to reflect the 
sales stages you use. Sample values are Pipeline, Upside, Expected, Committed, 
and Closed.

■ Revenue Type Field. Your company may want to differentiate between kinds of 
revenues and their sources. For instance, your company may classify revenue by 
Software, Consulting, and Hardware categories, or by Booked versus Billed 
revenue, which are defined in the list of values. Defining revenue types allows 
you to query revenues or view charts sorted by the category of the revenue.

For more information, see Applications Administration Guide and Siebel Forecasting 
GuideSiebel Forecasting.
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Changing the Primary Sales Team Member
The administrator or manager of the primary sales representative can change the 
person assigned as the primary member of the sales team.

To change a primary team member

1 Navigate to the Opportunities screen.

2 From the Show drop-down list, choose My Team’s Opportunities.

3 In the Opportunities list select the opportunity, and then click the More Info view 
tab.

4 In the More Info form, click the select button in the Sales Team field.

5 In the Team Members dialog box, select the team member to assign, and then 
select the Primary check box.

6 Click OK.

NOTE: If you have access to the Data Administration screen, you can change a 
primary team member assignment there.
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Monitoring Significant Opportunity Transactions
Sales executives can monitor significant opportunity transactions by querying for 
opportunities flagged as Executive Priority. These flagged opportunities can be 
tracked by the executive team regardless of the revenue or forecast commitment. 
Tracking high-priority opportunities helps the executive maintain the most accurate 
quarterly revenue forecast and plan involvement in the most promising 
opportunities.

To flag an opportunity as an executive priority

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 In the Opportunities list, click the menu button and choose Columns Displayed.

4 In the Columns Displayed dialog box, move Executive Priority and Executive 
Priority Date from the list of Available Columns to the list of Selected Columns, 
and then click Save.

The fields appear in the record for the selected opportunity.

5 In the opportunity record, click the check box in the Executive Priority field.

The Executive Priority Date field automatically shows the current date after the 
Executive Priority flag is checked.
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Assessing an Opportunity 
An opportunity assessment helps you qualify opportunities and verify resource 
allocation. Using an assessment template, you can select values and attributes to 
assign a composite value to the opportunity.

NOTE: In some companies, your Siebel application automatically generates 
assessments, but if this process has not been automated, you can create 
assessments manually.

To assess an opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity with which you want to 
associate the assessment.

3 Click the Assessments view tab, and then add a new record.

a In the Template Name field, click the select button.

The Select Assessment Template dialog box appears.

b Select the template, and then click OK.

c Click the menu button, and then choose Save.

An explicit Save is required.

4 Click the Assessment Attribute subview tab, and then click the show more 
button.

A list of assessment attributes appears.
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5 In the Value field, click the select button and choose the appropriate value for 
the attribute.

Repeat this step for each attribute in the list.

A composite assessment score for the opportunity appears as a percentage value 
in the parent Assessment list. This percentage compares the score you entered 
in the assessment attribute line items to the maximum possible score for the 
opportunity. You can use this percentage to qualify the opportunity.

NOTE: Your application administrator sets up the assessment templates based on the 
criteria defined by your company. For more information on administering 
assessment templates, see Applications Administration Guide.
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Viewing Decision Issues for an Opportunity
Decision issues are specific areas of interest that can influence a prospect’s buying 
decision during the sales cycle. These decision issues provide you with an 
opportunity to present the advantages of your solution to the customer.

You can track these decision issues using the Opportunity screen’s Decision Issues 
view, and use this information to develop your sales strategy and address customer 
concerns. Fore more information, see Chapter 6, “Decision Issues.”
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Associating a Contact with an Opportunity
As you work with an opportunity, you want to maintain information about the 
contacts associated with the opportunity. For more information about contacts, see 
Chapter 2, “Contacts.”

The Opportunity screen’s Contacts view allows you to store and review contact-
related information for an opportunity.

To associate a new contact with an opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Contacts view tab, and in the Contacts list click New.

4 In the new record, complete the fields.

To associate an existing contact with an opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Contacts view tab, and in the Contacts list click Add.

4 In the Add Contacts dialog box, enter query criteria for the contact, and then 
click Go.

5 Select the contact or contacts you want to add, and then click OK.

NOTE: To select a sequence of contact records, hold down the SHIFT key and click 
the contact records. To select multiple contacts that are not in sequence, hold down 
the CTRL key and click the contact records.
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Activities Associated with an Opportunity
The Opportunities screen’s Activities view allows you to track activities at the 
opportunity level, maintain a calendar and to-do list for the opportunity, and 
delegate activities related to the opportunity to your sales team. For more 
information about Activity Plans and associated activities, see Applications 
Administration Guide and Chapter 9, “Activities.”
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Associating a Product with an Opportunity
Specific products can be associated with an opportunity. For example, if a customer 
is interested in purchasing a new software suite, this information can be specified 
in the Products view.

After the product is associated with the opportunity, you can drill down on the 
product to review additional information such as product features and prices.

Later, this data can be used when you are building a presentation, quote, or 
proposal based on the opportunity.

To associate a product with an opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity.

3 Click the Products view tab, and in the Products list click New.

4 In the new record, click the select button in the Products field.

5 In the Pick Product dialog box, enter product criteria, and then click Go.

6 Select the product, and then click OK.

The product appears in the Opportunity Products list.

7 Complete the remaining fields as needed.

After the product record is saved, you can drill down on the hyperlink in the 
Product field to view Product details such as Key Features and Product Images.
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Creating a Quote from an Opportunity
Using the Quotes view, you can automatically create and revise quotes for the 
opportunity. For more information on quotes and orders, see Siebel Order 
Management Guide and Chapter 14, “Quotes.”

To create a quote from an opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select an opportunity.

3 Click the Products view tab.

4 In the Products list click New, and then add a product.

For more information, see “Associating a Product with an Opportunity” on 
page 76.

5 In the Product record, complete the fields.

a Enter the number of product units the customer is interested in purchasing

b In the Auto Quote field, select the check box to display a check mark.

6 Click the Quotes view tab, and then in the Quotes list, click Auto Quote.

A quote record is automatically created, with some fields completed and a status 
of In Progress.

If a price list is associated with the account, the Price List field is automatically 
completed. If no price list is associated, in the Price List field click the select 
button and choose a price list. For more information on price lists, see Pricing 
Administration Guide.

7 In the quote record, drill down on the hyperlink in the Name field.

You can change the system-generated name for a name that is more meaningful 
in the quote details form.
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8 In the quote’s Line Items list, add line items, and then click the menu button and 
choose Reprice.

The Reprice function makes sure that the quote total reflects the prices from the 
price list, and multiplies those prices by the quantities that you enter in the 
products view.

9 In the Quote form, click the menu button and choose Update Opportunity, and 
then return to the Opportunity form.

The Update Opportunity function verifies that the opportunity's revenue line 
items are in sync with the quote line items.

Use the History icon or the threadbar to navigate back to the Opportunity form.

To update opportunity revenues

1 In the Opportunity list, select the opportunity, and then click the Revenues view 
tab.

2 In the Revenues list choose List from the Revenues drop-down menu.

3 In the Revenues list, click the menu button and choose Update Opportunity.

Update Opportunity makes sure that your summary level revenues equal the 
sum of your revenue line items.

After this process is completed, the revenue amounts that appear in the 
Products, Revenues, and Quotes views are synchronized and the Opportunity’s 
Revenue field displays a calculated sum of the individual revenue line items 
associated with the opportunity.

NOTE: Siebel Quotes is a separately licensed product offering. You cannot access the 
Quotes view tab if you have not licensed this product.
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Creating an Organization Analysis
You can automatically create organization charts to help you analyze your key 
contacts and develop your relationship strategy to win the opportunity.

Siebel Sales automatically generates organization charts based on contacts 
associated with each opportunity. When you update contact information, your 
changes are reflected in the organization chart.

To add existing contacts to the organization analysis

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity for the Organization Analysis.

3 Click the Organization Analysis view tab.

4 In either the default Organization Analysis chart view or in the Contacts list 
(toggle view), click New.

The Add Contacts dialog box appears.

5 Select one or more contacts to add, and then click OK.

NOTE: You can select sequential contacts by holding down the SHIFT key while 
selecting the contact records.

To create new contacts for the organization analysis

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity for the Organization Analysis.

3 Click the Organization Analysis view tab.

4 In either the default Organization Analysis chart view or in the Contacts list 
(toggle view), click New.

5 In the Add Contacts dialog box, click New.
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6 In the new contact record enter the contact information in the fields, and then 
click Save.

NOTE: If you create a new contact directly from the Organization Analysis chart 
view, then an explicit Save is required to update the chart.

The Level of Influence value determines the degree of shading that appears in 
the Contact node in the Organization Analysis chart. The following table details 
values and shading.

You can update contact information from either the Opportunities screen or from 
the Contacts screen. 

Using Drag and Drop to Depict Organization Hierarchy
From the Organization Analysis chart view you can drag and drop contacts to 
indicate professional relationships within the organization.

To create the hierarchy

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity for the Organization Analysis.

3 Click the Organization Analysis view tab.

4 Add or create contacts, as described in “To add existing contacts to the 
organization analysis” on page 79 and “To create new contacts for the 
organization analysis” on page 79.

In the Organization Analysis chart area the nodes (boxes) appear for each of the 
contacts you have analyzed and associated with the opportunity.

Value in Level of Influence Fields Shading on Organization Chart

Low None

Political Structure (Medium) Light gray

Inner Circle (High) Dark gray
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5 Select the contact node and drag it beneath the contact node that depicts the 
contact’s manager.

When you drop the contact node on its manager’s node, a formal line between 
the nodes appears, reflecting the reporting relationship.

6 Repeat Step 5 for each contact until you have completed the organization chart.

NOTE: The reporting relationships are also stored in the Contacts list (toggle 
view). The Manager’s Last Name and Manager’s First name fields of the contact 
automatically populate based on the drag and drop actions. To expose this 
information in the contacts list, click the menu button, and then choose 
Columns Displayed.

Drawing Lines of Influence
You can also map the politics in the customer organization by identifying informal 
lines of influence between contacts. Mapping informal lines of influence helps you 
identify contacts who are not highly ranked (and are easier to access) but who have 
significant influence on key decision makers. Lines of Influence information is 
automatically updated in the Contacts screen’s Relationships view. You can add 
Lines of Influence information in the Relationships view if you prefer.

To draw lines of influence

1 In the Organization Analysis chart area, select the contact node, and 
simultaneously hold down the CTRL key.

2 Drag and drop the selected contact on other contacts to draw the lines of 
influence.

The CTRL key must be depressed throughout this process in order for the 
informal line of influence to appear.

To delete lines of influence

■ In the Organization Analysis chart area, select the line and press the DELETE 
key.

You may also right click the mouse in the Organization Chart area, and choose 
Edit > Delete from the menu.
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Viewing and Printing the Organization Analysis
After you associate contacts with an opportunity and enter values for the manager, 
reports, associates and the influence level for each, you can view an organization 
chart of all your contacts. 

To view the Organization Analysis chart

1 Navigate to the Opportunities screen.

2 In the Opportunities list select the opportunity.

3 Click the Organization Analysis view tab.

The Organization Analysis list of contacts appears.

4 From the drop-down list, choose Organization Analysis.

An organization chart appears with the contact information you entered.

Each contact appears in a hierarchy based on the influence level or managerial 
structure assigned to the contact. 

NOTE: Double-click the contact node to navigate to the Contacts screen’s Activities 
view to add follow-up activities for the contact.

To print an Organization Analysis chart

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity for which you want to view the 
Organization Analysis.

3 Click the Organization Analysis view tab.

The Organization Analysis list of contacts appears.

4 From the drop-down list, choose Organization Analysis.
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5 Right click the mouse in the Organization Analysis chart workspace, and choose 
Print from the menu.

You can adjust the zoom level at which you want to print the Organization 
Chart. Large charts print across multiple pages.
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Adding Attachments and Notes to Opportunities
The Attachments view allows you to associate relevant files such as requests for 
proposals, strategic information documents, and slide presentations that other sales 
team members can use as they work this opportunity. You can add private or public 
notes that are shared with members of the sales team, using the Notes view tab.

To add an attachment to an opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity, and then click the Attachments 
view tab.

3 In the Attachments list, click New.

4 In the new record, click the select button in the Attachment Name field, and in 
the Add Attachments dialog box, click Browse to navigate to the file.

5 In the Choose File dialog box, locate the file and then click Open.

The file name and path appears in the Add Attachments dialog box.

6 In the Add Attachments dialog box, click Add.

The Attachment name, size, type and modified fields are automatically 
completed for the record, and the Update File field is checked.

7 In the Comments field for the attachment record, enter a description of the 
attachment.

To add private and public notes to the opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity, and then click the Notes view 
tab.

3 In the Notes list, choose Public or Private from the drop-down menu to specify 
a private note or one that is shared.

4 In the Notes list, click New, and complete the fields for the new record.

The Created By field is automatically completed with the creator’s User ID.
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a In the Type field, select the note type.

Examples of note types are legal, reference, and directions.

b In the Description field, enter the note text.
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Opportunity Charts
Several charts are available that support analysis of opportunities data. The data can 
be depicted in a variety of formats such as pie graph, bar graph, and so on. 

Table 6 describes each opportunity analysis chart.

Table 6. Opportunities Charts

Chart Description

Activity Analysis Displays the number of activity types for the selected 
record.

Current Opportunity Analysis Displays a scatter diagram of the selected opportunity 
by revenue and probability. The bottom chart displays 
sales stage.

Lead Analysis Displays the number of opportunities or revenue by 
organization or primary sales representative. The data is 
segmented by lead quality. 

Lead Source Analysis Displays the number of opportunities, revenue, or 
average revenue by time period. The data is segmented 
by lead source.

Lead Source Pipeline Analysis Displays the number of opportunities by sales stage and 
lead source.

New Business Analysis Displays the number of opportunities, revenue, or 
average revenue over a time period.

Opportunity Analysis Displays the number of opportunities by product, 
source, territory, and competitor.

Pipeline Analysis Displays the number of opportunities or revenue by 
sales stage, organization, revenue size, or sales method.

Probability Cluster Analysis Displays a scatter diagram of your opportunities by 
revenue and probability.

Rep Analysis Displays the number of opportunities, revenue, or 
average revenue by sales representative. The data can 
be segmented by sales stage and win probability.

Revenue Analysis by Rep Displays the number of opportunities and revenue by 
sales representative.
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Viewing the Opportunity Sales Pipeline Analysis Chart
The Sales Pipeline Analysis works by evaluating the total revenue and count of 
opportunities by a selected sales methodology and then evaluating the total against 
each applicable quota.

NOTE: The Sales Pipeline Analysis Chart considers only active Quota plans, 
regardless of duration. 

To display sales pipeline analysis information

1 Navigate to the Opportunities screen.

2 From the Show drop-down list, select an Opportunities list.

For example, you might choose All Opportunities.

3 In the Opportunities list, click Query

4 In the Opportunities form, query on a Sales Method, and then click Go.

5 Click the Charts view tab.

6 In the Charts list, select Sales Pipeline Analysis from the Show drop-down list.

7 From the secondary Show drop-down list, choose either % of Count Quota, or 
% of Revenue Quota, and then click Go.

Sales Method Bar Displays number of opportunity products or revenue by 
sales method. The data is segmented by sales stage.

Sales Pipeline Analysis Displays the percentage of revenue quota and 
percentage of count quota.

Sales Pipeline Phases Analysis Displays sales pipeline phases and the percentage of 
revenue quota or count quota achieved per phase.

Table 6. Opportunities Charts

Chart Description
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Viewing the Sales Pipeline Phases Analysis Chart
The Sales Pipeline Phases chart provides an overall view of the revenue generated 
for opportunities in an organization. Sales phases are basic components used to 
group stages together into basic sales categories.

To view the sales pipeline phases analysis chart

1 Navigate to the Opportunities screen.

2 From the Show drop-down list, select an Opportunities list.

3 In the Opportunities list, click Query.

4 In the opportunities form, query for a Sales Method, and then click Go.

5 Click the Charts view tab.

6 In the Charts list, select Sales Pipeline Phases Analysis from the Show drop-
down list.

7 From the secondary Show drop-down list, choose either % of Count Quota, or 
% of Revenue Quota, and then click Go.
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Generating Opportunity Reports
You also can generate reports of your opportunities data. Available reports include:

■ Opportunities by Category

■ Opportunities by Sales Rep

■ Opportunity Summary

■ Opportunity List

■ Pipeline Report by Rep

■ Smart Report - Opportunity Detail

■ Opportunity Status

■ Opportunity Marketing Events Summary

To generate an opportunity report

1 Navigate to the Opportunities screen, and in the Opportunities list, select an 
opportunity.

2 From the application-level menu, choose View > Reports.

The Reports dialog box appears.

3 In the Reports dialog box, choose the report to display from the Select a Report 
drop-down list, and then click Run Now.

To generate the report at a later time, click Schedule, and then complete the 
fields in the Reports dialog box.

Configuring the Opportunities by Category Report
The Opportunities by Category report can be configured to sort by City, Close Date, 
Sales Cycle Stage, Source, Source Date, State, Territory, or ZIP Code.

To configure the Opportunities by Category report

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select an opportunity.
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3 From the application-level menu, choose View > Reports.

4 In the Reports dialog box, choose the Opportunities by Categories report from 
the Select a Report drop-down list, and then click Run Now.

5 In the Opportunity Parameters dialog box, choose a sort parameter in the Sort 
By field, and then click Finish.
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This chapter describes how to use D&B data and reports to manage customer 
relationships, acquire new customers, and create high quality new account records.
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Business Scenarios for D&B Integration
These scenarios provide examples of how sales representatives use D&B data in 
Siebel Sales. Your company may follow a different process according to its business 
requirements.

Relationship Management
A company can increase market penetration across its existing customer base by 
determining how many relationships the company already has within a corporate 
family structure. Sales managers and representatives can use D&B D-U-N-S numbers 
to view the organizational hierarchies of clients and aggregate account attributes at 
each level.

For instance, a sales representative plans to sell computers to 20 business locations 
and he discovers that there are locations for this company that he has not yet 
contacted. In another situation, the sales manager many want to see a rollup of 
opportunities and the potential revenue for each subsidiary and location for a 
specific company on a worldwide basis.

Customer Acquisition
Because a sales organization is always looking for more leads to new business, sales 
professionals can access company information in the Siebel D&B database, allowing 
them to generate prospects in their territories.

With D&B, the sales representative can query the Siebel D&B database using criteria 
to target new leads. The sales representative can query using demographic data, 
revenue profiles, or other criteria. After generating a list of leads, the sales 
representative can automatically add the companies and contacts to their 
company’s accounts list. These promoted accounts and contacts are automatically 
updated when D&B updates occur.

D&B Search for New Account Information
Sales professionals can access the D&B database real-time to find and retrieve new 
D&B account information that is immediately available for use within Siebel Sales. 
This information includes company demographic, corporate linkage, and address 
data maintained by D&B.
92 Siebel Sales User Guide Version 7.5, Rev. A



D&B Integration

Business Scenarios for D&B Integration
For example, a sales representative discovers a new opportunity, but the 
representative cannot find the account in either the Siebel account list or the D&B 
account list. Instead of creating a new account, the sales manager performs a real-
time D&B search to obtain up-to-date, quality information that can be used to 
automatically establish a new Siebel account. This provides the sales team with 
valuable information that they can use when working on the new opportunity.
Version 7.5, Rev. A Siebel Sales User Guide 93



D&B Integration

Accessing Company Data and Reports with D&B
Accessing Company Data and Reports with D&B
The D&B screen allows you to access D&B marketing data as well as business and 
credit reports from within the Siebel Sales application. 

You can directly access D&B data for use in prospecting, qualifying leads, and 
generating marketing lists. You also can integrate D&B data and reports into your 
Siebel application, allowing you to perform the following tasks:

■ Use D&B information to standardize data for your customer accounts

■ Access D&B business and credit reports

■ Search D&B for new accounts

■ Generate prospect lists based on D&B relationships and demographic data

■ View account hierarchies and related opportunities across a corporate family 
structure

D&B D-U-N-S Number
The D-U-N-S (Data Universal Numbering System) number is an important 
component of D&B data. The D-U-N-S number is a unique nine-digit identifier 
assigned to each business entity in the D&B database.

D&B links the D&B D-U-N-S numbers of parents, subsidiaries, headquarters, and 
branches on more than a million corporate family members around the world.
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Viewing D&B Aggregate Data for a Company
When you have the D&B account information loaded into your Siebel Sales 
application, a number of views allow you to use the data and view company 
hierarchies. The following procedure explains how to view aggregate data for a 
company using the D&B screen.

NOTE: D&B data for a company is read-only until the company is promoted to a 
Siebel account. For more information, see “Promoting a D&B Account” on page 96.

To view aggregate data

1 Navigate to the D&B screen.

2 In the D&B Accounts list select the account for which you want to view the 
aggregate data.

3 In the More Info form, click Query.

4 In the query form, enter the query criteria, and then click Go.

A list of D&B accounts that meet your criteria appear.

NOTE: If the DUNS # field does not appear in the list, click the menu button, 
choose Columns Displayed, and adjust the list of displayed columns.
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Promoting a D&B Account
You can use the D&B list to locate accounts that are potential sales leads. After you 
identify accounts that meet your criteria, you can promote the accounts into your 
accounts list.

To promote a D&B account

1 Navigate to the D&B screen.

2 In the D&B Accounts list select the company or companies that you want to add 
to your accounts list.

■ To select a sequence of account records, hold down the SHIFT key and click 
the account records. 

■ To select multiple accounts that are not in sequence, hold down the CTRL 
key and click the account records.

3 In the D&B Accounts list, click Promote as Siebel Account.

A check mark appears in the Promoted field and the company is added to your 
Siebel Sales application. 

Drill down on the hyperlink in the Business Name field to view the account 
profile and related contacts.
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Creating a Prospect List from D&B Data
You can use D&B data to generate sales leads. One way to use sales leads is to create 
a prospect list for your telesales or sales team to contact.

To create a prospect list

1 Navigate to the D&B screen.

2 In the D&B Accounts list select the company or companies that you want to 
include in your list, and then click Create D&B Lists.

The contacts associated with the company or companies are added to a prospect 
list.

3 To view the prospect list, select D&B Lists from the Show drop-down list.

4 In the D&B Lists list, select the list and drill down on the list name hyperlink to 
view accounts on the list.
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Viewing a D&B Report
After a D&B report order is set up by your administrator, you can view business and 
credit reports from within Siebel Sales. This information can also be viewed from 
the Accounts screen’s D&B Reports view tab.

To view a D&B report

1 Navigate to the D&B screen.

2 In the D&B Accounts list select the company for which you want to view reports.

3 Click the Reports view tab.

The D&B report for the selected company appears. 
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Using Global Integration to Add New D&B Accounts
After a D&B Global Integration access is set up by your administrator, you can 
access D&B real-time within your Siebel application and enter criteria to locate new 
accounts in the D&B database. Search criteria can include the business name with 
state/province and country information, D&B D-U-N-S number, local business ID, 
and telephone number.

When you execute a search for new D&B accounts, the search criteria is sent to 
D&B's Global Integration, along with the user’s D&B account name and password. 
When D&B receives the information, Global Integration automatically selects the 
single best search method to execute based on the criteria. D&B calculates the 
criteria matches and returns the number to Siebel. If there are no matches for the 
criteria, the requestor is notified.

At this point, you can opt to purchase the account information, or cancel the Global 
Integration search process. If an account is purchased, data received from D&B is 
added to the Siebel D&B tables and is available in D&B All Accounts view.

NOTE: If the selected account already exists in your Siebel D&B database, the 
account is not purchased. 

To initiate D&B’s Global Integration search

1 Navigate to the D&B screen.

2 In the D&B Accounts list, click Search D&B for New Account.
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3 In the Search D&B dialog box, complete the fields for the query.

The following illustration shows an example of the search criteria form.

You must enter sufficient data to initiate a query in the United States. For 
example, as the following figure shows, in the Search D&B form you can enter 
Business Name, State/Province and Country as criteria, or just the D-U-N-S 
number, or the Local Business ID and Country, or the Phone number and 
Country. If you only enter the Business Name, the search fails because the data 
is insufficient.
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The following table describes the Search D&B query fields.

Field Comments

Business Name The Name/Address search is the most commonly used 
search method. At a minimum, the business name and 
country must be supplied. For Canadian businesses, the 
province must also be included. 

When you are searching for a business by name, do not 
use wildcard characters, (*) for unknown characters in 
the name.

Additional information such as town, street address, 
and postal code, can be included to increase the 
chances of finding an exact match.

Street Address

City

State/Province

Country Name

Zip Code

DUNS # This search method allows you to enter a known D&B 
D-U-N-S number to verify the identity of a business. 
The D&B D-U-N-S number should contain only nine 
numeric characters (no spaces, dashes, and so on). 
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Local Business ID Many countries have their own numbering schemes to 
identify local businesses. Normally, this is a 
government-sponsored schema for the purpose of 
business registration and tax filing. 

The local business ID submitted in a search should only 
contain numeric characters (no spaces, dashes, and so 
on). A country code must also be included with the 
request. 

D&B Global Integration supports searching by the 
following local business identifiers.

Australia—CAN 

Belgium—BTW/TVA

France—SIREN

Germany—Hr. Number

Ireland—Company House

Italy—CCIAA

Netherlands—KvK Nr

Portugal—Fiscal

Spain—CIF/NIF

Sweden—Company House

United Kingdom—Company House

Phone # If using a telephone number search, enter the telephone 
number as dialed from within the country, including 
the area code or city code if required. The international 
long distance code (country code) should not be 
included. 

For example 9086655000 for a search in New Jersey, US; 
9055686000 for a search in Ontario, Canada; 
01494422000 for a search in High Wycombe, England; 
0104009400 for a search in Rotterdam, Netherlands. 

The telephone number should contain only numeric 
characters (no spaces, dashes, and so on).

Field Comments
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4 After you have entered the criteria, click Search D&B.

The following figure shows sample search results, with the business name, city, 
and state in the Search Results list.

5 In the Search D&B list of results, select an account, and then click Purchase.

Click Refine Query to modify the query criteria. Click Cancel to return to the 
D&B Accounts list without purchasing.

The purchased account is highlighted in the D&B Accounts list.
Version 7.5, Rev. A Siebel Sales User Guide 103



D&B Integration

Using Global Integration to Add New D&B Accounts
104 Siebel Sales User Guide Version 7.5, Rev. A



Decision Issues 6
Decision issues are specific areas of interest that can influence a prospect’s buying 
decision. Customers and prospective customers may ask questions and express 
concerns about the solutions you propose, and your company in general, during the 
sales cycle. Decision issues provide you with an opportunity to develop a sales 
strategy and address customer concerns.

This chapter describes how to use the Decision Issues view to associate customer 
questions and concerns with an opportunity. Decision issues are the criteria a 
prospective customer uses to evaluate a potential supplier and product before 
making a decision to buy.
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Business Scenario for Decision Issues
This scenario provides an example of a business process performed by a sales 
representative using decision issues. Your company may follow a different process 
according to its business requirements.

A sales representative logs into the Siebel Sales application and discovers a new 
opportunity for a software module his company sells. The 2,500-seat opportunity 
has been qualified by a colleague in the Telesales department, and the sales 
representative wants to move forward with the opportunity. The sales 
representative reviews the list of contacts, and then calls the main prospect to 
introduce himself and gather some initial requirements. Based on this conversation, 
the sales representative adds two new decision issues which are important to this 
prospect—customer references and search engines in the software. 
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Associating a Decision Issue with an Opportunity
After you qualify an opportunity, you can associate the related decision issues with 
the opportunity and rank the decision issues in order of importance to the prospect.

To associate a decision issue with an opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity associated with the decision 
issue.

3 Click the Decision Issues view tab.

4 In the Decision Issues list, click New.

5 In the Add Issues dialog box select the issue, and then click Add.

6 Complete the fields for the decision issue.

a In the Rank field, choose a value based on the importance of the decision 
issue to the customer.

b In the Comments field, enter any additional information.

NOTE: Your application administrator enters decision issue data that has been 
defined in your company. For more information, see your application administrator.
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After associating a decision issue with an opportunity, drill down on the decision 
issue name hyperlink to access associated views. These views, shown in Figure 2, 
allow you to enter details that help you position your company’s offerings around 
the selected issue. By clicking a view tab you can specify related issues, associate 
literature, and attach files to the decision issue.

To add decision issue details

1 Create a Decision Issue associated with an opportunity as detailed in “To 
associate a decision issue with an opportunity.”

2 In the Decision Issues list, drill down on the hyperlink in the Decision Issue field.

The selected decision issue read-only form appears with four subview tabs, 
More Info, Related Issues, Literature, and Attachments, as shown in Figure 2.

To add related issues

1 Click the Related Issues view tab, and then click Query.

2 In the Related Issues query form, enter the query information, and then click Go.

Figure 2. Decision Issues Details View
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To associate literature with the decision issue

1 Click the Literature view tab, and then click Query.

2 In the Literature query form enter the query information, and then click Go.

Select the Auto Update check box if you want to update associated literature 
when source literature files are updated.

To associate attachments with the decision issue

1 Click the Attachments view tab, and then click Query.

2 In the query form, click the select button in the Attachment Name field.

3 In the Add Attachment dialog box, specify a file name or URL, and then click 
Add.

In the Add Attachment dialog box, click Browse to navigate to the file you want 
to attach.
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In competitive sales situations, it is imperative for the sales representative to have 
information about competitors to strengthen his sales strategy and differentiate his 
company's image and offerings. 

This chapter describes how to use the Competitors screen to examine 
comparisons of your company and competitors, view comparative literature of your 
products and those of your competitors, and associate a competitor with an 
opportunity.
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Business Scenario for Competitors
This scenario provides an example of a business process performed by a sales 
representative using the competitors view. Your company may follow a different 
process according to its business requirements.

A sales representative logs into the Siebel Sales application and discovers a newly 
qualified opportunity. He navigates to the Competitors view to review the 
competition for the opportunity. One competitor is listed for the deal. The sales 
representative is not familiar with the company and drills down on the competitor 
name hyperlink to learn more.

In the Company Comparisons view, the representative can view a side-by-side 
comparison of his company and the competitor’s company as well as comparison 
of products. He can access competitive intelligence documents compiled by his 
company about this competitor, and the literature items that the competitor has 
published.

A colleague in Telesales calls the sales representative and indicates that there is a 
new competitor trying to win the deal. The sales representative adds the new 
competitor to the opportunity to allow the sales team to research the new 
competition.
112 Siebel Sales User Guide Version 7.5, Rev. A



Competitors

Associating a Competitor with an Opportunity
Associating a Competitor with an Opportunity
Associating a competitor with an opportunity notifies the sales team about the 
competition for the deal and provides the team with a link to the information it 
needs to deliver a consistent, winning sales strategy.

To associate a competitor with an opportunity

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity, and then click the Competitors 
view tab.

3 In the Competitors list, click New.

4 In the Add Competitors dialog box, select the competitor and then click OK.

5 In the Competitors list, complete the fields.

TIP: Drill down on the hyperlink in the competitor Name field to navigate to the 
Competitors screen to obtain more information.

The following table describes some of the fields.

Field Comments

Comments A text field that allows you to record additional information about 
the competitor.

Name Displays the competitor’s company name as a hyperlink. 

Primary A check box which, when selected, indicates that the competitor is 
the primary rival for the deal.

Status A list of values established by your company that allows you to 
specify the prospect’s interest level in the competitor’s offerings. 
Default values include Some Interest, Evaluation in Progress, 
Existing Relationship, and Not Satisfied.

Threat A list of values established by your company that allows you to 
specify the value of the competitor’s threat. Default values include 
1-Low, 2-Medium, 3-High, 4-Very High.
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Viewing Competitor Comparisons
In many sales situations it is necessary to discuss competitive information with a 
prospect. Using the Competitors screen, you can view comparisons about 
companies, products, and services, and also find literature to prepare for sales calls.

To view competitor comparisons

1 Navigate to the Competitors screen, and in the Competitors list, select the 
competitor.

2 Click the Company Comparisons view tab.

The Company Comparisons, Competitor’s Literature, and Comparative 
Literature lists appear, as shown in the following figure.

3 In the Competitor’s Literature list, select the literature item you want to view, 
and then drill down on the hyperlink in the Name field.

4 In the Comparative Literature list, select the literature item you want to view, 
and then drill down on the hyperlink in the Name field.
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Products can be physical goods or intangible items such as service, sales 
agreements, or sales promotions.

This chapter describes how sales professions can use the read-only Products screen 
and its related views to address a customer’s questions about products and their 
features, review and provide the customer with product comparisons, and view 
price lists and associated products. 
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Business Scenario for Products
This scenario provides an example of a business process performed by a sales 
representative using the Products screen. Your company may follow a different 
process according to its business requirements.

A sales representative receives a call from a customer who has specific questions 
about a product the sales representative’s company sells. The prospect is interested 
in the benefits of a mid-range service package and how it compares to the next 
higher level of service package that the company offers. The sales representative 
views service information and is able to address the customer’s questions about the 
products and provide more detail about each offering.
116 Siebel Sales User Guide Version 7.5, Rev. A



Products

Viewing Product Features and Image
Viewing Product Features and Image
The Products screen’s Features and Image view allows you to review details about 
the product and, if an image is associated with the product, see a picture of the 
product. The Features and Image view is read-only. Your application or product 
administrator maintains the product information for your company.

To view product features and image information

1 Navigate to the Products screen, and in the Products list, select the product.

2 Click the Features and Image view tab.

NOTE: You can also view product features and image information from the Quotes 
screen and the Opportunities screen.
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Product comparisons present a feature-by-feature comparison between related 
products. You can use comparisons when you are prepare for meetings, sales calls, 
or when you are speaking to a prospect on the telephone.

To view product comparisons

1 Navigate to the Products screen, and in the Products list, select the product for 
the comparison.

2 Click the Product Comparison view tab.

The Product Comparison list appears. 
118 Siebel Sales User Guide Version 7.5, Rev. A



Products

Viewing Product Literature
Viewing Product Literature
You can view literature associated with a particular product. Literature items can 
include data sheets, white papers, marketing collateral, and so on.

To view product literature

1 Navigate to the Products screen, and in the Products list, select the product.

2 Click the Literature view tab, and in the Literature list, click Query.

3 In the query form, enter query criteria, and then click Go.

4 In the Literature list, drill down on the hyperlink in the Title field.

The literature opens in the format in which it was saved.
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Viewing Product Price Lists
You can view price lists to locate the price list associated with a particular product.

To view price lists

1 Navigate to the Products screen, and in the Products list, select the product.

2 Click the Price Lists view tab, and in the Price Lists list, click Query.

3 Enter query criteria in the form, and then click Go.

The price lists that meet the criteria appear in the list.

4 Select the price list record, and then drill down on the hyperlink in the Price List 
field to view additional information.
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When you discuss products with a prospect or customer, you may need to consider 
related products to substitute because products may be back ordered, sold out, 
delayed in shipping, or unavailable for other reasons.

To view related products

1 Navigate to the Products screen, and in the Products list, select the product.

2 Click the Related Product view tab, and then in the Related Product list, drill 
down on the hyperlink in the product name field.
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This chapter describes how to use the Activities screen and associated views to 
track tasks and events performed for contacts, accounts, and opportunities. 
Activities can be associated with accounts, contacts, and opportunities, and activity 
templates with predefined activities can be created and used company-wide.
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Business Scenario for Activities
This scenario provides an example of a business process performed by a sales 
representative managing new and existing activities. Your company may follow a 
different process according to its business requirements.

A customer plans to visit the headquarters of a software company to meet with 
executives and view a product demonstration. In preparation for the event, the sales 
manager creates and delegates to her team several activities such as preparing 
presentation slides, reserving a conference room, and configuring a demo. To make 
it easier to track these activities, the sales manager assigns the activities so that they 
appear in the team members' calendars and to-do lists.

As the manager and sales team members complete the activities, the activities are 
marked as done, providing important progress information about the opportunity.
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Siebel Sales tracks various tasks or events performed for contacts, accounts, and 
opportunities as activity records. Activities can be grouped into lists and activity 
templates created for use across the company.

Using activities, you can assess the investment in time and resources to maintain 
and grow account relationships. Sales managers also have a record of the activities 
of their sales representatives as they manage account relationships. Sales teams can 
use activities to avoid duplicating efforts across the team, and to share information 
about pending and completed activities. 

NOTE: Activities that are assigned specific dates and times appear on both the 
Activities and the Calendar screens. For more information, see Fundamentals.

To create an activity

1 Navigate to the Activities screen.

2 In the Activities list, add a new record, and then complete the fields.

If the activity should appear in the calendar as well as the activities list, choose 
Calendar and Activities in the Display In field, and make sure that the activity 
has a start time. 

The following table describes some of the fields.

Field Comments

Account The account associated with the activity.

Activity # A default, application-generated number.

Alarm The Alarm check box sets the activity reminder. A reminder 
dialog box appears when the activity is due. You can either 
set an alarm for an individual activity, or you can set a 
default alarm for all your activities. For more information, see 
Fundamentals.

Audience A list of values established by your company that allows you 
to specify which audiences can view the activity. Examples 
of values are employees, partners, and customers.
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Billable A check box which when selected, indicates the activity is a 
revenue-generating event.

Category A list of values established by your company that allows you 
to specify a category for the activity. 

Service related activities are often created by one individual 
(such as a call center agent) and completed by another (such 
as a service repair representative). Consequently, when a 
service related category value is selected (such as Diagnostic, 
Field Engineer Activity, Preventative Maintenance or Other), 
the owner of the activity is deleted so that the activity is 
unassigned. The user can then reassign the activity by adding 
a new value to the owner field. If the customer is using Siebel 
Assignment Manager, the activity is automatically 
reassigned. For more information about Activities and 
Categories, see Applications Administration Guide.

Comments A text field for activity notes and information to be shared by 
the team.

Cost Estimate The monetary value associated with the activity estimate.

Created The date and time the activity was created.

Created By The User ID of the activity creator.

Description A text entry field that can be used for additional information 
about the activity.

Display In A field that determines where an activity appears. The field 
has three values— Calendar and Activities, To Do and 
Activities, Activities Only. If, for example, you want an 
activity to appear in your calendar, you must set the Display 
In field to Calendar and Activities.

Due An editable date field that displays a date and time by which 
the activity must be completed.

Duration A list of values established by your company that allows you 
to choose the duration of an activity. Default values are in 
minute segments, for example 5, 10, 15, and 20.

Employees The User ID of the activity creator. You can select multiple 
employees for an activity, but only one employee can be 
designated as primary.

Field Comments
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End The proposed date and time for the activity completion.

Global Owner The employee who is responsible for the activity.

Meeting Location A text field that can be used for location information that is 
shared by the sales team. Examples of meeting locations are 
Conference Room B and Main Campus Facility.

Opportunity A dialog box that allows you to associate an opportunity with 
an activity.

Owner The primary employee associated with the activity. The 
default owner is the creator of the activity. Enter a new value 
into the field by typing the User ID directly into the field, or 
click the select button and choose the primary employee 
from the Pick Employee dialog box. The new Owner value 
that you enter also replaces the primary employee that 
appears in the Employee field. Conversely, if you add a new 
primary to the Employee field, this new primary also appears 
in the owner field.

Price List A list of values established by your company that allows you 
to specify which price list is associated with a billable 
activity.

Priority A list of values established by your company that allows you 
to assign a priority to the activity. Default values include 1-
ASAP, 2-High, 3-Medium, and 4-Low.

Project A dialog box that allows you to associate a project with an 
activity.

Rate List A list of values established by your company that allows you 
to specify which rate list is associated with a billable activity.

Repeat Frequency If Repeat Frequency is selected, this field displays the interval 
at which the activity repeats. Default values include daily, 
weekly, monthly, and yearly.

Repeat Until An editable field that displays the date and time for the last 
interval of the final meeting in the series.

Site A default value that is automatically entered when you 
associate the account with an activity.

Field Comments
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NOTE: The My To Do filter allows you to view each activity that has been designated 
as a To Do item using the Display In field. Choose My To Do List from the Show 
drop-down list to access this feature. You can further refine the To Do List by using 
the predefined queries that appear in the Queries drop-down list. For example, if 
you select the Uncompleted Activities query, the To Do items that do not have a 
status of Done appear. You can also view uncompleted To Do items in the To Do list 
that appears on the calendar screen. This list, by default, only shows To Do items 
that are not yet complete.

Start An editable field that displays the activity creation date and 
time.

Status A list of values established by your company that allows you 
to assign a status to the activity. Default values include 
Acknowledged, Cancelled, Declined, Scheduled, and 
Completed.

Type A list of values established by your company that allows you 
to define the activity type. Default values include Call, 
Correspondence, and Email.

Field Comments
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If you work as part of a sales team or you are a sales manager, you may manage 
other people’s activities. You can delegate an activity to another member of the 
sales team, an employee, or a partner.

To delegate an activity

1 Navigate to the Activities screen, and in the Activities list, select the activity that 
you want to delegate.

2 In the Activity form, click the select button in the Owner field.

3 In the Pick Assigned to dialog box, choose the individual to whom the activity 
will be assigned, and then click OK. 

The previous owner is removed from the activity and the selected individual 
becomes the new owner. 

To reassign an activity using the Employee field

1 Navigate to the Activities screen, and in the Activities list, select the activity that 
you want to reassign.

2 In the Activity form, click the select button in the Employees field.

3 In the Employees dialog box, select the employee to whom the activity will be 
assigned.

Click New to add employees to the Employee dialog box.

4 Click the check box in the Primary field to designate the individual as the 
primary employee, and then click OK.

To remove the old owner from the activity 

1 Navigate to the Activities screen, and in the Activities list, select the activity.

2 In the Activity form, click the select button in the Employees field.
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3 In the Employees dialog box, select the old owner and click Delete.

NOTE: If you want the application to use Siebel Assignment Manager to 
automatically assign a person, in the Activity form click the menu button and 
choose Assign. If the delegator uses Siebel Assignment Manager to reassign an 
activity, the delegator is automatically removed from the employee list.
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When you add an activity to your calendar, you may also want to have a record of 
individuals who participate in the activity, and available resources.

To associate an employee with an activity

1 Navigate to the Activities screen, and in the Activities list, select the activity.

2 Click the Participants view tab.

3 In the Employees list, click New.

4 In the Add Employees dialog box, select the employee, and then click OK.

To associate a contact with an activity

1 Navigate to the Activities screen, and in the Activities list, select the activity.

2 Click the Participants view tab.

3 In the Contacts list, click New

4 In the Add Contacts dialog box, select the contact, and then click OK.

To associate a resource with an activity

1 Navigate to the Activities screen, and in the Activities list, select the activity.

2 Click the Participants view tab.

3 In the Add Resources list, click New.

4 In the Resources dialog box, select the resource from the list, and then click OK.

Your application administrator creates and associates activity templates and activity 
plans with specific stages in the sales process. For more information about creating 
activity templates, see Applications Administration Guide.
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Activity Templates and Activity Plans
Activity templates allow you to coordinate complex tasks into a predefined set of 
activities called an Activity Plan. You can select an appropriate Activity Template 
for the goal you want to achieve, which generates a list of activities associated with 
the Activity Template. This keeps you from creating a new list of activities for each 
sales call, corporate visit, and special event. 

For instance, the following list of activities can serve as an Activity Template for a 
a corporate visit with clients for product demonstrations:

■ Book a conference room

■ Set an agenda

■ Confirm the date and time with the customer

■ Make arrangements for presenters

This set of tasks, when defined as a template, helps sales team members follow the 
steps your company recommends to prepare for a corporate visit. The list drives 
critical tasks and defines the recommended lead time for each activity within the 
template.

Activity Plans are groups of activities or subactivities related to successfully 
completing a business service. Frequently, activity plans incorporate a company’s 
best practices. Using activity plans, you can locate, assign, schedule, and track the 
progress of related activities. 

For example, each activity associated with a customer visit to corporate 
headquarters can be assigned to a different individual, and each activity can have 
a different due date. You can track the progress of all activities associated with the 
customer visit using the Activity Plan.

For more information on creating activity templates and plans, see Applications 
Administration Guide.
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This chapter describes how to use the Messages screen to create messages and 
alerts, and associate messages with accounts, opportunities, contacts, and service 
requests. 
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Business Scenario for Messages
This scenario provides an example of a business process performed by a sales 
representative managing messages and alerts. Your company may follow a different 
process according to its business requirements.

A sales assistant receives a message for an executive, either by phone or by voice 
mail. Instead of writing the message out by hand, the assistant enters the message 
in the Messages screen and assigns the message to the executive. Before saving the 
message, the assistant can perform the following tasks:

■ Associate the message with an existing account, opportunity, contact, or service 
request

■ Add additional information to the message in the Comments field

■ Add electronic file attachments to the message

■ Prioritize the message

■ Send an email or screen alert or both

By default, a message is marked private, which means that only the assistant and 
executive can review the message. The assistant can choose not to mark the 
message private, and then any individual with access to the account, activity, 
contact, opportunity, or service request associated with the message can view it.
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There are two types of message alerts you can establish to send screen or email and 
screen alerts. You can set up email and screen alerts for messages and individuals 
to whom you delegate message-related activities, and perform the following tasks:

■ Set up an alert for an individual to whom you routinely send messages

For instance, you routinely send messages to the same individuals, and you want 
to set up a standard alert method to let them know you have sent a message.

■ Set up an alert for a single message so the recipient receives an alert

For instance, you send a message to an individual for whom you have not set up 
a message alert, but you can also set up an alert for the individual message.

Email and Screen Alerts
You can opt to receive both email alerts and screen alerts simultaneously.

Email Alerts. A message generates an email alert when the following events occur:

■ A message is created and the Alert Type field has a value of Email or Email and 
Screen Alert.

■ A message is assigned to you, and you have set up an alert to receive email when 
messages or activities are assigned to you by a contact or employee.

■ An activity is assigned to you, and you have set up an alert to receive email 
when messages or activities are assigned to you.

■ You send an email from your Siebel application.

Screen Alerts. A message generates a screen alert when the following events occur:

■ A message is created and the Alert Type field of the Messages form has a value 
of Screen Alert.

■ A message is assigned to you, and you have set up an alert to receive email when 
messages or activities are assigned to you by a contact or employee.

■ An activity is assigned to you, and you have set up an alert to receive a screen 
alert when messages or activities are assigned to you.
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Creating a New Message
Use messages to communicate with others who also use Siebel Sales. You can create 
messages, set up email and screen alerts, view and sort messages, and associate 
activities and other items with messages. Using messages allows you to maintain a 
history of the communication associated with a contact, account, opportunity, or 
information request.

To create a new message

1 Navigate to the Messages screen.

2 In the Daily Messages list, click New.

3 In the new message form, complete the fields.

The following table describes some of the fields.

Field Comments

Account Shows the Account name associated with the message, if applicable.

Alert Type Allows you to select a value from the drop-down list to indicate the 
alert type for the message. Default values include None, Email, 
Screen Alert, and Email and Screen Alert.

Assigned To A required field that displays the name of the individual to whom 
you are assigning the message. You can select a default value in the 
Default Assigned To field in the User Preferences screen. See 
Fundamentals for more information on user preferences.

Comment An optional text field that displays additional information.

Date/Time An editable field that displays the month, day, year and the hour, 
minute, second that the message was created. 

Email Address Automatically populates the email address when you select the 
contact record.

First Name Automatically populates the first name of the contact when you 
select the contact record.

Home Phone # Automatically populates the home telephone number when you 
select the contact record.
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Last Name A required field that displays the last name of the contact you 
selected as the message recipient. After a record is saved, you can 
drill down on the hyperlink to navigate to Contacts and More Info.

Message A text field that displays the content of the message.

Mobile Phone # Automatically populates the mobile telephone number when you 
select the contact record. 

Opportunity Displays the Opportunity associated with the message, if applicable. 
Click the select button to choose an opportunity.

Priority Allows you to select a value from the drop-down list to indicate the 
message priority. Default values include 1-ASAP, 2-High, 3-Medium, 
and 4-Low.

Private A check box which, when selected, allows only the message creator 
and recipient to view the message. When the check box is cleared, 
team members associated with the opportunity, account, contact, 
and service request can view the message.

SR # The Service Request number associated with the message, if 
applicable.

Status Allows you to select a value from the drop-down list to indicate the 
message status. Default values include New, Read, Delegated, 
Return Call, and Completed.

Work Phone # Automatically populates the business telephone number when you 
select the contact record.

Field Comments
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Setting Up a Message Alerts
You can set up an ongoing alert type for an individual. This individual always 
receives an alert when you assign a message to him.

You also can assign an alert to a single message to notify the recipient of a message. 
You can do this either while you are creating the message or after you have saved 
the message.

To set up an ongoing message alert

1 Navigate to the Messages screen.

2 Click the Message Alert Setup view tab.

3 In the Message Alerts Setup list, click New.

4 In the new Message Alert record, click the select button in the Last Name field.

5 In the Pick Contact dialog box, select the name, and then click OK.

6 In the Alert Type drop-down list, select the type of alert.

The default value in the Alert Type field is None. Other values are Email Alert, 
Screen Alert, and Email and Screen Alert.

To send a single message alert

1 Navigate to the Messages screen.

2 In the Daily Messages list, click New.

3 In the Message Details form, click the drop down list in the Alert Type field, and 
then choose the type of alert to assign to the message.
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Viewing Messages
You can view messages assigned to you, or created by you, using Siebel Sales.

To view messages assigned to you

1 Navigate to the Messages screen.

2 In the Daily Messages list, select the message to read.

3 In the Message Details form, review the text in the Message field.

To view messages created by you

1 Navigate to the Messages screen.

2 Click the All Messages view tab.

3 In the All Messages list, click the menu button, and then choose Columns 
Displayed.

4 In the Columns Displayed dialog box, move Created By from the Available 
Columns list to the Selected Columns list, and then click Save.

5 In the All Messages list, click Query, complete the Created By field, and then 
click Go.

6 In the All Messages list, sort the messages by the Date/Time field.
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Sorting Messages by Intervals
Use the appropriate view tab to sort messages into Daily, Weekly, or Monthly lists. 
You also can use queries to achieve the same result. The default query for the My 
Messages list displays all messages, but you can select predefined Daily, Weekly, or 
Monthly queries to refine your lists.

To sort messages by intervals

1 Navigate to the Messages screen.

A list of messages you received today appears in the Daily Messages list.

2 Adjust the values in the Date fields, and then click Go.

A list of messages for the specified date appears.

3 Click Today to reset the date to the current date.

4 Click the Weekly Messages view tab to view messages you received in the 
previous seven-day interval.

5 Click the Monthly Messages view tab to view messages you received in the last 
30 days.
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Associating a Message with an Opportunity
You can associate a message with an opportunity, a contact, an account, or a service 
request. You can also use the basic procedure to associate a message with other 
items by selecting the appropriate field name, such as account or contact.

To associate a message with an opportunity

1 Navigate to the Messages screen.

2 In the Messages list, click New.

3 In the Message Details form, click the select button in the Opportunity field.

4 In the Pick Opportunity dialog box, select the opportunity to associate with the 
message, and then click OK.
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Associating an Attachment with a Message
You can associate an electronic file with a message as an attachment to provide the 
message recipient with related information. For example, you can attach a sales 
document to a message requesting a review by your manager. For general 
information on working with attachments, see Fundamentals.

To associate an attachment with a message

1 Navigate to the Messages screen.

2 In the messages list, select the message, and then click the Attachments view 
tab.

3 In the Message Attachments list, click New.

4 In the new record, click the select button in the Attachment Name field.

a In the Add Attachment dialog box, click Browse, navigate to the file, and then 
click Open. 

b In the Add Attachment dialog box, click Add.

The attachment record appears in the Message Attachments list associated with 
the message.

5 In the attachment record, enter a description of the attachment in the Comments 
field.
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Associating an Activity with a Message
When you need to share information related to an item that requires follow-up 
action, you can associate an activity with a message. For more information on the 
activity-related fields, see Chapter 9, “Activities.”

To associate an activity with a message

1 Navigate to the Messages screen.

2 In the Daily Messages list, select the message.

3 Click the Activities view tab.

4 In the Activities list, click New, and then complete the fields.
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Sending a Message Using Email
You can send email messages to the recipient from within Siebel Sales. The recipient 
either can be inside or outside your corporate firewall because Siebel Sales uses the 
email address associated with the contact information for the recipient. After you 
create a message and complete the necessary fields, you can send the message as 
an email. For information on standard email functionality within Siebel Sales, see 
Fundamentals.

To send an email message

1 Navigate to the Messages screen.

2 In the Daily Messages list, select the message to send as an email message.

3 From the application-level menu, select File > Send > Email.

4 In the Send Email dialog box, complete the fields for the email, and then click 
Send.

5 In the email form, click To to display the Address Book dialog box.
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This chapter describes how sales professionals can use the Correspondence screen 
to communicate and track correspondence with prospects and customers. It also 
explains how to create and use correspondence templates, and generate, print, and 
send correspondence to a Fulfillment Center. For more information on 
administrative tasks relating to Correspondence, see Applications Administration 
Guide.
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Business Scenario for Correspondence
This scenario provides an example of a business process performed by a sales 
representative managing correspondence. Your company may follow a different 
process according to its business requirements.

Sales professionals use Siebel Sales correspondence to automate letter writing tasks, 
send out literature, and track correspondence sent to prospects and customers. 

A customer requests literature about specific product and service offerings. The 
sales representative creates a letter using a template called Thank You for Your 
Interest. The sales representative selects the contact recipient and determines which 
product literature to include with the letter.

When the sales representative reviews the letter, he see a Microsoft Word document 
that includes the customer’s name and address, thanks the customer for his interest 
in the product, and tells him a little about the company. The letter also lets the 
customer know that the sales representative plans to follow up with the customer 
soon.

When the sales representative is ready to send the letter, he can print the letter and 
send it, or have the company’s fulfillment center generate the letter, enclose the 
product literature, and send it on behalf of the sales representative. The sales 
representative also can email this information to the customer. A record of the 
correspondence is associated with the contact, and allowing the sales representative 
to review the correspondence at a later date.
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Creating Correspondence
You can create correspondence using a selection of pre-defined templates for letters 
and labels. You can create personal templates that only you can access, or you can 
use templates created by your administrator. For information on creating personal 
templates, see “Creating a Personal Correspondence Template.”

NOTE: You must associate one or more recipients with the correspondence before 
you can generate or submit the request for fulfillment.

To create correspondence

1 Navigate to the Correspondence screen.

2 In the Correspondence list, add a new record.

3 In the new Correspondence record, select a correspondence template.

For example; if you want to create a mailing you might choose the 
MICROSOFT_Promotional template for the letter and the MICROSOFT_Labels 
template for the mailing labels. If you only want to create labels, you still select 
both templates, but only generate the labels with the Generate Labels command 
in the Correspondence list menu.

NOTE: The fixed text of each correspondence template is written using specific 
locale conventions and language. The author of the template can choose the 
locale and language using the Locale and Language fields in the template record 
to support Global Deployment. 

a To create a letter, click select in the Template field, choose a letter template 
from the Pick Template dialog box, and then click OK.

b To create a label, click select in the Template field, choose a label template 
from the Pick Template dialog box, and then click OK.
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4 In the correspondence record, complete the fields.

The following table describes some of the fields.

Field Comments

Created Date A default value that displays the date and time you created 
the correspondence.

Document Status The system status for the document during generation. 
Default values include In Progress, Generating, Completed, 
and Failed.

Fulfillment Center A list of fulfillment centers that can produce and distribute 
the document and enclosures on your behalf.

Generated Document Drill down on the hyperlink in this field to preview the 
document merged with the name and address of the selected 
recipient in the Recipients list.

Generated Label Drill down on the hyperlink in this field to preview the label 
merged with the name and address of the selected recipient 
in the Recipients list.

Label Status The system status for the label during generation. Default 
values include In Progress, Generating, Completed, and 
Failed.

Label Template The name of the label template defined by your company 
and created by your Siebel administrator, or your personal 
template.

Modified Template If you have modified the template, click the select button in 
this field and navigate to the modified file to choose it. For 
example, you choose a template, drill down on the Template 
name hyperlink to open the template and modify template 
text. After saving the modified file locally, you specify it 
using the Modified Template field.

Opportunity The name of the opportunity associated with the 
correspondence. Drill down on the hyperlink in the 
opportunity name field to open the Opportunity details 
form.
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5 Click in the Recipients list and proceed to “Editing a Correspondence Template.”

NOTE: You can create correspondence from any screen by navigating to the 
application-level menu and selecting File > New > Correspondence. This action 
takes you to the Correspondence screen where you can create your letter or label.

Status The correspondence status. Values include Submitted, 
Pending, and Completed.

Template The name of the selected template defined by your 
company, or your personal template.

Field Comments
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Editing a Correspondence Template
You can edit an existing template to add a different personal message to each 
correspondence request. By editing the template you only modify the template for 
the selected Correspondence request. Only an administrator can make a global 
change to a template.

To open and edit an existing template

1 Navigate to the Correspondence screen.

2 In the Correspondence list, click New.

3 In the new correspondence record, click the select button in the Template field. 

4 In the Pick Template dialog box, choose a template, and then click OK.

5 Drill down on the hyperlink in the Template field to open the template in 
Microsoft Word.

6 In Microsoft Word, edit the template, and then select Save As to save the edited 
template to your desktop or to a shared network folder.

7 In the Correspondence record, click select in the Modified Template field to 
browse and add your edited template to the Correspondence record.

Inserting Templates into Correspondence Templates
You can insert one or more templates into your correspondence template. For 
instance, if you have a description of your company that you want to include in 
many correspondence templates, you can type this description in a separate file and 
insert the text into the correspondence you send. You can insert as many files into 
a correspondence item as you want, but each file name must be unique. 

Your Siebel application supports inserting one level of files, but you cannot insert 
nested files. For instance, you can insert files called File1.doc, File2.doc, and 
File3.doc into a template called FollowUp.doc, but you cannot insert File1.doc into 
File2.doc and then insert File2.doc into FollowUp.doc. Each file must be inserted 
into the correspondence template independently. 
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The template into which you insert the file can be a public template created by an 
administrator, or a personal template that you created. Only Microsoft Word files 
can be inserted into Microsoft Office templates.

To insert a file into a correspondence template

1 Navigate to the Correspondence screen, and create a correspondence record.

For more information, see “To create correspondence” on page 147.

2 In the Template Name field, choose the file that you want to insert.

3 Drill down on the hyperlink in the Template field to open the template in 
Microsoft Word.

4 Within the template file, locate a separate line at the location where the file 
should be inserted, and then enter the following text.

[[<File Name>]]

[[<File Name>]] is the name of the inserted file. The file name must have the 
same name as the template into which it is inserted. 

5 Save the modified template to your desktop or on a shared network drive.

6 In the Modified Template field, select the modified template.

7 Click Generate.

When you generate the correspondence, the file is merged into the 
correspondence.
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Adding Recipients to Correspondence
You must choose one or more contacts as recipients before you can generate the 
correspondence. If you are sending the correspondence to someone who is not 
listed as a contact, you can add that individual in the Add Recipients dialog box. 
The individual is then added to the Contacts list and as a recipient for the selected 
Correspondence record.

NOTE: There is no maximum limit to the number of recipients that you can add to a 
correspondence item, however, the number of recipients affects performance and 
time required to generate the final document.

To add a recipient to correspondence

1 Navigate to the Correspondence screen, and create a correspondence record.

For more information, see “To create correspondence” on page 147.

2 In the Recipients list, click Add.

3 From the Add Recipients dialog box, add recipients.

Use one of the following methods:

■ To send correspondence to an existing contact, select the recipient in the Add 
Recipients dialog box, and then click Add.

■ To send correspondence to a new contact, click New in the Add Recipients 
dialog box, complete the fields as needed, and from the menu, choose Save.

NOTE: You can drill down on the hyperlink in the Last Name field to navigate 
to the Contacts screen’s Activities list.
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Enclosing Literature with Correspondence
You can select literature such as sales brochures, white papers, and data sheets from 
the Siebel Encyclopedia and associate the information with your correspondence. 
This functionality allows you to send and track items you enclose with 
correspondence. 

To view available literature

1 Navigate to the Correspondence screen, and from the Show drop-down list, 
choose Literature Selection.

2 In the Explorer tree, click the plus sign (+) to expand the view of literature items 
in each category.

The list at right provides detail for selected category items.

3 In the list, use Query to locate desired literature items. 

NOTE: In the Explorer, when you drill down to the actual Literature item, the Add 
Enclosure button appears on the Literature list at right. Add Enclosure allows 
you to add the enclosure to the correspondence record. However, most users 
select the enclosure using the Enclosures list on the Correspondence screen.

To enclose literature with correspondence

1 In the Correspondence list, create a correspondence record.

For more information, see “To create correspondence” on page 147.

2 In the Enclosures subview list, click Add.

3 In the Add Literature dialog box, select the literature item you want to enclose, 
and then click Add.

4 In the Enclosures list, complete the fields for the enclosure record.
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5 To view the literature file, drill down on the hyperlink in the Name field. 

You must have the corresponding application loaded on your computer to view 
literature files created using that application.

NOTE: If you are working in a Mobile Web Client environment (remote), you 
must have the literature files available in your local environment. If the Local 
check box is selected, you can work with the file in a remote environment. To 
download the file from the server the next time you synchronize, select the 
Request check box when you add the Literature file.
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Generating Correspondence
After you have created a correspondence item from a template, and selected or 
added recipients, you can generate your correspondence. The Generate button is 
disabled after a correspondence is queued.

NOTE: You cannot edit and regenerate a document that has already been generated. 
Instead, specify modified document templates in the Modified Template field.

To generate correspondence

If you are creating correspondence using the Siebel Web client (network 
connection), follow Step 1 through Step 4.

If you are creating correspondence in a Mobile Web Client environment (remote) 
and have the Mobile Web Client installed locally on your computer, follow Step 1 
through Step 3.

1 In the Correspondence list, create a correspondence record.

For more information, see “To create correspondence” on page 147.

2 Associate a recipient with the selected correspondence record.

For more information, see “To add a recipient to correspondence” on page 152.

3 In the Correspondence list, select the correspondence, and then click Generate.

A draft of the letter appears automatically if you are using the Mobile or 
Dedicated Web client. 

To preview the letter with the Siebel Web client, see “Previewing Letters and 
Labels” on page 157.
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4 Click Update to see an updated status of the generation process.

The status of the correspondence refreshes when you click Update. 
Correspondence Status values include In Progress, Generating, Completed, and 
Failed.

If the status is Failed, an error message appears in the Document Error or Label 
Error fields.
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Previewing Letters and Labels
You should preview the letter before sending it to a contact. If you do not use a 
fulfillment center, you can print a letter or label from the preview screen. You must 
generate correspondence before you can preview it.

NOTE: If you use a fulfillment center, you do not have to print the letter, but you 
should still preview it before sending it. 

To preview a letter or label

1 Navigate to the Correspondence screen.

2 In the Correspondence list, select the correspondence you want to preview.

■ Drill down on the Merged hyperlink in the Generated Document field to 
display a document in your word processor, if you have the word processor 
installed locally. 

■ Drill down on the Merged in the Generated Label field to display labels in 
your word processor, if you have the word processor installed locally. 

■ In the Correspondence list, click the menu button and choose View (HTML) 
to display a document in your Web browser if you do not have the word 
processor installed locally. 

■ In the Correspondence list, click the menu button and choose View Label 
(HTML) to display labels in your Web browser if you do not have the word 
processor installed locally. 

The letter or label appears, with the recipient’s name and address information 
merged into the template.
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Sending Correspondence to a Fulfillment Center
If the fulfillment center is part of the Siebel Enterprise, you can submit fulfillment 
requests from the Correspondence list. 

To send correspondence to a fulfillment center

1 Navigate to the Correspondence screen, and from the Show drop-down list 
choose My Correspondence Requests.

2 In the Correspondence list, select the correspondence that you want to submit 
to your fulfillment organization. 

3 In the Correspondence list, click the Fulfillment Center drop-down list and then 
select the appropriate fulfillment center.

4 Click Submit.

The Document Status changes to In Queue.
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Monitoring Fulfillment Requests
When you submit correspondence to a fulfillment center, the status of the 
correspondence is set to Submitted. When your correspondence request is fulfilled, 
the fulfillment center updates the status to Done, which associates an activity with 
each recipient (contact). You can monitor the status to determine the date and time 
that your correspondence was sent and time your follow-up calls and sales visits 
accordingly.

To monitor fulfillment requests

1 Navigate to the Correspondence screen.

2 In the Correspondence list, select the correspondence record, and then verify 
that Done appears in the Status field.
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Recalling Submitted Correspondence
You can recall correspondence records that you have submitted, as long as the 
correspondence records have not been fulfilled. You can recall correspondence to 
modify it and resubmit it for fulfillment.

To recall correspondence

1 Navigate to the Correspondence screen.

2 In the Correspondence list, select the correspondence to recall.

3 Click the menu button, and then choose Recall.

The correspondence status reverts from Submitted to In Progress. 
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Creating a Personal Correspondence Template
You can create your own letter templates that are not accessible to other users. 
Although you can create a new template, it is much easier to create a template based 
on an existing correspondence template. This approach allows you to reuse 
elements from the existing template, such as a company logo or mail merge fields, 
in your personal template.

You must have Microsoft Word installed locally to create a personal template. 

NOTE: Mail merge fields are placeholders for information that is merged from your 
Siebel application into correspondence. Creating new mail merge fields (not copied 
from a template) is a complex process that requires the assistance of your Siebel 
administrator. 

To create a personal template

1 Navigate to the Correspondence screen, and from the Show drop-down list, 
choose Personal Templates.

2 In the Personal Templates list, click New.

3 In the new record, click the select button in the Template Name field.

4 In the Add Attachments dialog box, click Browse in the File Name field.

5 In the Choose File dialog box, select the document, and then click Open.

6 In the Add Attachment dialog box, click Add.

The template name appears in the File Name field, and information about the 
file appears in the Active, Size, Type, and Modified fields.

This template also appears in your list of templates.

7 In the Templates list, drill down on the hyperlink in the file name field to view 
the template.
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Batch Printing Correspondence
To batch print, you select correspondence items in the Correspondence screen list, 
click the menu button, and then choose Print. The Print menu item is only active if 
the selected correspondence record has a value of Completed in the Document 
Status field.

The Print menu item in the Correspondence and Fulfillment screens is configured 
for client-based printing. However, your administrator can configure server-based 
printing in addition to (or instead of) client-based printing.

Check with your system administrator to determine which print method is 
available.

Preparing for Client-Based Batch Printing 
When you use client-based batch printing, Siebel Sales launches Microsoft Word on 
your client system. The application retrieves the document from the Siebel File 
System and prints it to the default printer configured for your desktop session. 
Before using client-based batch printing, verify that the following prerequisites are 
completed:

■ Install Microsoft Word on the client system.

■ Configure Internet Explorer to start Microsoft Word.

■ Configure the default printer for your desktop system.

To configure Internet Explorer to allow client-based batch printing

1 Start Internet Explorer and log in to the Siebel Sales application.

2 In the Internet Explorer, select Tools > Internet Options.

3 Select the Security tab, and then choose Custom Level.

The security zone used by Siebel is highlighted (either Local intranet, or 
Trusted). Verify that any other URL in this zone can be trusted with extra 
security privileges.

4 In the Security Settings dialog box, locate the following option: 

Initialize and script ActiveX controls not marked safe
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5 Change the option setting to either Enable or Prompt, and click OK.

6 Click Yes to answer the question, Are you sure you want to change the security 
for this zone?

7 In the Internet Options dialog box, click OK.

To add a printer connection to your desktop

1 Select Start Menu > Settings > Printers.

2 Double-click the Add Printer icon.

3 Click Next on the Welcome screen.

4 In the Local or Network Printer screen, select Network Printer, and then click 
Next.

5 In the Locate Your Printer screen, select Type the Printer Name.

6 Enter the network name of the printer, or click Browse and select the printer, and 
then click Next.

7 In the Default Printer screen, choose either Yes, or No, and then click Next.

8 In the Completing the Add Printer Wizard screen, click Finish.

To change the default printer

1 Select Start Menu > Settings > Printers.

The current default printer is marked with a check mark.

2 Select a new default printer by right clicking on the desired printer and choosing 
Set as Default.

To print documents using client-based printing

1 Close files that are open in Microsoft Word.

2 From the Siebel Sales application-level menu, choose View > Site Map > 
Correspondence or Fulfillment.
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3 In the Correspondence list, select one or more records.

Each selected correspondence record must have a Document Status of 
Completed.

4 In the Correspondence list, click the menu button, and then select Print.

The selected documents are printed to the default printer.

Preparing for Server-Based Batch Printing
Server-based batch printing sends a printing request to the Siebel Document Server. 
The document is then sent to the printer specified in User Preferences. If you do not 
specify a printer, the document is printed on the default printer configured by the 
System Administrator.

To specify a printer for server-based batch printing

1 From the application-level menu, choose View > Site Map > User Preference 
> Correspondence.

2 In the Default Printer field, enter the network name of the printer used for 
Correspondence. 

The network name should contain both the printer server name and the printer 
name as shown in the following example.

\\printer_server_name\printer_name

3 In the Printer Driver field, enter the name of the printer driver used to generate 
an intermediate file during the printing process, and then click Save.

The System Administrator should provide you with a list of printer drivers and 
their associated printer types. Select the Printer Driver associated with the 
printer you previously specified in Step 2.

To print documents using server-based printing

1 From the application-level menu, choose View > Site Map > Correspondence 
or Fulfillment.

2 Select one or more records in the Correspondence list. 

Selected correspondence must have a Document Status of Completed.
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3 In the Correspondence list. click the menu button and then select Print.

The selected documents are printed to the default printer specified in User 
Preferences.
Version 7.5, Rev. A Siebel Sales User Guide 165



Correspondence

Batch Printing Correspondence
166 Siebel Sales User Guide Version 7.5, Rev. A



Literature 12
This chapter describes how to use the Literature screen and associated views 
to view and distribute white papers, marketing brochures, competitive data, 
product information, and other types of documents that your company determines 
are appropriate for the literature repository.

Literature is stored and managed online, which allows you to view the most recent 
versions through the shared repository. Typically, content experts at your company 
maintain the literature repository by updating files, adding new ones, and removing 
outdated ones.
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Business Scenario for Literature
This scenario provides an example of a business process performed by a sales 
representative using the Literature screen. Your company may follow a different 
process according to its business requirements.

A sales representative reviews sales and marketing information stored in the 
literature repository. The sales representative’s company sells a large number of 
products, and literature allows the representative to view and distribute sales 
brochures, white papers, and other product information.

A customer calls to ask the sales representative for detailed information on a new 
computer hardware component that the representative’s company recently 
advertised. The sales representative uses literature to research the hardware 
specifications and features while the customer is on the telephone. 

While the customer and representative are viewing the literature online, the 
representative emails product literature to the customer, and faxes product 
specifications to the customer’s business office.
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Viewing Literature
You can use the Literature screen to view a list of available marketing and sales 
information, and display the document if the application used to create the 
literature. is installed on your desktop system.

To view literature

1 Navigate to the Literature screen, and in the Literature list, select the literature 
item you want to view.

2 Drill down on the hyperlink in the Name field.

The application that was used to save the document opens, and the document 
appears.
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Sending Literature by Email and Fax
You can send a literature item as an email attachment or a fax message from within 
Siebel Sales. 

To send literature as an email attachment

1 Navigate to the Literature screen, and in the Literature list, select the literature 
item you want to send.

2 From the application-level menu, select File > Send >Email.

The Send Email dialog box appears with the literature item added as an 
attachment.

NOTE: You can also attach files to email by clicking the attachment icon and 
following the instructions to attach a file. For more information on attachments, 
see Fundamentals.

To send literature by fax

1 Navigate to the Literature screen, and in the Literature list, select the literature 
item you want to send.

2 From the application-level menu, select File > Send > Fax.

The Send Fax dialog box appears with the literature item added as an 
attachment.

3 In the dialog box, complete the necessary fields, and then click Send.
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Viewing Product Literature
The Product Literature Explorer allows you to examine your company’s product 
lines and services and locate individual literature items.

NOTE: You can also use the InfoCenter screen to find product information and other 
types of literature.

To view product literature

1 Navigate to the Literature screen.

2 From the Show drop-down list, choose Product Literature.

The Product Literature Explorer appears.

3 In the Product Lines Explorer list, select the product line, and then click the plus 
sign (+) next to each folder in the hierarchy of folders until you reach the 
Literature folder.

Clicking the plus (+) sign next to the Literature folder displays a list of literature 
items associated with the product. The list appears to the right of the explorer.

4 In the Literature list, drill down on the Title hyperlink.

The literature item opens in the format in which it was saved.
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Sales professionals can track information about accounts, opportunities, and 
contacts using the Categories screen and associated views. This chapter describes 
how to use predefined categories to sort and search for specific criteria, and enter 
information that defines a personal sales approach and style. The information can 
be shared with other members of the sales team or kept private.
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Business Scenario for Categories
This scenario provides an example of a business process performed by a sales 
representative using the Categories screen and views. Your company may follow a 
different process according to its business requirements.

A sales representative wants to track information to help manage relationships with 
current and potential customers. Categories, which can be designated as private or 
shared with the sales team, provide the sales representative with a way to organize 
information about an account, opportunity, or contact.

The sales representative can track the most active accounts by creating a category 
called Hot Accounts, and then select that category for each account that she wants 
to add to her active list. 

The sales representative also can view a list of all the opportunities she has closed 
over a period of time. If she sets up a Closed category, she can see which 
opportunities she has closed during the previous year. 

Sales professionals also can use categories to track personal information about 
contacts. For instance, a sales representative can record hobbies, such as golf or 
tennis, and designate that category for contacts she plans to invite to her company-
sponsored sporting events. In addition, she can track family names or add contacts 
to a category called Holiday List that allows her to create a seasonal mailing list.
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Adding a Category
You can add categories to accounts, contacts, and opportunities. The procedure that 
follows explains how to add a category for accounts. You can add a category for 
contacts or opportunities by navigating to the appropriate screen, and then 
following Step 3 through Step 7 in the procedure.

To add an account category

1 Navigate to the Accounts screen.

2 In the Accounts list, select the account for which you want to add a category.

3 Click the Categories view tab.

4 In the Categories list, click New.

5 In the new record, click the select button in the Category field.

6 In the Pick Category dialog box, choose an existing category, or click Query to 
locate a category, and then click OK.

NOTE: In the Pick Category dialog box, click New to create a new category, and 
then complete the category name, description, and public fields to add the new 
category to the Pick Category dialog box.

7 Complete the category fields.

The following table describes some of the fields.

Field Comments

Category Opens a dialog box that allows you to select an existing 
category or add a new one.

Category Rank A value that defines the category. The rank can be any 
numeric value. 

Comments A text field for additional information about the category.
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Private A check box which, when selected, restricts sales team 
members from seeing how you have categorized the account. 
When the check box is selected, the category is private.

Clear the check box to designate the category as Public 
allowing access by team members.

Value The numeric value assigned to the category.

Value Rank Defines the rank of the value.

Field Comments
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Searching for a Category
You can search for specific accounts, opportunities, and contacts using the 
categories you and your team have defined. The procedure that follows describes 
how to search for an account category. Use the same procedure for the 
Opportunities, Contacts, and Personal categories.

To search for an account category

1 Navigate to the Categories screen.

2 In the Categories list, click Query. 

3 In the Category form, click the select button in the Category field.

4 In the Pick Catalog dialog box, choose a category, and then click OK.

5 In the Categories query form, click Go.
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This chapter describes how to use the Quotes screen and associated views to create 
quotes, add line items and details, apply manual discounts, customize product 
offerings and then create favorite product configurations, and generate sales orders. 
For more information on quotes and orders, see Siebel Order Management Guide.
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Business Scenario for Quotes
This scenario provides an example of a business process performed by a sales 
representative using the Quotes screen and views. Your company may follow a 
different process according to its business requirements.

A sales representative uses quotes to create formal offers to prospects for a variety 
of products and services his company provides. Siebel Sales helps the sales 
representative develop accurate quotes without being encumbered by manual 
verification. 

The sales representative can access information and resources in one central 
location, which eliminates the need to cross reference pricing books, and he can 
create a quote record and add line items to configure a specific quote.
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Creating a Quote
Quotes include effective dates, price lists, and discounts used in pricing products 
and services. Before you can work with the line items and details of a quote, you 
must create a quote, which can be associated with an opportunity.

When a customer is ready to purchase a product or service, you provide the 
customer with a quote, a formal offer for products and services that includes 
specific prices and related payment terms.

Quotes can be created from the Quotes screen, the Accounts screen, or the Contacts 
screen. The following procedure describes creating quotes from the Opportunities 
screen.

To create a quote

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity, and then click the Quotes view 
tab.

3 In the Quotes list, add a new record, enter a name for the quote, and complete 
the fields.

Siebel Sales automatically enters the same information into the quote if, for 
example, an account is associated with the opportunity. Choose the account and 
price list for the quote if this information is not automatically entered.

The following table describes some of the fields.

Field Comments

Active A check box indicating whether the quote is active. When you 
create a quote, it is automatically marked as active.

The quote must be designated as active before it can be updated or 
files can be attached to it.

Created The date the quote was created. Siebel Sales automatically sets the 
value for an active quote to the Effective As Of (Start Date) + 30 
days. 

Currency Defaults to the currency associated with the price list.
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4 Click the show more button if you want to apply a discount to the line items you 
add to the quote.

The discount you enter in this field is used instead of any pricing rules 
associated with a price list. For more information, see Siebel Order Management 
Guide.

Effective As Of Defaults to the created date. You can change this date, if necessary.

Effective 
Through

Defaults to the effective date plus 30 days. You can change this date 
if the quote is effective for a different length of time.

Name Defaults to the unique number assigned to the quote at creation. If 
you do not enter a name for the quote, the quote number is 
automatically assigned as the name.

Quote # This unique system-generated number is assigned to the quote at 
creation.

Revision The number of revisions associated with the quote. At quote 
creation, this value = 1.

Status The default status is In Progress. You can change the status as the 
quote advances. Examples of status are Approved, Rejected, 
Expired, Order Placed, and Active.

Field Comments
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Using Auto Quote to Create a Quote
If you are working with an opportunity for which the products and solutions have 
already been specified, you can use the Auto Quote button to generate a quote.

Products are designated as available for use in an AutoQuote by selecting the 
AutoQuote check box for the product in the Opportunity screen’s Products view.

To use Auto Quote

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity associated with the quote, and 
then click the Quotes view tab.

3 In the Quotes list, click Auto Quote.

4 In the new quote record, enter a name for the quote in the Name field, and then 
select the appropriate price list in the Price List field.

5 In the Status field, choose a valid status.

6 (Optional.) Drill down on the quote name to display the Quote Line Items view, 
where you can add line items to the quote.

You can update opportunities with information from a quote. For more 
information, see “Updating an Opportunity with Quote Information” on 
page 205.
Version 7.5, Rev. A Siebel Sales User Guide 183



Quotes

Adding a Line Item to a Quote
Adding a Line Item to a Quote
Drilling down on the quote name in the Quote screen’s Quote list allows you to add 
line items and additional quote details and information.

For each line item in a quote, the Line Item Detail form allows you to view and 
modify data. Using Line Item Details, you can apply a manual discount to a line 
item. After you have priced all line items in a quote, you can view the total of all 
discounts applied to each line item by clicking the Totals subview tab.

Products associated with quotes in the Opportunity screen’s Products view appear 
automatically as line items with any applicable discounts if you use Auto Quote to 
create the quote. For more information, see “Using Auto Quote to Create a Quote” 
on page 183.

NOTE: You cannot query for packaged products in Quotes screen’s Line Items view. 

in addition to using the Line Items view to add individual item records, line items 
can be added to a quote using the following methods:

■ Browsing the product catalog. For more information, see “Using Browse Catalog 
to Add Quote Line Items” on page 187.

■ Using the Add Items button. For more information, see “Using Add Items to Add 
Multiple Line Items to the Quote” on page 187.

■ Entering the product name. For more information, see “Adding Products One at a 
Time to Quote Line Items” on page 188.

■ Using product group templates. For more information, see “Using Templates to 
Add Line Items to Quotes” on page 188.

■ Using line item packages. Adding Line Item Packages. For more information, see 
“Adding a Package of Line Items to a Quote” on page 189.

To add a line item

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the quote.

2 Click the Quotes view tab, and in the Quotes list, select the quote.
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3 In the quote record, drill down on the hyperlink in the Name field.

The Line Items list and the Totals subview appear.

4 In the Line Items list, add a new record.
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5 In the new line item, click the select button in the Product field and choose a 
product from the Pick Product dialog box.

6 Complete the fields for the line item record.

The following table describes some of the fields.

NOTE: To enter more than one line item, repeat Step 4 through Step 6 for each item. 

Field Comments

Attributes A text description or abstract of the product offering.

Extended Net Price If the quantity reflects a number of products for the line 
item, then the extended net price reflects the total for the 
number of products listed.

Extended Qty Displays a default value of 1. Reflects the actual number of 
units contained in the component product, packages, or 
bundle that is ordered. This field differs from the Qty field 
for hierarchical products.

Item Net Price The price for an individual item. When you are referencing 
component products or packages, the Item Net price is the 
net price of the top level only and does not include the 
rollup.

Part # A unique number assigned to the product you selected.

Qty Displays a default value of 1. You can edit this field to 
reflect the number of products associated with the line 
item. Reflects the actual number of units of a component 
product, package, or bundle that is ordered.

Start Price The undiscounted price for an individual item from the 
price list associated with the quote.

Unit Net Price Net price of the item and the rollup of the unit net price of 
its immediate children. The net price and unit net price for 
simple products are the same.
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Using Browse Catalog to Add Quote Line Items
The Browse Catalog feature, which uses the Product catalog, provides another way 
to add line items to a quote. In the Product catalog you can add additional products 
or services to the customer’s existing quote. After adding products and services, 
click View Quotes to update the information.

NOTE: The Browse Catalog feature is only available to you if your company has 
purchased Siebel eCatalog. For more information, see Siebel eSales Administration 
Guide.

You can also add line items manually without using the Browse Catalog feature.

To use Browse Catalog to add line items

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity, and then click the Quotes view 
tab.

3 In the Quotes list, select the quote, and then drill down on the hyperlink in the 
Name field.

4 In the Quote form, click Browse Catalog.

5 In the catalog’s Browse list, select each product to add by supplying the quantity 
and clicking Add to Cart.

6 After the products have been added, click View Details in the Catalog view to 
return to the Line Items list.

Using Add Items to Add Multiple Line Items to the Quote
Use the Add Items feature to add multiple line items to the quote, and specify the 
quantity and attributes for the items.

To add a product to a quote using Add Items

1 Navigate to the quote to which you want to add items.

2 Drill down on the quote name to display the Line Items list.

3 In the Line Items list, click Add Items.
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4 In the Pick Products dialog box, select the products to add to the quote.

a In the Order Qty field, enter the quantity for each product, and then click Add 
or press the tab key.

b To specify attributes for a product, click Attributes, complete the dialog box, 
and then click OK.

c When you are finished specifying product quantity and attributes, click OK.

For information on entering discounts or price adjustments, and manually repricing 
items, see Siebel Order Management Guide.

Adding Products One at a Time to Quote Line Items
If you know the product name, you can add products one at a time to the Line Items 
list.

To add items one at a time

1 Navigate to the quote, and then drill down on the quote name hyperlink to 
display the Line Items list.

2 In the Line Items list, add a new record.

3 In the new record, enter the product name in the Product field.

4 (Optional) Make any necessary changes to the quantity or attributes.

5 (Optional) Enter discounts and price adjustments. 

For more information, see Siebel Order Management Guide.

Using Templates to Add Line Items to Quotes
Product selection templates are groups of products and attributes that have been 
saved for reuse. Some product selection templates are public, and available to 
anyone using Siebel Sales. Other product selection templates are private, and are 
often created from an existing quote or order.

To add all the items in a template to the current quote

1 Navigate to the quote, and in the Quote header summary, click Select Template.
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2 In the Product Selection Template dialog box, select the template, and then click 
OK.

The items and associated attributes are copied into the quote or order.

3 Make any additional changes to the line items.

To add some of the items in a template to the current quote or order

1 Navigate to the quote, and in the Quote summary form, click Select Template.

2 In the Product Selection Template dialog box, drill down on the name of the 
template that includes the items you want to use.

The Product Template List appears, and the Product Template Item List shows 
all the products in the template.

3 Select the products you want to add to the current quote, and then click Add 
Selected Items.

For information on creating a product template, or making changes to a private 
product template, see Siebel Order Management Guide.

Adding a Package of Line Items to a Quote
In the Line Items list you can create a product bundle called a package. The package 
unit net price is the rolled up price of its bundled component products. If you 
discount the price of a component product or change the quantity of a component 
product, the price difference is automatically reflected in the unit net price and the 
extended price for the package. After you add a package to a quote, you can add 
individual product items to the package and renumber the items.

To add a package of line items 

1 Navigate to the Quotes screen.

2 In the Quotes list, locate the quote, and then drill down on the Name hyperlink.

3 In the Line Items list, add a new record, and in the new record, click the select 
button in the Product field.

4 In the Pick Product dialog box, type Package, and then select the package 
product.

5 In the Line Items list, complete the fields and save the record.
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To add a product to a package of line items

1 In the Line Items list, select the package item, and create a new record.

A new line item row appears.

2 In the line item row, add a product from the Product list to the package you 
created.

3 Follow the procedure for “To add a line item” on page 184.

4 (Optional) Modify quantities and discounts for products in the package.

5 Select the new product line item, and then click the Indent button.

The icon and number in the Sequence column change to reflect the addition of 
a product line item to the package.

The Outdent button removes products from packages.

To add more than one product to a package, repeat Step 1 through Step 5 for each 
item. 
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Repricing a Line Item in a Quote
Use the Reprice and Reprice All commands to update the prices and totals for your 
line items.

To reprice line items

1 In the Line Items list, click the menu button, and then choose Reprice to 
manually reprice a single line item. 

It is not necessary to routinely use Reprice and Reprice All after adding line 
items. For more information about repricing line items, see Siebel Order 
Management Guide.

In the Line Items list, click the menu button, and then choose Reprice All to reprice 
all line items.
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Renumbering Quote Line Items
After you have added all the line items for a quote, you can change the sequence of 
the items. Items appear in numbered sequence for orders and reports, and you may 
want to renumber them using a sequence that makes sense to your customer.

To renumber line items

1 Navigate to the Quotes screen.

2 In the Quotes list, locate the quote record, and in the Name field, drill down on 
the hyperlink.

3 In the Line Items list, navigate through the columns until you see the Line field.

4 In the Line field for each item, renumber as desired.

5 Click the up or down arrow on the Line field to sort the line numbers in 
ascending or descending order.

This action re-sorts the list based on the numbers you assigned in Step 4. 
Clicking the menu and choosing Renumber only generates sequential integer 
numbers so that your items now appear neatly sequenced. 

6 In the Line Item List, click the menu button, and then click Renumber.
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Deleting Line Items in a Quote
Use the following procedure to remove line items from your quote.

To delete line items

1 Navigate to the Quotes screen, and in the Quotes list, select the quote for which 
you want to delete the line item.

2 In the quote record, drill down on the hyperlink in the Name field.

3 In the Line Items List, select the line item, click the menu button, and then 
choose Delete Record. 

4 In the Quote form, click Update Opportunity.

The first time you delete a line item, the product is not deleted in the Opportunity 
view. A product is only deleted from the Opportunity products when the associated 
quote number is equal to the quote number of the quote from which you are 
updating. 

The first time you click Update Opportunity the quote numbers are not yet assigned 
to the Opportunity Product. When you click Update Opportunity the quote numbers 
are assigned, the opportunity product is identified, and the deleted quote is deleted 
in the opportunity. For more information, see “Updating an Opportunity with Quote 
Information” on page 205. 
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Adding a Write-In Product to the Price List for a Quote
When a product is not listed in the price list, and you need to add the information 
manually, you create a write-in product.

To add a write-in product

1 Navigate to the Quotes screen.

2 In the Quotes list, select the quote, and then drill down on the hyperlink in the 
Name field.

3 In the Line Items list, click the menu button, and then click New Record. 

a In the Product field, click the select button.

The Pick Product dialog box appears.

b In the Product field, type *Write* and then click Go.

c In the Pick Product dialog box, select Write-In Product and then click OK.

The Part # and Qty fields are automatically populated.

4 In the Line Items list, save the record.

5 Click the Line Item Detail view tab.

6 In the Line Item Detail form, complete the Disc Price field.

7 Select the Keep Discount check box, and then save the record.

The Keep Discount check box allows you to override pricing rules.
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Applying a Manual Discount to a Quote
You can apply a manual discount to an entire quote or to any line item in a quote. 
If you apply a manual discount (a percentage) to an entire quote, the discount 
percentage applies to each line item, and the result is reflected in the price for the 
entire quote. 

If you enter a manual discount for a line item and select the Keep Discount flag, the 
manual discount overrides the quote level discount for that line item. Manual price 
adjustments and automatic (system-applied) price adjustments function 
independently. The Keep Discount flag determines whether the line item or the 
automatic discount applies.

To prevent ePricer from automatically overwriting a manual discount the next time 
you click Reprice or Reprice All, make sure the Keep Discount check box is selected.

To apply a manual discount to an entire quote

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the quote.

2 Click the Quotes view tab, and in the Quotes list, drill down on the hyperlink in 
the Name field.

The Quote form appears, showing header data for the quote.

3 In the Discount field of the Quote form, select the discount (a percentage value) 
that you want to apply to the existing quote. 

The percentage discount is applied to each line item, and the Keep Discount 
check box is selected for each line item. Selecting the keep discount option 
prevents ePricer from further modifying the price after the manual discount has 
been applied.

To apply a manual discount to a line item in a quote

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity with which the quote is associated.

2 Click the Quotes view tab.

3 In the Quotes list, locate the quote, and then drill down on the hyperlink in the 
Name field.
Version 7.5, Rev. A Siebel Sales User Guide 195



Quotes

Applying a Manual Discount to a Quote
4 Click the Line Items view tab.

5 In the Line Items list, select the line item for the manual discount. 

Discount information for the selected line item appear in the Line Items Detail 
form.

Discount Amount indicates the amount of any applied discount resulting from 
ePricer (automatic/non-manual) adjustments. 

Percentage Discount indicates the percentage discount for the line item. 

The Keep Discount check box is not automatically selected. The check box is 
selected when discounts are applied using the Quote header.

NOTE: Manual discounts applied to the entire quote do not appear in the line 
item discount fields, but they are reflected in the net price field and the Net Disc 
% field for the line item.

6 In the Line Items Detail form, enter the discount or override price that you want 
to apply to the selected line item.

■ To enter a discount percentage, use the Disc % field. This overrides other 
discounts.

■ To enter a discount amount, use the Disc Amount field. This subtracts the 
dollar amount from the starting price.

■ To enter a new price that overrides any other discounts, enter the amount in 
the Disc Price field. Use this field whenever you want the discount to be the 
final price.

If you do not select the Keep Discount option, then your manual discount is 
replaced by any ePricer (automatic) discounts if you click Reprice or Reprice 
All.

The Discount percentage or the Discount Price you enter is applied to the line 
item. 
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Customizing a Product for a Quote
If your organization has purchased the Siebel Product Configurator, you can 
customize products when you add line items to a quote. Customizing might involve 
adding components to one or more products within the quote.

For example, if your customer is interested in a quote for a computer system, you 
can simply select a computer CPU, or you can customize the product by adding a 
monitor, a hard drive, and an operating system to create a complete product. You 
customize the selected product using configuration tools in your Siebel application. 
For more information, see Product Administration Guide.

To customize a product

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity associated with the quote, and 
then click the Quotes view tab.

3 In the Quotes list, drill down on the hyperlink in the Name field.

4 In the Line Items list, add a new record, and complete the fields in the line item 
form.

a In the Line Items list, click the select button in the Part # field.

b In the Pick Product dialog box, select the product, and then click OK.

5 Click Customize.

The Customize button is only available if the selected product is a customizable 
product.

6 In the Configurator window, verify that the item is configured correctly. 

■ If the product is configured correctly, click Done.

■ If the product is not configured correctly, make the necessary changes, click 
Save, and then click Done.

7 In the Line Items list, click Verify.

When you click Verify, the quote is verified as complete or incomplete. A 
message appears to confirm the status. If the quote is incomplete, the message 
indicates the missing information. You can add the missing information and 
finish the quote. 
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Creating Favorites for Quotes
Favorites are product configurations or packages that you have created and want to 
reuse at another time for other quotes. For instance, you notice that there are several 
common configurations for the PC computer system that you sell. Rather than 
create these manually for each quote, you can create one and save it, then reuse it 
the next time you need to produce a similar quote.

For information on the differences between a Favorite and a Delta Quote, see 
“Creating Delta Quotes” on page 200.

Saving a Favorite
After you have created a specific product package, you can save it as a favorite to 
use again in another quote.

To save a favorite

1 Navigate to the Quotes screen, and in the Quotes list, select the quote.

2 In the quote record, drill down on the hyperlink in the Name field.

3 In the Line Items list, click the menu button, and then choose Save as Favorite.

NOTE: This assumes that you have already entered line item information and you 
want to reuse the information.

4 In the Save as Favorites dialog box, enter a name.

The following figure shows the Save a Favorite dialog box, with fields for a name 
and the Save as a personal favorite check box. Clearing the check box allows all 
users to use this favorite.

5 In the Favorites dialog box, click Save.
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Using Favorites Manager
You can use Favorite Manager to access previously saved configurations or package 
bundles for use in a quote. 

To use Favorites Manager

1 Navigate to the Quotes screen, and in the Quotes list, select the quote.

2 In the quote record, drill down on the hyperlink in the Name field.

3 In the Line Items list, click the menu button, and then choose Favorite Manager.

4 In the Favorites dialog box, select the favorite, and then click Start from Favorite.

The favorite you selected appears in the Line Items list.

5 (Optional.) In the Line Items list, click Customize to change the product 
configuration.

6 To save this modification as a favorite, see “Saving a Favorite” on page 198.
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Creating Delta Quotes
When you create a quote, you can add to or make changes to the customizable 
products the customer has already purchased. Generally, these products, which are 
also called customizable assets, have attributes and features that can be modified. 
For instance, a company might purchase several hundred computers, which can 
have different specifications for drive capacity, memory, and peripherals that can be 
upgraded.

Favorites are new products being sold for the first time. Delta Quote products are 
items being sold as add-ons or replacement components for products you have 
already sold. In a Delta Quote, only new or changed items have a price. Unchanged 
items have no price associated with them. When you add a Favorite to a quote, all 
the items in the customizable product have a price.

Using the computer purchase example, after the customer has owned the computers 
for a while, you can provide the customer with a delta quote that lists additional 
memory or other available upgrades. First, you create a quote and select the 
customer’s customizable asset, which, in this case, is the computer model. Then, 
you configure the asset by adding or removing items and saving your changes. 

To create a delta quote 

1 Navigate to the Quotes screen, and in the Quotes list, select the quote to which 
a delta quote will be added.

2 Click the Line Items view tab.

3 In the Line Items list, click the menu button, and then choose Delta Quote.

4 In the Customizable Asset dialog box, locate the asset you want to add to the 
quote, and then click OK.

The Customizable Asset dialog box lists all customizable product assets for the 
account. 

5 In the Line Items list, highlight the customizable asset, and then click 
Customize.

This starts an eConfigurator configuration session. The configuration of the 
customizable asset displays in the session’s selection pages.
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6 Revise the configuration of the customizable asset by making selections and 
click Done to return to the Quote list.

The revised configuration displays in Quotes screen’s Line Items view.

Viewing Delta Status for a Quote Item
All the items in the revised asset receive a status when they are copied to the quote 
after a configuration session. The status tells you whether the item was changed 
during the configuration session. 

Table 7 describes the Delta Status values.

To view the delta status of an item in a delta quote

1 Navigate to the Quotes screen, and in the Quotes list, select the quote.

2 Click the Line Items view tab, and then select the line item for which you want 
to view status information.

3 Click the Line Item Detail subview tab, and then review the Delta Quote status 
in the Delta Status field.

You may need to click the show more button to see the field. 

Table 7. Delta Status Values

Delta Status Comments

Existing All items that were not changed. These items display no price.

Modified All items for which attribute settings have changed. All items with a 
status of Modified are priced as new items.

New All items that have been added or for which the quantity increased. If the 
quantity of an item increased, the original quantity is shown with a status 
of Existing. A second entry in the quote shows the increase, has a status 
of New, and displays a price.

Removed All items that were removed or decreased in quantity. If the quantity of 
an item is reduced, the new quantity appears with a status of Existing. A 
second entry in the quote shows the reduction and has a status of 
Removed.
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Revising a Quote
You revise a quote to keep it up-to-date with the most current products, price lists, 
discounts, and so on. During negotiations with a customer, you may revise quotes 
to add and delete items, making sure the quote addresses the customer’s budget.

The Revise feature allows you to edit or change the original quote. Revisions do not 
create a new quote, but instead add a revised quote to the list associated with the 
opportunity. When you revise a quote, the original quote becomes inactive and 
read-only.

To revise a quote

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity with which the quote is 
associated, and then click the Quotes view tab.

3 In the Quotes list, select the quote and then click Revise.

A new quote, with the same quote number, appears beneath the one you 
selected to revise.

4 Revise the information as needed, and then click Save.

The following figure shows the original quote record and the revised quote 
record in the Quotes list. You can verify the revision by looking in the Revision 
column.
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Using Siebel eAdvisor for Quote Solutions
You can use Siebel eAdvisor to help you find a solution to present to your customer. 
When you use eAdvisor, an interactive session starts, and a list of questions is 
presented to help you locate a solution or a product. For instance, if your customer 
has given you specifications for a car, eAdvisor might present the following 
questions.

■ What are the minimum number of passengers?

■ What are the storage needs?

■ What is the price range?

Based on your answers, eAdvisor presents a product or solution that you can add 
to a quote.

If a product, customizable or non-customizable, has attributes that you can choose, 
then you can make changes to the product. For instance, if a car has two attributes, 
color and coupe versus four-door, you can select these items. If the different options 
are priced differently, then the pricing changes are carried over into the line item.

To use eAdvisor to add line items

1 Navigate to the quote to which you want to add items.

2 In the Quote form, click Get Advice.

The Advisor List appears.

3 In the Advisor List, select an Advisor session, and then drill down on the session 
name.
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4 In the eBusiness Advisor wizard, answer the questions in the left panel, view 
recommendations in the right panel, and then click Next.

Figure 3 shows an example of an eAdvisor automotive application.

For more information on eAdvisor, see Siebel Interactive Designer Administration 
Guide.

Figure 3. eAdvisor Screen
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Updating an Opportunity with Quote Information
After you have added the appropriate line items and completed the quote, you need 
to update the opportunity with the quote information. It is important to keep your 
opportunity information in sync with your quote information to maintain accurate 
forecasts and charts. 

To update quote information to the opportunity

1 Navigate to the Quotes screen.

2 In the Quotes list, select the quote for which you want to update the opportunity, 
and then click Update Opportunity.

The new or modified products and prices appear in the opportunity.
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Creating Orders from Quotes
After you complete the initial quote and the customer agrees to the products and 
prices, you can create a sales order. For more information on sales orders, see Siebel 
Order Management Guide and Siebel Incentive Compensation Administration Guide.

To create an order from your quote

1 Navigate to the Quotes screen.

2 In the Quotes list, select the quote for which you want to generate an order.

3 Click the Orders view tab.

4 In the Orders list, click New.

The order inherits field values from the quote.

5 In the Type field, select Sales Order from the drop-down list.

6 In the Orders list, drill down on the Order # hyperlink.

The Orders line items view appears.

7 In the Line Items list, click New to add line items to the order.
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Adding Payment and Billing Information to a Quote
After completing the sales order, you enter payment and billing information. The 
customer may receive an order at an address that differs from the main address 
associated with either the account or the contact information. You can enter a 
billing different address for the order without changing the customer’s permanent 
address information.

To add billing, payment, tax and terms information

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity with which the quote is 
associated, and then click the Quotes view tab.

3 In the Quotes list, select the quote, and in the quote record, drill down on the 
hyperlink in the name field.

4 Click the Payments view tab.

5 In the Payments form, complete the necessary fields.

The billing address is automatically populated based on the account 
information.

For more information, see Siebel Order Management Guide.

To specify a different billing address

1 Complete Step 1 through Step 4 in the procedure,“To add billing, payment, tax 
and terms information.” 

2 In the Payments form, click the select button in the Bill To Address field.

3 In the Bill To Address dialog box, select a different address.

Click New to add an address.

To add shipping information

1 Complete Step 1 through Step 3 in the procedure, “To add billing, payment, tax 
and terms information.”
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2 Click the Fulfillment view tab.

The shipping address is automatically populated based on the account 
information.

3 Click the select button in the Ship to Address field.

4 In the Ship To Address dialog box, select an address.

Click New to add an address.

For more information, see Siebel Order Management Guide.
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This chapter describes how to create, modify and print proposals for an opportunity, 
using the Opportunity screen’s Proposals view.
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Business Scenario for Proposals
This scenario provides an example of the business process performed by a sales 
representative creating proposals for accounts. Your company may follow a different 
process according to its business requirements.

A software company receives a Request for Proposal (RFP) from a prospect 
interested in outsourcing part of the information technology department. The sales 
representative assigned to the RFT selects the opportunity in Siebel Sales, and then 
creates a new proposal record based on the organization’s standard template for 
proposals. 

The sales representative composes a draft of a proposal that meets the requirements 
of the RFP, adding sections such as a cover letter, executive summary, the proposal 
body, and sections that outline the company’s experience, and references. After 
conferring with sales team members, the sales representative modifies the proposal, 
changing the order of some of the sections, and adding other sections from the 
Proposal Library.
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Generating Sales Proposals
A proposal is an offer to sell products or services with specific terms and conditions. 
A proposal can be long or short, simple or complex. Even a simple proposal consists 
of several sections such as a cover letter, an executive summary, and a price 
quotation.

A proposal takes the details you have recorded about an account or opportunity and 
combines them with a predefined template to create a document tailored to the 
customer’s needs. The template defines the initial formatting and structure of your 
proposal and can include predefined components, such as text, tables, and 
diagrams. It can also be set up to include files from the Proposal Library, such as 
product descriptions and standard terms and conditions. After generating a 
proposal, you can modify it to meet your customer’s requirements.

When creating procedures, use the following process:

1 Create a proposal (required). 

2 Generate a proposal draft (required)

3 Modify the proposal (optional)

4 Print the proposal draft (optional)

5 Lock the proposal (optional)
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Creating a Proposal
Before you can generate a draft of the proposal, you must create a proposal and 
associate the proposal with an opportunity or account. The following procedure 
explains how to create a proposal using the Opportunities screen. You can perform 
a similar procedure using the Accounts screen.

To create a proposal

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity associated with the proposal, 
and then click the Proposals view tab.

3 In the Proposals list, click Auto Proposal.

Auto Proposal automatically generates a proposal based on a default template or 
Decision Issue associated with the opportunity. The following figure shows the 
new proposal record in the Proposals list, with the template name, created date 
and updated date fields completed.

NOTE: To generate a proposal based on a different template, in the proposal record 
select a different template from the template drop-down list.
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Generating a Proposal Draft
After you create a proposal, you can generate a proposal draft. The draft is a 
standard word processing document that you can edit if Microsoft Word is installed 
on your computer.

If you are creating a proposal in a Siebel Web Client environment (network 
connection), follow Step 1 through Step 5.

If you are creating a proposal in a Mobile Web Client environment (remote) and 
have the Mobile Web Client installed locally on your computer, follow Step 1 
through Step 4.

To generate a proposal draft

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity associated with the proposal.

3 Click the Proposals view tab.

4 In the Proposals list, select the proposal and click Generate Draft.

In Queue appears in the Status field. 

A draft of the proposal is created if you are in Mobile Web Client environment 
(remote).

5 Click Update to generate a proposal from the server if you are working in a Siebel 
Web Client network environment.

The status of the proposal refreshes when you click Update. Status values 
include In Progress, Generating, Completed, and Failed.
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Modifying and Adding Content to a Proposal
After you create and view a draft of a proposal, you may decide to change the order 
of its sections, or add new sections.

The following procedures describe how to view, modify and add content to the 
proposal:

■ Viewing the Structure of a Proposal

■ Adding Content to the Proposal on page 215

■ Changing the Order of Sections in a Proposal on page 216

■ Adding a Component to a Proposal on page 217

■ Modifying a Proposal Component on page 219

Viewing the Structure of a Proposal
You can view the structure of a proposal in the Proposal Table of Contents view, 
which lets you see the hierarchy of sections and components that make up your 
proposal when it is generated. 

Sections are the headings that appear in your proposal. Sections can contain 
subsections and components. Components consist of the actual written information 
that appears in your proposal. A component can contain multiple files. 

To view the structure of a proposal

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the proposal.

2 Click the Proposals view tab, and in the Proposals list, select the proposal.
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3 In the proposal record, drill down on the hyperlink in the Name field.

The Proposal Table of Contents appears, showing the structure of the proposal. 

Click the plus sign (+) next to each section to expand sections and components.

The following figure shows an example of the Proposals Table of Contents, with 
the explorer pane on the left showing the sections and components of the 
proposal, and the Sections pane on the right showing a list of sections.

Adding Content to the Proposal
If an administrator has created optional sections in the Proposals Library, you can 
customize the proposal by adding one or more of these sections. The Edit Layout 
command allows you to add content to your proposal using the Proposal Library.

To add content from the Proposal Library

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the proposal.

2 Click the Proposals view tab, and in the Proposals list, select the proposal and 
click Edit Layout.

The Template Layout dialog box appears. To display more items in the Content 
Library list, clear the Show Recommended Only check box. 

3 In the Template Layout dialog box, move items from the Content Library pane 
to the Table of Contents pane, and then click Save.

4 In the Proposals list, drill down on the proposal name to open the Proposal Table 
of Contents view to see the new content.
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Changing the Order of Sections in a Proposal
When you add a section to a proposal, the sequence numbers are not automatically 
regenerated. if you insert a section within the current sequence, you must modify 
each sequence number. The sequence numbers in the Proposals list determine the 
order in which sections and components appear. There are two methods that you 
can use to resequence proposal sections and components:

■ Edit Layout

■ Proposal Table of Contents

To use Edit Layout

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the proposal.

2 Click the Proposals view tab, and in the Proposals list, select the proposal and 
click Edit Layout.

3 In the Template Layout dialog box, use the sequencing arrows to change the 
order of the sections.

To use Proposal Table of Contents

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the proposal.

2 Click the Proposals view tab, and in the Proposals list, select the proposal.

3 In the proposal record, drill down on the hyperlink in the Name field.

4 In the Proposal Table of Contents explorer, click the plus sign (+) to expand 
each section.

5 In the Sections list, change the number in the Sequence field for each selected 
section.

To remove sections in a proposal

1 Navigate to Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the proposal.

2 Click the Proposals view tab, select the proposal, and in the proposal record, drill 
down on the hyperlink in the Name field.
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3 In the Proposal Table of Contents explorer, click the plus sign (+) to expand 
each section.

4 In the Sections list, select the section, right click with the mouse, and choose 
Delete Record.

NOTE: You can also use the Edit Layout command to remove content from a 
proposal. For more information, see “To use Edit Layout” on page 216.

Adding a Component to a Proposal
Section components are the boilerplate text that make up your proposal. To add 
components, components must already be associated with the section. You can add 
components to sections from the Proposals Library, from the Siebel Encyclopedia, 
or from another location, such as your local hard drive. You can add more than one 
component to a section.

The Proposal Library offers a hierarchy structure that administrators can use when 
designing literature components that can be associated with a proposal. Using the 
Proposal Library, you can navigate to a section or subsection, and then select the 
component file associated with the section. If the component is relevant to your 
proposal, click Add Components.

To add a component to a proposal

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the proposal.

2 Click the Proposals view tab, and in the Proposals list, select the proposal and 
then drill down on the hyperlink in the Name field.

3 In the Proposals Table of Contents explorer, click the plus sign (+) next to show 
the hierarchy of the proposal you want to change.

The Sections folder appears.

4 Click the plus sign (+) to expand the Sections folder.

Each section associated with the proposal appears in the Sections list. 
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5 Click the plus sign (+) to expand the section that will contain the new 
component.

6 In the Sections list, click Library.

The Proposals Library view appears.

7 In the Proposals Library Explorer, click the plus sign (+) for Proposals Library. 

a Click the plus sign (+) next to the Sections folder.

b Click the plus sign (+) next to the section where the proposal is located.

The list of components for that section appears. 

8 In the Components list, click the plus sign (+) next to the Components folder, 
select the component in the list, and then click Add Components.

The component file is added to the Components folder located in the section you 
selected.

To add a Siebel Encyclopedia component

1 Navigate to the Opportunities screen, select the opportunity associated with the 
proposal, and then click the Proposals view tab.

2 In the Proposals list, select the proposal, and then drill down on the hyperlink 
in the Name field.

3 In the Proposal Table of Contents explorer, click the plus sign (+)to expand the 
proposal contents.

a Click the plus sign (+) next to the Sections folder to expand the folder.

b Click the plus sign (+) next to the section where you want to add a new file 
from the Encyclopedia.

c Click the plus sign (+) next to the Components folder.

4 In the Components list, click the menu button, and then choose New Record.

The Add Sales Tools dialog box appears.
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5 In the Add Sales Tools dialog box, select each record you want to add, and then 
click Add.

NOTE: Only .doc and .txt files can be added as components directly into a 
template section.

To add a component from another location

1 Navigate to Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the proposal.

2 Click the Proposals view tab, and in the Proposals list, select the proposal.

3 In the proposal record, drill down on the hyperlink in the Name field. 

4 In the Proposal Table of Contents explorer, click the plus sign (+) next to the 
proposal to expand the proposal.

a Click the plus sign (+) next to the Sections folder.

b Click the plus sign (+) next to the section where you want to add a new file.

c Click the plus sign (+) next to the Components folder.

5 In the Components list, click the menu button, and then choose New Record.

6 In the Add Sales Tools dialog box, click New. 

7 In the Components form, enter a name and sequence for the file, and then click 
the select button in the File Name field.

8 In the Add Attachment dialog box, click Browse, navigate to the file, and click 
Open.

9 In the Add Attachment dialog box, click Add, and in the Components form, click 
Save.

Modifying a Proposal Component
You can modify a component file if you have Microsoft Word for Proposals installed 
locally on your computer. You must have the same application that was used to 
create the component. 
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To modify a component

1 Navigate to Opportunities screen, select the opportunity associated with the 
proposal, and then click the Proposals view tab.

2 In the Proposals list, select the proposal record, and then drill down on the 
hyperlink in the Name field. 

3 In the Proposal Table of Contents explorer, click the plus sign (+) next to the 
proposal. 

a Click the plus sign (+) next to the Sections folder. 

b Click the plus sign (+) next to the section where you want to add a new file 
from the Encyclopedia.

c Click the plus sign (+) next to the Components folder.

4 In the Components list, select the component, and then drill down on the File 
Name hyperlink.

5 In the file, make any necessary edits. 

6 When you are finished, save the file on your local drive. 

7 In the Components list, select the component (saved locally), click Edit, and 
then use the select button to browse your desktop for the modified component. 

8 Select the modified component and add it. 

The old component is replaced with the new one.
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Printing a Proposal
After you have generated a proposal, and the status is Completed, you can print the 
proposal to send to the prospective customer.

To print a proposal

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the proposal you want to print.

2 Click the Proposals view tab, and in the Proposals list, select the proposal and 
drill down on the hyperlink in the Draft Name field.

The proposal opens in Microsoft Word.

3 Print the proposal using Microsoft Word.
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Locking a Proposal
Lock allows you to secure the completed proposal, making the proposal read-only 
and unable to be edited. Only the proposal author, the author’s manager, and that 
manager’s manager, and so on, can modify or unlock the proposal.

To lock the proposal

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the proposal.

2 Click the Proposals view tab, and in the Proposals list, select the proposal.

3 In the proposal record, select the check box in the Locked field.

NOTE: Note: If the Locked check box does not appear, click the menu button in the 
Proposals list, and then choose Columns Displayed.
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This chapter describes how sales professionals can create, modify and print 
presentations for an opportunity, using the Opportunity screen’s Presentations 
view.
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Business Scenario for Presentations
This scenario provides an example of the business process performed by a sales 
representative creating presentations for prospective accounts. Your company may 
follow a different process according to its business requirements.

A sales representative is asked by a prospective customer to deliver a presentation 
on service offerings. The sales representative has already recorded the opportunity 
and its related details in Siebel Sales, including the number one decision issue—
price.

The sales representative navigates to the Opportunities screen’s Presentations view 
and creates a new presentation record. Because price is the most important decision 
issue, the presentation is based on a template that includes slides that address price 
issues. 

When the sales representative generates a draft of the presentation, the presentation 
is formatted according to standards established by the sales representative’s 
company, and includes the relevant slides. The sales representative makes some 
minor adjustments to the presentation, and saves it.
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Generating Presentations
Presentations automatically take details you have recorded about an account or 
opportunity and combine them with a predefined template to create a Microsoft 
PowerPoint presentation.

The administrator at your company creates presentation templates that include 
consistently formatted components, such as text, tables, and diagrams, that are 
designed to address specific issues. When you generate a presentation, you merge 
details about a specific account or opportunity in these predefined templates. 

After generating a presentation, you can modify it to meet your customer’s 
requirements by changing the order of slides and adding slides from the 
Presentation Library. If the presentation generated by a template is adequate, you 
can create and print a presentation by following the following process.

1 Create a presentation

2 Generate a presentation draft

3 Print the presentation draft
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Creating a Presentation
Because presentations can include details about an account or an opportunity, you 
can create presentations from either the Accounts screen or the Opportunities 
screen.

To create a presentation

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the presentation.

2 Click the Presentations view tab, and in the Presentations list, click Auto 
Presentation.

A presentation is automatically generated based on the default template. The 
new presentation record appears in the Presentations list.

NOTE: To generate a presentation using an alternate template, click New in the 
Presentation list and complete the necessary fields in the form.
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Generating a Presentation Draft
You can generate a presentation draft as a starting point for creating the 
presentation you deliver to a customer. The draft is a Microsoft PowerPoint 
presentation.

If you have Microsoft PowerPoint installed on your local computer, you can edit this 
presentation. If you do not have Microsoft PowerPoint installed, you can view the 
presentation, and you can add sections and change the order of sections, but you 
cannot edit slides.

If you are creating a presentation in a Siebel Web Client environment (network), 
follow Step 1 through Step 5 in the procedure.

If you are creating a presentation in a Mobile Web Client environment (remote) and 
have the Mobile Web Client installed locally on your computer, follow Step 1 
through Step 4 in the procedure.

To generate a presentation draft

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity associated with the presentation.

3 Click the Presentations view tab.

4 In the Presentations list, select the presentation, and then click Generate Draft.

In Queue appears in the Status field. 

A draft of the presentation is created if you are using Siebel Mobile Client 
(remote environment).

5 Click Update to generate a presentation from the server if you are working in a 
Siebel Web Client (network) environment.

The status of the presentation refreshes when you click Update. Status values 
include In Progress, Generating, Completed, and Failed.
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Modifying Presentation Structure and Adding Content
After you create and view a draft of a presentation, you may decide that you want 
to change the order of its sections or add new sections.

The following procedures describe how to view, modify and add content to the 
presentation:

■ Viewing the Structure of a Presentation

■ Adding Content to the Presentation on page 229

■ Changing the Order of Sections in a Presentation on page 229

■ Adding Components to a Presentation on page 230

■ Modifying a Presentation Component on page 233

Viewing the Structure of a Presentation
You can view the structure of a presentation in the Presentation Table of Contents 
view, which allows you to see the hierarchy of sections and components that make 
up the presentation. 

Sections represent the main points of a presentation, and each section can consist 
of subsections and components. Components are the slides used in each section. In 
some cases, sections can also be set up to generate slides.

To view the structure of a presentation

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the presentation.

2 Click the Presentations view tab, and in the Presentations list, drill down on the 
hyperlink in the Name field.

The Presentation Table of Contents appears showing the structure of the 
presentation.

3 In the Presentation Table of Contents explorer, click the plus sign (+) next to 
each section to expand sections and components.
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Adding Content to the Presentation
If an administrator has created slides and included them in the Presentations 
Library, you can customize the presentation by adding one or more of these slides 
using the Edit Layout command.

To add content to the presentation

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the presentation.

2 Click the Presentations view tab, and in the Presentations list, select the 
presentation, and then click Edit Layout.

The Template Layout dialog box appears. To display more items in the Content 
Library list, clear the Show Recommended Only check box. 

3 In the Template Layout dialog box, move items from the Content Library pane 
to the Table of Contents pane, and then click Save.

4 In the Presentations list, select the presentation, and then in the presentation 
record, drill down on the hyperlink in the Name field to view the new content.

Changing the Order of Sections in a Presentation
When you add a section to a presentation, the section numbers are not 
automatically resequenced. If you insert a section within the current sequence, you 
must modify each sequence number. The sequence numbers in the Presentations 
list determine the order in which sections and components appear. 

There are two methods that you can use to resequence presentation sections and 
components:

■ Edit Layout

■ Presentation Table of Contents

To use Edit Layout

1 Navigate to Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the presentation.

2 Click the Presentations view tab, select the presentation in the Presentations list, 
and then click Edit Layout.

3 In the Template Layout dialog box, use the sequencing arrows to change the 
order of the sections, and then click Save.
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To use Presentation Table of Contents

1 Navigate to Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the presentation.

2 Click the Presentations view tab, and in the Presentations list, select the 
presentation.

3 In the presentation record, drill down on the hyperlink in the Name field.

4 In the Presentation Table of Contents explorer, click the plus sign (+) to expand 
each section.

5 In the Sections list, select a section, and then click Edit.

6 In the section form, change the number in the Sequence field, and then click 
Save.

To remove sections in a presentation

1 Navigate to Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the presentation.

2 Click the Presentations view tab, and in the Presentations list, select the 
presentation.

3 In the presentation record, drill down on the hyperlink in the Name field.

4 In the Presentation Table of Contents explorer, click the plus sign (+) to expand 
the sections.

5 In the Sections list, select the section, right click with the mouse, and then 
choose Delete Record.

NOTE: You can also use the Edit Layout command to remove content from a 
presentation. For more information, see “To use Edit Layout” on page 229.

Adding Components to a Presentation
Components are the slides that make up your presentation. You can add 
components to sections from the Presentation Library, the Siebel Encyclopedia, or 
from another location, such as your local hard drive. You can add more than one 
component to a section.
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The Presentation Library offers a hierarchical structure that administrators can use 
when designing literature components that can be associated with a presentation. 
Using the Presentation Library, you can navigate to a section or subsection and 
select the component file associated with the section. If the component is relevant 
to your presentation, click Add Components.

To add a component to a presentation

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the presentation.

2 Click the Presentations view tab, and in the Presentations list, select the 
presentation.

3 In the presentation record, drill down on the hyperlink in the Name field.

4 In the Presentations Table of Contents explorer, click the plus sign (+) next to 
the presentation you want to change. 

The Sections folder appears. 

5 Click the plus sign (+) next to the Sections folder.

Each section associated with the presentation appears in the Sections list. 

6 Click the plus sign (+) next to the section to which you want to add a 
component.

7 In the Sections list, click Library.

The Presentations Library view appears.

8 In the Presentations Library explorer, click the plus sign (+) for Presentations 
Library. 

a Click the plus sign (+) next to the Sections folder. 

b Click the plus sign (+) next to the section where the presentation is located. 

The list of components for that section appears. 
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9 In the Components list, click the plus sign (+) next to the Components folder, 
select the component in the list, and then click Add Components.

The component file is added to the Components folder located in the section you 
selected.

To add a Siebel Encyclopedia component

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the presentation.

2 Click the Presentations view tab, and in the Presentations list, select the 
presentation.

3 In the presentation record, drill down on the Presentation name hyperlink. 

4 In the Presentation Table of Contents explorer, click the plus sign (+) next to the 
presentation.

a Click the plus sign (+) next to the Sections folder. 

b Click the plus sign (+) next to the section where you want to add a new file 
from the Encyclopedia.

c Click the plus sign (+) next to the Components folder.

5 In the Components list, click the menu button, and then click New Record.

The Add Sales Tools dialog box appears.

6 In the Add Sales Tools dialog box, select each record you want to add and then 
click Add.

NOTE: Only .ppt files can be added as components directly into a template 
section.

To add a component from another location

1 Navigate to Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the presentation.

2 Click the Presentations view tab, and in the Presentations list, select the 
presentation.
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3 In the presentation record, drill down on the Presentation name hyperlink. 

4 In the Presentation Table of Contents explorer, click the plus sign (+) next to the 
Presentation.

a Click the plus sign (+) next to the Sections folder. 

b Click the plus sign (+) next to the next to the section where you want to add 
a new file.

c Click the plus sign (+) next to the Components folder.

5 In the Components list, click the menu button, and then choose New Record.

6 In the Add Sales Tools dialog box, click New.

7 In the Components entry form, enter a name and sequence for the file, and then 
click the select button in the File Name field.

8 In the Add Attachment dialog box, click Browse, navigate to the file, and then 
click Open.

9 In the Add Attachment dialog box, click Add, and then in the Components entry 
form, click Save.

Modifying a Presentation Component
You can modify a component file if you have Microsoft PowerPoint installed locally 
on your computer. You must have the application that was used to create the 
component. 

To modify a presentation component

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the presentation.

2 Click the Presentations view tab, and in the Presentations list, select the 
presentation.

3 In the presentation record, drill down on the Presentation name hyperlink. 

4 In the Presentation Table of Contents explorer, click the plus sign (+) next to the 
presentation. 

a Click the plus sign (+) next to the Sections folder. 
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b Click the plus sign (+) next to the section where you want to add a new file 
from the Encyclopedia.

c Click the plus sign (+) next to the Components folder.

5 In the Components list, drill down on the hyperlink in the File Name field.

6 In the file, make any necessary edits, and then save the file on your local drive.

7 In the Components list, select the component (saved locally), click Edit, and 
then use the select button to browse your computer desktop for the modified 
component.

8 Select the modified component, and then add it.

The old component is replaced with the new one.
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Printing a Presentation 
After you have generated a presentation, and the status is Completed, you can print 
the presentation. 

To print a presentation

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the presentation you want to print.

2 Click the Presentations view tab.

3 In the Presentations list, select the presentation, and then drill down on the 
hyperlink in the Draft Name field.

The presentation appears in the application in which it was created. 

4 From the application, print the presentation.
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Locking a Presentation
Lock allows you to secure the completed presentation, making the presentation 
read-only and unable to be edited. Only the presentation’s author, the author’s 
manager, that manager’s manager, and so on, can modify or unlock the 
presentation.

To lock the presentation

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity associated with the presentation.

2 Click the Presentations view tab, and in the Presentations list, select the 
presentation.

3 In the presentation record, select the check box in the Locked field.

NOTE: Note: If the Locked check box does not appear, click the menu button in the 
Proposals list, and then choose Columns Displayed.
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This chapter describes how sales professionals can use the References screen to 
access accounts that can be designated as references, and to associate contacts, 
activities, profiles, and notes with each reference.
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Business Scenario for References
This scenario provides an example of the business process performed by a sales 
representative using references to compete for new business. Your company may 
follow a different process according to its business requirements.

A sales representative is attempting to win a 2,500-seat software sales opportunity 
for his company. In a series of meetings with the prospect, the sales representative 
demonstrates his product line and submits a quote. The sales representative 
receives a call from the prospective customer requesting a chance to speak with 
existing software customers as a point of reference before agreeing to the terms of 
the quote.

The sales representative searches the list of references, and performs a query to find 
accounts that meet specific criteria. The accounts must be designated as 
referenceable, in the same industry as the prospective customer, and listed as 
maintenance in the sales stage.

The sales representative finds companies that meet the criteria. She selects a 
company for the reference, and telephones the primary representative to get 
permission to use the customer as a reference. The representative agrees and sets 
up a conference call to discuss the opportunity with the prospect. 
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Managing Accounts and References
The References screen provides you with customer reference information that you 
can use as a sales tool when managing sales, marketing, and public relations 
initiatives. As a sales team member, providing potential customers with a list of 
referenceable accounts adds immediate legitimacy to any sales situation and gives 
you a competitive advantage. You also can use the References screen to determine 
the best reference for a current initiative. 

You can use the References list to search for accounts that are referenceable. A 
calendar view of reference activities is also available.

The following procedures describe how to manage accounts references using the 
references screen:

■ Designating an Account as a Reference on page 240

■ Associating an Activity with a Reference on page 241

■ Associating a Contact with a Reference on page 242

■ Associating an Attachment with a Reference on page 243

■ Adding a Reference Activity to the Calendar on page 244

■ Adding a Note to a Reference on page 245

■ Adding Profile Information to a Reference on page 246

■ Searching for References on page 247

■ Viewing Reference Assets and Profiles Charts on page 248
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Designating an Account as a Reference 
You can mark an account as referenceable using the check box in the account 
record’s Reference field. During the reference process, you can set the reference 
stages.

To designate an account as a reference

1 Navigate to the Accounts Screen, and in the Accounts list, select the 
referenceable account.

2 In the Account details form, select the Reference check box, located next to the 
account name field.
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Associating an Activity with a Reference
In the Activities view, you can see each activity associated with an account. 
Activities associated with a reference appear in the Calendar view. See 
Fundamentals for more information on Calendar.

Figure 4 shows a sample References list. Reference record fields provide information 
on the primary representative, the corporate sponsor, and so on.

NOTE: Only these Activity Types appear in this view: Reference - Call, Reference - 
Testimonial, Reference - Visit .

To associate an activity with a reference

1 Navigate to the References screen.

2 In the References list, select the account associated with the activities, and then 
click the Activities view tab.

3 In the Activities list, add a new record, and complete the fields.

For more information, see Chapter 9, “Activities.”

Figure 4. References List
Version 7.5, Rev. A Siebel Sales User Guide 241



References

Associating a Contact with a Reference
Associating a Contact with a Reference
You can designate a specific contact within a referenceable account. This contact 
can provide you with reference information or the individual can be the point-of-
contact for activities associated with the account.

To associate a contact with a reference

1 Navigate to the References screen.

2 In the References list, select the Reference associated with the contact, and then 
click the Contacts view tab.

3 In the Contacts list, perform one of the following steps.

a Click Add to open the Add Contacts dialog box, and then select the contact 
from the list.

b Click New to add a new row to the Contacts list, and then complete the 
necessary fields for the contact.
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Associating an Attachment with a Reference
The Attachments view lists attachments associated with a reference account. You 
can add new attachments or view attachments associated with the account. 
Reference Attachments include account attachments as well as reference 
attachments.

To associate an attachment with a reference

1 Navigate to the References screen.

2 In the References list, select the account to add an attachment, and then click 
the Attachments view tab.

3 In the Attachments list, add a new record.

4 In the Attachment Name field, click the select button, and in the Add 
Attachment dialog box, click Browse.

5 In the Choose File dialog box, select the file, and then click Open.

6 In the Add Attachment dialog box, click Add.
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Adding a Reference Activity to the Calendar
The Calendar view details all reference activities associated with the account. In the 
calendar, you can view, by month, the number of reference activities associated 
with the account. This view allows you to manage the number of initiatives for the 
account and determine if the customer is being contacted too often.

To add a calendar item for a reference

1 Navigate to the References screen, and in the References list, select the account 
associated with the appointment.

2 Click the Calendar view tab.

The reference form appears with the calendar. 

3 In the Calendar view, click New.

4 In the Calendar Detail form, complete the necessary fields, and then click Save 
This One. 

NOTE: Only these Activity Types appear in the Reference Calendar: Reference - 
Call, Reference - Testimonial, Reference - Visit .
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Adding a Note to a Reference
The Reference screen’s Notes view allows you to add notes to the selected reference 
account. Notes can be shared with others, and notes can be designated as private. 
Reference notes are visible in both the Account screen and the Reference screen. If 
you create a note in either the Accounts screen or the Reference screen, it is 
accessible in both views.

To add a note to a reference

1 Navigate to the References screen.

2 In the References list, select the account associated with the note, and then click 
the Notes view tab.

3 In the Notes view, select Private Notes or Shared Notes from the Show drop-
down list.

4 In the Notes list, add a new record and complete the fields.
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Adding Profile Information to a Reference
The Profile view allows you to update the account with information about the assets 
owned by the account, and information about the service profile. The service profile 
is a list of all external products the account is using in its operating environment. 
For instance, if your company sells application software, you might add information 
about the server hardware and end-user operating system used in conjunction with 
your products.

To add profile information to a reference

1 Navigate to the References screen.

2 In the References list, select the account, and then click the Profile view tab.

The Profile list and the Service Profile subviews appear.

3 In the Profile list, add a new record and complete the fields.

4 In the Service Profile list, add a new record and complete the fields.
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Searching for References
Use the All References Read Only and All References Across Organizations Read 
Only lists to search for references applicable to your accounts. These views are read-
only; you cannot modify information, and a contacts list is not available. To use the 
reference contact information, contact the reference owner, whose User ID appears 
in the Primary Rep field.

To search for references

1 Navigate to the References screen.

2 From the Show drop-down list, choose All References Read Only.

As an alternative, select All References Across Organizations Read Only.

3 In the References list, click Query, enter criteria in the query form, and then click 
Go.

4 In the reference record, drill down on the name hyperlink in the Primary Rep 
field to view reference owner information.
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Viewing Reference Assets and Profiles Charts
Reference charts provide a graphical analysis of referenced account assets and 
profiles. The Asset Analysis chart provides a graphical view of the assets, and the 
Profile Analysis chart provides a graphical representation of the profile information 
associated with all reference accounts. Both charts are read-only.

To view Assets and Profile Analysis charts

1 Navigate to the References screen.

2 From the Show drop-down list, choose Asset Analysis or Profile Analysis.

The Reference Assets or Reference Profile list appears with the analysis chart.

3 In the chart, select the type (3D, 2D) from the drop-down list, and then click Go.

The following figure shows a sample 3D Pie Profile Analysis chart.
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This chapter describes how a sales professional can use Siebel Enterprise Selling 
Process (ESP) methodology from Siebel MultiChannel Services to penetrate, cover, 
and grow large strategic accounts—especially global accounts. Enterprise Selling 
Process is a separately licensed module that integrates with the Siebel Sales 
application.

The ESP module helps sales professionals identify the customer's business drivers 
and initiatives, uncover opportunities in key business and service units, develop 
global account strategies, manage key executive and partner relationships, and 
coordinate team activities.

The ESP module is designed to support users who are already familiar with the ESP 
methodology, based on the learning programs offered by Siebel MultiChannel 
Services. Users should first complete an initial account analysis to select the units, 
opportunities, and partners, using the tools provided in the ESP workshop. After the 
analysis, the business units, opportunities, and partners are entered and tracked 
using the Siebel ESP module. 
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Using ESP Methodology to Manage Accounts
Siebel Enterprise Selling Process (ESP) software provides support for the Enterprise 
Selling Process methodology from Siebel MultiChannel Services. The software 
module allows account teams to better make use of the ESP account management 
methodology to penetrate, cover, and grow large strategic accounts— especially 
global accounts. Using the software, sales professionals can be more effective at 
identifying the customer's business drivers and initiatives, uncovering 
opportunities in key business and service units, developing global account 
strategies, managing key executive and partner relationships, and coordinating 
team activities.

The Siebel Enterprise Selling Process software module provides the following 
features:

■ Support for the Enterprise Selling Process methodology

■ An overview of Account Plan Highlights, such as the goal, the value proposition, 
and the critical success factors for driving business in the account

■ A set of objectives for driving business in the account and an action plan for 
achieving each objective

■ Analysis of the offerings that address each business and service unit's needs, 
along with the associated revenue from Installed Base, Current, and Potential 
Opportunities 

■ Automatic creation of an organization chart that visually shows an analysis of 
key players and their relationships

■ Automatic creation of ESP reports including the Account Map and Account Plan
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Business Scenario for Enterprise Selling Process
This scenario provides an example of the business process performed by a sales 
manager using the ESP methodology. Your company may follow a different process 
according to its business requirements.

An account manager has completed the ESP methodology workshop. At the end of 
the workshop, he develops a plan for his account. He plans to use the ESP software 
module to enter his account plan information to share with his team, and to track 
performance over the next several quarters against the plan.

The account manager begins by launching Siebel Sales and navigating to the 
Accounts screen. He selects the targeted account from the list of accounts, and then 
moves to the Enterprise Selling Process view to begin his account analysis. 

First, the account manager enters the account's business and service units and key 
information about each unit such as the unit's culture, his company's level of 
relationship with the unit, and the strategy he plans to apply to the unit. This 
provides his team with important sales information about each unit that sales team 
members plan to contact. 

Then, the account manager enters information about the potential, current, and 
installed base opportunities by offering for each unit. This information helps the 
team understand where they have coverage and penetration in each unit and with 
which offerings. After the account's units and opportunities are mapped, the 
account manager analyzes the organizational structure within the account. The 
account manager defines both the formal and informal organizational structures 
and determines who is important within the account and whom the team needs to 
spend more time with to close the identified opportunities. 

The account manager continues by analyzing the partners involved with this 
account so he can identify and use partnership capabilities within the key business 
and service units. The manager enters his value proposition, goal, critical success 
factors and objectives for the account based on his analysis. He then enters 
activities that are necessary to meet each objective, and assigns objectives to the 
appropriate team member. This allows the account manager to coordinate with his 
team in a goal-oriented fashion.

When the account manager is ready to share his Account Plan, he runs the report 
and emails it to his team and manager. His manager can also review the report 
online and enter his comments in the Manager's Review form. 
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Enterprise Selling Process Views and Procedures
The Enterprise Selling Process (ESP) module consists of eight views. Information 
provided in these views comprises the overall account plan. The ESP Account Plan 
and the ESP Account Map reports can be automatically generated from the ESP 
module.

The procedures associated with the following eight ESP views describe how to use 
the Enterprise Selling Process module.

1 BU/SU Overview. For more information, see “Adding ESP Business Unit and 
Service Unit Information” on page 253.

2 Offerings. For more information, see “Adding ESP Business and Service Unit 
Offerings” on page 255.

3 Organizational Analysis. For more information, see “Conducting an ESP 
Organizational Analysis” on page 258 and “Charting the Organization’s 
Reporting Structure” on page 261.

4 Partners. For more information, see “Adding Partners for ESP Analysis” on 
page 264.

5 BU/SU Offering Summary. For more information, see “Viewing the BU/SU Offering 
Summary” on page 266.

6 Objectives. For more information, see “Adding ESP Objectives” on page 267.

7 Account Plan Highlights. For more information, see “Adding ESP Account Plan 
Highlights” on page 269.

8 Manager’s Review. For more information, see “Viewing an ESP Manager’s 
Review” on page 270.

■ Reports. For more information, see “Generating ESP Account Plan and Account 
Map Reports” on page 271.
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Adding ESP Business Unit and Service Unit Information
The Business Unit and Service Unit (BU/SU) Overview helps you segment the 
account into more manageable business and service units. Each business or service 
unit in your account has different characteristics that affect your ability to sell into 
the unit. This view helps you profile each unit to determine these characteristics. It 
also helps you to make decisions about where to apply your resources and how to 
successfully integrate into the organization.

To add BU/SU overview information

1 Navigate to the Accounts screen, and in the Accounts list, select the account.

2 Click the Enterprise Selling Process view tab.

3 In the BU/SU Overview list, add a new record, enter a name for the business or 
service unit, and then complete the fields.

The following table describes the fields in the BU/SU Overview record. 

Field values are discussed during methodology training, and are available as part 
of the methodology documentation.

Field Comments

Culture A list of values that defines the culture (sales environment and sales 
approach) favored by the business or service unit. Examples are 
Entrepreneurial, Individualistic, Bureaucratic and Collaborative. 

Strategy Type A list of values that defines your strategy to penetrate, cover and 
grow the relationship with the business or service unit. The values 
are Create, Exit, Expand, Protect, and Pursue.

Initiatives A text field that allows you describe the initiatives on which you plan 
to focus for the business or service unit. Example are improve ROI 
by 10% and increase customer satisfaction.

Level of 
Relationship

Your company’s perception of its relationship with the business or 
service unit. Examples are Problem Solver, Trusted Advisor, and 
Credible Source.

Marketing Enter information in this text field about an existing marketing 
campaign or new marketing campaign that you want to apply or 
develop for this business or service unit.
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Repeat Step 3 for each Business or Service Unit in the account.

NOTE: If you are using ESP to analyze an account that has associated child accounts, 
the child accounts automatically appear in the BU/SU Overview list.
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Adding ESP Business and Service Unit Offerings
The Offerings view helps sales professionals to identify opportunities to sell their 
offerings (products and services) into key business or service units in the account. 
The sales professional can use this view to maintain a balance of current and future 
revenue in the account. It also helps to identify opportunities for greater account 
penetration. 

To add offerings

1 Navigate to the Accounts screen, and in the Accounts list, select the account.

2 Click the Enterprise Selling Process view tab.

3 In the ESP view, select BU/SU Overview from the Show drop-down menu.

Business and Service units appear in a list.

4 In the Business/Service Unit field, drill down on the hyperlink of the unit to 
which you want to add offerings. 

NOTE: The name of the unit you drilled down on appears in the Account form at 
the top of the screen. The account type for this unit should be ESP BSU. The 
Show drop-down list automatically shows the Offerings view. To add offerings, 
the Account Type must be ESP BSU.
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5 In the Offerings list, add a record and complete the fields.

The following table describes the fields in the Offerings record.

Field Comments

Potential 
Oppty Name

A Potential Opportunity has long-term revenue implications and ties 
to the customer's business initiative. The opportunity may or may 
not occur and may be classified as unqualified. Click the select 
button in this field to add existing opportunities, or to create new 
opportunities. 

Potential 
Oppty Revenue

The revenue classified as Potential that is associated with the 
opportunity.

Current Oppty 
Name

A Current Opportunity is in the sales cycle and has a significant 
associated revenue or market value. The opportunity can be the 
result of a new or installed business. Click the select button in this 
field to add existing opportunities, or to create new opportunities. 

Current Oppty 
Revenue

The revenue classified as Current that is associated with the 
opportunity.

Install Base 
Name

An Installed Base opportunity can be categorized in one or more of 
the following groups.

■ Servicing and maintaining

■ Upgrades, add-ons

■ Contract extensions

■ Non-competitive

Click the select button in this field to add existing opportunities or to 
create new opportunities. 

Install Base 
Revenue

The revenue classified as Install Base that is associated with the 
opportunity.
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NOTE: You can enter the revenue associated with potential opportunities without 
creating a new opportunity in the database. 

When you have finished identifying opportunities in the unit for your offerings, 
navigate back to the BU/SU Overview view, select a new unit, and repeat Step 4 and 
Step 5. 

Value to 
Customer

Choose a numeric value to indicate your assessment of how critical 
the initiative is to the enterprise's overall strategy.

Value to Us Choose a numeric value after evaluating the following factors.

■ Short-term revenue potential

■ Future revenue potential

■ Profitability

■ Degree of risk

■ Strategic value

Field Comments
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Using the Organizational Analysis view, sales professionals can map the structure 
and politics of the customer's organization to build and expand the relationship 
with the customer. After completing additional assessments to identify the most 
influential people and how to use these relationships, sales professionals can 
automatically create formal and informal organizational charts that visually 
summarize their contact analyses. 

To conduct an organizational analysis

1 Navigate to the Accounts screen, and select an account.

2 Click the Enterprise Selling Process view tab.

You can conduct an organizational analysis at the Account level or at the 
Business/Service Unit level. 

3 Perform the following steps to conduct an Account-level Organizational 
Analysis.

a In the BU/SU Overview list, select Organizational Analysis from the Show 
drop-down list.

The Organization Chart view appears, showing all contacts associated with 
the account.

b Proceed to Step 5 of this procedure.

4 Perform the following steps to conduct a Business/Service Unit Organizational 
Analysis.

a In the BU/SU Overview list, drill down on the name hyperlink of the unit for 
which you are conducting an organizational analysis.

The name of the unit appears in the Account form at the top of the screen. 
The Show menu automatically changes to the Offerings view.   

b From the Show drop-down list, choose Organizational Analysis.

The Organization Chart view appears, showing all contacts associated with 
the unit.
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c From the Show menu, choose Contacts (toggle).

All the contacts that have been created for this business or service unit 
appear.

d Proceed to Step 5 of this procedure.

NOTE: In the Organizational Analysis view, you can toggle between the 
Organization Chart view and the Contacts list view. Contacts previously 
associated with the account or unit automatically appear in both views. The 
contacts shown in the Contacts list appear in the Organization Chart view. 

5 In the Contacts list, add a new record and complete the fields to associate an 
existing contact with the account or unit. 

To create a new contact record, click New in the Add Contacts dialog box. 

NOTE: You can also create contacts by clicking New on the Organization Chart 
toggle view. If you create a new contact from the Organization Chart, an explicit 
Save is required to return to the Organization Chart view.

6 In the Contacts list, analyze each contact based on the criteria taught in the ESP 
methodology training program.

The criteria includes Role, Your Status, Level of Influence, Adaptability to 
Change, and Coverage.

The Level of Influence value for the contact determines the degree of shading 
that appears in the Contact node in the Organization Chart. The following table 
describes the shading associated with the Level of Influence value.

Value in Level of Influence Field Shading on Organization Chart

Low None

Political Structure (Medium) Light gray

Inner Circle (High) Dark gray
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7 In the Contacts list, use the drop-down list to toggle to the Organization Chart 
view. For more information, see “Charting the Organization’s Reporting 
Structure” on page 261.
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Charting the Organization’s Reporting Structure
The Organization Chart displays nodes (boxes) that contain information for each of 
the contacts you have analyzed and associated with the account or contact. Figure 5 
shows a contact node with associated information.

You can visually represent the formal hierarchy in the organization by creating the 
Organization Chart for the account or unit.

To represent a reporting structure

1 In the Organization Chart view, select the contact node and drag it beneath the 
node that represents the manager of the contact.

After you drop the contact node on the manager node, a line between the nodes 
appears, reflecting the reporting relationship. 

2 Repeat this process for each contact until you have completed the organization 
chart.

NOTE: The reporting relationships are also stored in the Contacts list (toggle 
view). Information about the manager of the contact appears in the fields 
Manager Last Name, and Manager First Name. To expose this information in the 
list, click the menu button, and then select Columns Displayed.

To delete contacts from the organization chart

1 In the Organization Chart view, select the contact node, right click, and choose 
Edit > Delete from the menu.

You can also delete a contact by selecting the contact node, and then pressing 
the DELETE key. 

Figure 5. Contact Node
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2 To confirm the deletion, click OK.

When you delete a contact, the contact is removed from the contacts list as well 
as the organization chart.

Using the Organization Chart to Draw Lines of Influence
You can also map the political structure in the account or unit organization by 
identifying informal lines of influence for contacts. This feature helps you identify 
contacts who are not highly ranked (and are easier to access) but who have 
significant influence on key decision makers. 

Lines of Influence information is automatically updated in the Relationships view 
of the Contacts screen. You can add lines of influence in the Relationships view if 
you prefer.

To draw a line of influence 

1 In the Organization Chart view, select the contact, and then simultaneously hold 
down the CTRL key on your keyboard. 

2 Select the contact node, and then drag and drop the contact node onto other 
contacts to draw the lines of influence.

The CTRL key must be depressed throughout this process for the informal line 
of influence to appear.

To delete lines of influence

■ Select the line, and then press the DELETE key. 

You can also select the line, right click the mouse, and then choose Edit > Delete 
from the menu.

Printing the Organization Chart
You can print the Organization chart for distribution to your sales team. 

NOTE: The Organization Chart does not print in the Account Plan Report or Account 
Map Report. You must print it from the Organization Chart view using the right-click 
menu.
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To print an organization chart

1 In the Organization Chart view, right-click your mouse.

2 From the menu, choose the Zoom level at which you want to print the chart. 
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The Partners view helps you to analyze and execute key partnership strategies while 
identifying and using partnership capabilities across the enterprise. This view also 
helps you develop initiatives used to engage key partners.

To add a partner

1 Navigate to the Accounts screen, and in the Accounts list, select the account.

2 Click the Enterprise Selling Process view tab, and from the Show drop-down list, 
select BU/SU Overview.

3 In the BU/SU list, drill down on the name hyperlink for the unit to which 
partners will be added.

The name of the unit appears in the Account form at the top of the screen. The 
Account Type must be ESP BSU to add partners to the unit. 

The Offerings list appears below the Account form.

4 From the Show drop-down list, choose Partners.

5 In the Partners view, click New, and from the Add Accounts dialog box, add the 
partner.

NOTE: Partners are stored as Accounts in the database. The Partner flag is 
checked in the Add Accounts dialog box.

6 In the Partners list, complete the comment and address fields for the partner.

7 Navigate back to the BU/SU Overview to add partners to another unit.

Select a new business or service unit, and repeat Step 5 and Step 6.

To add a contact

1 In the Partners list, select the partner, and then drill down on the hyperlink in 
the Name field. 

The Accounts screen, Contacts view appears.
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2 In the Contacts list, click Add to select an existing contact.

Click New to add and enter information on a new contact.

3 In the Add Contacts dialog box, select a contact, and then click OK.

NOTE: You can select multiple contacts by holding down the SHIFT key and selecting 
multiple contacts.

To add activities

1 In the Contacts list, drill down on the hyperlink in the Last Name field.

The Contacts detail form and Activities view appears.

2 In the Activities list, add a new record and complete the fields.

If you select Calendar and Activities in the Display In field, you must specify a 
Start date and time for the record to appear in the Calendar.

To delegate the activity, click the select button in the Owner field, and from the 
Pick Assigned To dialog box, select the owner of the activity. For more 
information, see Chapter 9, “Activities.”
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Viewing the BU/SU Offering Summary
The BU/SU Offering Summary is a read-only view that allows you to see all the 
offerings (and associated opportunities) you have added to each business and 
service unit in the account.

NOTE: Verify that the account name in the Account form does not show one of your 
units. You must select the main account for which you are conducting the ESP 
analysis to see all the offerings by unit.

To view BU/SU offerings

1 Navigate to the Accounts screen, and in the Accounts list, select the account.

2 Click the Enterprise Selling Process view tab.

The BU/SU Overview list appears.

3 In the BU/SU Overview list, choose BU/SU Offering Summary from the Show 
drop-down list.

The offerings associated with each unit in the account appear. You can also see 
the potential, current, and installed base opportunities for each offering 
associated with each unit. 
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The Objectives view helps the sales professional to develop an initial plan for the 
account. Sales professionals can create specific types of objectives (for example, 
Business Development, Revenue, and Cross-Account) for each unit or resource to 
improve strategic planning and account team coordination. 

The defined objectives link to an Action Plan form that sales professionals can use 
to develop action plans to achieve each objective they set. Moreover, the sales 
professional can verify that the action plan is implemented, because the activities 
assigned in the Action Plan form automatically appear in the assignee’s activities 
list.

To add objectives

1 Navigate to the Accounts screen, and in the Accounts list, select the account.

2 Click the Enterprise Selling Process view tab.

3 In the ESP view, select Objectives from the Show drop-down list.

4 In the Objectives list, add a new record, and complete the fields. 

The following table describes the fields.

Field Comments

Unit or Resource The Unit or Resource for which you are creating the objective. 
Units can be a business or service unit, opportunities, offerings, 
or groups of units. Examples of Resource names are Marketing, 
Customer Satisfaction, or Partners.

Objective Type The type of objective being defined. Choose from the three 
primary objective types, Cross Account, Revenue, and Business 
Development.

Objective The objective for the unit or resource.

Strategy A text entry field. Enter a statement that explains how the 
objective will be achieved.
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5 Drill down on the Unit or Resource hyperlink.

The Objective details form appears with the Action Plan list.

6 In the Action Plan list, add a new record, and then complete the fields.

The Actions you create in the Action Plan list appear in your Activities, Calendar, 
and To Do List, based on the Display In value you selected. To appear in the 
Calendar, the start date for the action must be entered.
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Adding ESP Account Plan Highlights
The Account Plan Highlights view allows the sales professional to enter the 
achievement goals for the account. The sales professional can communicate the 
strategic plans for the account to the sales team and to sales management, using the 
Account Goal, Value Proposition, and Critical Success Factor fields.

■ Goal. The account goal is a statement that describes the level of business you 
desire with the customer within the next few years. Express the goal, if possible, 
in terms of relationship and revenue.

■ Value Proposition. The value proposition is a statement that describes your value 
to the customer. The value proposition should be written from the perspective 
of the customer.

■ Critical Success Factor. Specific to the ESP Account Plan, critical success factors 
are the events or resources necessary to the success of your plan.

To add account plan highlights

1 Navigate to the Accounts screen, and in the Accounts list, select the account.

2 Click the Enterprise Selling Process view tab.

3 In the ESP view, select Account Plan Highlights from the Show drop-down list. 

The Overview form and the Critical Success Factors form appear.

4 In the Overview form, enter statements in the Goal and Value Proposition fields. 

5 In the Critical Success Factors form, enter a statement in the Critical Success 
Factors field.
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Viewing an ESP Manager’s Review
The sales manager uses the Manager's Review view to enter an assessment of the 
sales professional's ESP account plan. The manager can add comments in the 
Manager’s Review, which includes the date of each review. The sales representative 
and other nonmanagers have read-only access to this view. 

To view a manager’s review

1 Navigate to the Accounts screen, and in the Accounts list, select the account.

2 Click the Enterprise Selling Process view tab.

3 In the ESP view, select Manager’s Review from the Show drop-down list. 
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Generating ESP Account Plan and Account Map Reports
You can automatically generate an Account Plan report and an Account Map report 
for your selected account. The reports can be printed or emailed.

To create a report

1 Navigate to the Accounts screen, and in the Accounts list, select the account 
associated with the report.

2 Click the Enterprise Selling Process view tab.

3 From the application-level menu, choose View > Reports.

4 In the Reports dialog box, choose the Account Plan or Account Map report from 
the Select a Report list, and then select the language and locale for the report.

5 Run the report or schedule it to run at a specific time.

For more information on reports see Fundamentals and Siebel Reports 
Administration Guide.
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This chapter describes how the Target Account Selling (TAS) module integrates with 
Siebel Sales to help sales professionals win deals. The TAS module provides 
automated support and coaching to help sales professionals in the following ways:

■ Assess opportunities, relationships with key customer contacts, and their 
competitive position

■ Develop competitive and relationship strategies to win the deal

■ Execute the strategy and track progress against the action plan

The TAS opportunity management methodology is a separately licensed offering 
developed by Siebel MultiChannel Services. For information on TAS administrative 
tasks, see Applications Administration Guide.
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Using Target Account Selling to Manage Opportunities
The Target Account Selling module provides full support for the Target Account 
Selling (TAS) sales methodology from Siebel MultiChannel Services. Using the 
Target Account Selling methodology and the Target Account Selling module, sales 
professionals can assess opportunities, conduct organizational and competitive 
analysis, and develop and execute effective sales strategies.

The Siebel Target Account Selling software module provides the following features:

■ Full support for the Target Account Selling methodology

■ A TAS Coach to help sales professionals assess their opportunities, including 
Tips to reinforce key concepts in the TAS methodology

■ A TAS Coach that recommends what competitive strategy to take, and identifies 
the pros and cons of the recommended strategy

■ Automatic creation of the Organization Map that allows you to view both the 
formal hierarchy and lines of influence in the customer organization. This helps 
sales professionals develop relationship strategy

■ Support in identifying and ranking the decision criteria of each contact

■ Team planning to make sure that key Customer Milestones are addressed

■ Automatic creation of the TAS Opportunity Plan. The report can be configured 
to print selected sections

■ Automatic creation of the TAS Initial Plan

■ The TAS Opportunity Plan template that generates an editable Microsoft Word 
file (available to customers who have the separately licensed Proposal 
Generator)
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Business Scenario for Target Account Selling
This scenario provides an example of the business process performed by a sales 
manager using the Target Account Selling (TAS) methodology. Your company may 
follow a different process according to its business requirements.

A sales representative meets with a customer and discovers a new opportunity. The 
sales representative plans to use the Target Account Selling (TAS) methodology from 
Siebel MultiChannel Services (MCS) to develop a sales strategy for this new deal. 
TAS is supported by his Siebel Sales application, allowing the sales representative 
to analyze the opportunity and its multiple decision makers.

Opportunity Assessment
The sales representative selects the opportunity within Siebel Sales, and navigates 
to the Target Account Selling views to begin the process. He sees several views that 
he can use to profile and assess the opportunity, develop his value proposition and 
competitive strategy, and create a detailed action plan to achieve his goals. 

He begins by developing an overview of the opportunity. He enters some high-level 
information, including a profile of the account and the opportunity. This 
information provides strategic insight that his sales team can use and helps him to 
connect the project to the customer’s business drivers. The sales representative also 
enters details about his goal for the opportunity, the solution he is offering, and the 
business value this solution provides. He continues by entering a description of the 
compelling event that is causing the customer to act. This helps him to determine 
the customer’s sense of urgency to close the deal. He concludes by summarizing his 
high-level strengths and weaknesses for the deal.

Now that he has a general overview of the opportunity, he begins to assess his 
position using the TAS criteria that Siebel MCS has developed from analyzing the 
best practices of top sales professionals. He also rates the position of his key 
competitors using these criteria. He uses the TAS Coach on the Assessments screen 
to help him complete the assessment. The assessment helps him qualify the 
opportunity and understand his company’s position in the deal.
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Competitive and Relationship Strategy Development
Next, the sales representative begins to analyze his competitors for the opportunity 
and to determine what strategy he should use to win the deal. He uses the TAS 
Coach, available from the Competitive Analysis screen, for competitive strategy 
recommendations.

He continues by analyzing the prospect’s organization. He maps both the formal 
and informal structures so that he can be sure he is spending time with the right 
contacts. When he completes the analysis, he views the organizational chart that 
summarizes his assessment and identifies key players and relationships he can use 
to close the deal.

Now that he knows who to talk to, the sales representative begins to develop a 
relationship strategy. He enters the business and personal agenda, as well as key 
decision issues, for each contact. This preparation helps him to determine what 
message to deliver to each contact.

Strategy Execution
The sales representative is now prepared to develop his action plan to win the 
opportunity. First, he navigates to the Customer Milestones view to document key 
events or milestones in the customer’s buying process. This view helps him plan 
the activities that he and his sales team should take to address the customer’s 
requirements at each milestone. Then, he enters key action steps and resources 
needed and assigns the actions to members of his sales team. He can choose to have 
the activities appear in his calendar, activities, or to-do list, or in those of another 
assignee. He navigates to the PRIME Activities view where he can see all the 
activities he created to meet customer milestones, as well as add action items 
required to win the deal. He also makes some additional notes about the 
opportunity and makes the notes available for the entire team to view.

The sales representative’s manager requests a copy of the TAS Opportunity Plan. 
The sales representative configures the report to display relevant sections of the 
Opportunity Plan, generates the report, and then emails it to his manager. 
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Target Account Selling Views and Procedures
Siebel Target Account Selling (TAS) consists of eight views that automate the steps 
in the TAS methodology. The TAS Initial Plan report and the TAS Opportunity Plan 
report can be generated from the TAS module.

The TAS Opportunity Plan template is available with Siebel Proposal Generator (a 
separately licensed module), which automatically creates the Opportunity Plan 
using Microsoft Word.

The procedures associated with the following eight Target Account Selling views 
describe how to use the Target Account Selling module. 

For more information on reports, see “Creating TAS Opportunity Plan and Initial 
Plan Reports” on page 298.

1 Overview. For more information, see “Completing a TAS Overview” on page 278.

2 Assessment. For more information, see “Assessing an Opportunity” on page 280.

3 Competitive Analysis. For more information, see “Developing Strategy with TAS 
Competitive Analysis” on page 283.

4 Organizational Analysis. For more information, see “Conducting an Organizational 
Analysis” on page 286.

5 Customer Milestones. For more information, see “Adding Customer Milestones” 
on page 291.

6 Relationship Strategy. For more information, see “Developing a Relationship 
Strategy” on page 294.

7 PRIME Activities. For more information, see “Viewing PRIME Activities” on 
page 296.

8 Notes. For more information, see “Adding Notes” on page 297.
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Completing a TAS Overview
The Overview view provides a starting point that sales professionals can use to 
consolidate their observations about the account and opportunity and share 
strategic insights with their sales teams.

Using this view, sales professionals can profile their customers’ important business 
initiatives and requirements. In addition, sales professionals can summarize the 
strategic goal, value proposition, and overall position.

To complete a TAS overview

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity, and then click the Target 
Account Selling view tab.

3 From the Show drop-down list, choose Overview.

4 In the TAS Opportunity Overview form, complete the necessary fields. 

The following table describes the fields.

TIP: Position the pointer on the “i” information icon to see information on the 
view.

Field Comments

Customer’s Business Profile Describes the customer's business conditions. Identify 
the customer's major lines of business, affiliations, 
products, and markets. Include information about 
recent mergers and acquisitions.

Customer’s Revenue The customer's annual revenues or sales.

Profit The customer's annual profit.

Fiscal Year End The month and day in which the customer's 12-month 
accounting period ends.
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NOTE: If this is a new opportunity, you must create a new record and associate it 
with an account before you can enter text in the Customer’s Business Profile field. 
For more information, see Chapter 4, “Opportunities.”

Opportunity Profile Describes the customer's project or application. 
Identify the customer's business objectives for the 
project, the total cost and budget for the project, and 
how the project affects the customer's overall 
business.

Goal Describes your desired, long-term position with the 
customer. Identify how a closer relationship with you 
advances the attainment of their business goals. 
Include the long-term gain for your business such as 
future or strategic value.

Customer’s Compelling Event Describes what is driving the customer to make a 
decision or change the current situation. Identify the 
payback if the customer makes a change, or the 
consequences if they do not act. Note the specific date 
associated with the consequences or payback.

Our Solution Describes the solution you plan to offer to the 
customer. Address how the solution works in the 
customer's environment and how it meets their 
compelling event. Include any alliances or business 
partner solutions required to make it operational for 
the customer.

Critical Success Factors Identifies actions you, the competition, and your 
customer must do for you to win this opportunity.

Our Unique Business Value Describes your value proposition. Make sure it is 
specific to this customer, defines a measurable 
business result, and creates credibility by proving your 
ability to deliver. The value proposition should be 
confirmed with the customer, and differentiate you 
from your competitors.

Our Strengths Identifies business, organizational, and political issues 
that give your sales team an advantage in the deal.

Our Weaknesses Identifies business, organizational, and political issues 
that could put your sales team at risk in the deal.

Field Comments
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Sales professionals can use the Assessments view to evaluate the opportunity using 
criteria developed by Siebel MultiChannel Services. Assessments must be 
completed before determining the best strategy. An assessment focuses on the 
following four key questions:

1 Is there an opportunity?

2 Can we compete?

3 Can we win?

4 Is it worth winning?

Sales professionals assess their organization’s position and the position of their top 
competitors against these criteria. As the sales campaign progresses, sales 
professionals repeat this assessment and then compare the results to past 
assessments to evaluate and monitor their position at each sales stage.

The first few times an assessment is performed, use the TAS Coach to help evaluate 
and answer each set of assessment questions. After a number of assessments are 
performed and you are familiar with the criteria and methodology, use the 
Assessment form to rate the criteria.

To begin an assessment

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity.

2 Click the Target Account Selling view tab.

3 From the Show drop-down list, select Assessments. 

The Assessments list includes all the assessments you and your sales team have 
performed to date. Use the Assessments list to compare opportunity assessments 
for your company and your competitors.

4 In the Assessments form, click New.

5 In the new record, the Assessment For field defaults to Our Company for self 
assessments. If you are assessing a competitor’s position, click the select button 
and choose the competitor. 
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6 In the Assessment form, click TAS Coach, and then complete the assessment 
criteria questions. 

For more information, see “Using the TAS Coach” on page 281.

Using the TAS Coach
The Assessment TAS Coach, shown in Figure 6, uses Siebel SmartScripts technology 
to help sales professionals evaluate opportunities. The explorer pane expands to 
show the individual questions in each question set, and the form at right provides 
information on assessment considerations and rating selection.

To perform an assessment using TAS Coach

1 Assess the position of each of the criteria in the Assessments list by selecting a 
plus (+), a minus (-), or a question mark (?) from the drop-down list.

2 Click Next to advance to the next set of criteria questions.

■ Click Previous to return to criteria you have already assessed.

■ Click Cancel to return to the Assessments view without saving the 
assessment.

Figure 6. TAS Coach Screen
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■ If you want to pause in the middle of a TAS Coach assessment, and then 
return to the assessment at a later time, click Finish Later. The assessment 
does not appear in the Assessments list until it is completed. 

Your assessment is saved in the SmartScripts screen’s My Saved Session view. 
Use Site Map to navigate to the SmartScripts screen.

If you do not have enough information to answer the question, select the 
question mark (?).

3 When you have rated all criteria, click Finish to return to the Assessments list.

NOTE: You must click Finish to save the criteria ratings.
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Developing Strategy with TAS Competitive Analysis
The Competitive Analysis view helps sales professionals to develop competitive 
strategy. For each competitor, the sales team can evaluate strengths and weaknesses 
and anticipate the competitor’s strategy. The view also help the sales team to assess 
its own position against the competitor and to refine its strategy to win the deal. 

Use the TAS Coach to help you establish your sales strategy. TAS Coach provides 
recommendations based on the information you enter.

NOTE: If you use the TAS Coach to refine your strategy, enter information in the Our 
Competitive Strategy field. If you are analyzing a competitor’s strategy, enter the 
information in the Competitors list.

When you determine what your strategy will be, enter a summary in the Our 
Competitive Strategy text field in the Competitive Analysis view.

To add competitive analysis information

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity.

2 Click the Target Account Selling view tab.

3 From the Show drop-down list, select Competitive Analysis.

4 In the Competitors list, add a new record.

5 In the new record, click the select button in the Competitor field.

6 In the Pick Competitors dialog box, select the competitor to assess, and then 
click OK.

7 In the new Competitor record, complete the fields.

After you have analyzed your competitors, you determine the strategy you will 
take in the deal. Enter your strategy, based on what you think the competitor 
will do, in the Our Competitive Strategy field.
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Using the TAS Coach for Competitive Analysis
The TAS Coach can help you develop a competitive strategy after you have 
completed the TAS Assessment for your company and competitors. You can also 
answer TAS Coach questions from your competitors' perspective to help you 
anticipate the strategy that competitors are likely to take. You may need to refer to 
your assessment criteria ratings during a TAS Coach session, and may want to 
review or print the assessments before starting. See “Creating TAS Opportunity Plan 
and Initial Plan Reports” on page 298.

To use the TAS Coach for competitive analysis

1 Navigate to the Opportunities screen.

2 In the Opportunities list, select the opportunity, and then click the Target 
Account Selling view tab.

3 From the Show drop-down list, select Competitive Analysis.

4 In the Competitive Strategy form, click TAS Coach.

The TAS Coach screen appears, as shown in the following figure, detailing 
strategy types such as Fragment, Frontal, and Disengage, and includes a 
description of how to use the TAS coach.
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5 During the TAS Coach session, answer each question presented, and then click 
the Continue hyperlink to proceed to the next question.

During the session, an interim evaluation of each answer is provided, outlining 
the relevant issues that you must consider.

Click the Back hyperlink to return to a previous question.

At the conclusion of the session, TAS Coach recommends the type of strategy to 
take.

6 At the TAS Coach Recommends screen, drill down on the Click here for 
variations hyperlink for additional strategy options.

7 When you complete the TAS Coach session and review the TAS Coach 
recommendation, click the Siebel Back arrow to return to the Competitive 
Analysis view.

8 Enter the strategy you will take in the Our Competitive Strategy field.
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Conducting an Organizational Analysis 
Sales professionals can use the Organizational Analysis view to create formal and 
informal organizational charts that visually summarize their contact analyses.

The Organizational Analysis view toggles between a Contacts list and an 
Organization Map. Contacts previously associated with the opportunity 
automatically appear in both views. The contacts shown in the Contacts list appear 
in the Organization Map view. 

The toggle control list is shown in Figure 7. You can click New in either the Contacts 
list view or the Organization Map to create contact records. Position the pointer on 
the “i” icon to display information on the view.

Regardless of which view you use to create or select contacts, analyze each contact 
based on the criteria taught in the Target Account Selling methodology training 
program. This criteria includes Buying Role, Your Status, Level of Influence, 
Adaptability to Change, and Coverage.

The Level of Influence that you assign to each contact determines the degree of 
shading that appears in the contact node in the Organization Map. Table 8 explains 
the contact node shading for each value in the Level of Influence field.

Figure 7. Organizational Analysis View, Contacts List and Organization Map Toggle

Table 8. Level of Influence Shading for Contacts

Value in Level of Influence Field Shading on Organization Chart

Low None

Political Structure (Medium) Light gray

Inner Circle (High) Dark Gray
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You can also map the politics in the customer organization by identifying formal 
and informal lines of influence between contacts. Mapping informal lines of 
influence helps you identify contacts who may not be ranked highly (and are easier 
to access) but have significant influence on key decision makers. 

To begin an Organizational Analysis

1 Navigate to the Opportunities screen, and in the Opportunities list, select an 
opportunity.

2 Click the Target Account Selling view tab.

3 From the Show drop-down list, choose Organizational Analysis.

The Organization Map view appears.

To add a new contact in the Organization Map

1 In the Organization Map view, click New.

2 In the Add Contacts dialog box, click New.

3 In the Contact form, complete the fields, and then click Save.

The following figure shows the Organization Map contact form that includes 
assessment fields such as Adaptability to Change, Buying Role, and Coverage.

When you toggle to the Organization Map, this information appears in the 
contact node box, illustrated on the following page.

To add a contact in the Contacts list

1 From the toggle list, choose Contacts.
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2 In the Contacts list, click New.

3 In the Add Contacts dialog box, select the contact or contacts you want to add, 
and then click OK.

In the Add Contacts dialog box, click New to create a new contact.

4 Complete the fields to analyze the contact.

To create the Organization Map

1 In the view drop-down list toggle, select Organization Map.

The organizational chart displays the nodes (boxes) containing information for 
each of the contacts you have analyzed and associated with the opportunity. 

The following figure shows an example of a contact node (box) with the Level 
of Influence shading of dark gray. The node includes information about the 
contact, such as the contact’s title and other contact analysis information 
(Decision Maker, Mentor).

You can visually represent the formal hierarchy in the organization by creating 
the Organization Map of key contacts in the deal.

2 Select the contact node and drop it on top of the contact node that represents 
the contact’s manager.

When you drop the contact node on the manager node, a line appears between 
the nodes, reflecting the reporting relationship.
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3 Repeat this procedure for each contact until you have completed the 
organization chart.

NOTE: The reporting relationships are also stored in the Contacts list (toggle 
view). The Manager Last Name and Manager First Name fields in the contact 
record are automatically populated. To expose this information in the contacts 
list, click the menu button, and then choose Columns Displayed.

To delete contacts on the Organization Map

■ Right-click on the contact node and choose Edit > Delete from the menu.

NOTE: Contacts deleted from the organization map are no longer associated with the 
opportunity. However, the contact record still exists in your Contacts screen list.

To draw lines of influence

1 In the Organization Map, press the CTRL key and simultaneously select the 
contact. 

2 Drag and drop the selected contact node on other contacts to draw the lines of 
influence.

The CTRL key must be depressed throughout this process for the informal line 
of influence to appear. 

NOTE: This information is automatically updated in the Relationships view of the 
Contacts screen. You can indicate lines of influence in the Relationships view if 
you prefer.

To delete lines of influence on the Organization Map

■ Right-click on the line and choose Edit > Delete from the menu.

To print the Organization Map

1 Right-click on the Organization Map and select Zoom from the menu.

2 Choose the Zoom level at which you want to print the chart. 
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3 Right-click the Organization Map again and choose Print from the menu. 

The Organization Map prints at the selected zoom level. Large charts print 
across multiple pages.

NOTE: The Organization Map does not print in the Initial Plan Report or 
Opportunity Plan Report. You must print it from the Organization Map view 
using the right-click menu.
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Adding Customer Milestones
Milestones are formal steps in the customer’s buying process. The Customer 
Milestones view helps sales professionals identify and track customer requirements 
that must be met as the sales cycle progresses. After the milestones are set, use the 
Our Activities list to target specific activities that need to be accomplished to meet 
each milestone. These activities might include formal presentations, product 
demonstrations, benchmarks, proposals, and other activities required to make the 
sale. Figure 8 shows the Customer Milestones list, and the activities associated with 
the selected milestone in the Our Activities subview list.

Milestones are similar to Activity Plan templates that are created with predefined 
activities. For example, the initial milestone, Request Offering, is associated with 
recommended activities to be performed by you and your sales team. These 
activities might include understanding the problem or opportunity, defining the 
customer’s Compelling Event and confirming the budget, completing an 
opportunity assessment, and developing an organization map for the customer’s 
business. 

Figure 8. Customer Milestones View with Associated Activities
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A sample of customer milestone types is included with the Siebel Sales application. 
Your administrator can change the milestones, based on your business needs. You 
and your sales team can create, edit and delete activities associated with the 
milestones that address the opportunity.

To add a milestone

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity.

2 Click the Target Account Selling view tab.

3 From the Show drop-down list, select Customer Milestones.

4 In the Customer Milestones list, add a new record.

The current date appears in the Date field. 

5 In the Event field, select the type of event from the list, and then click Save.

A set of suggested activities appears in the Our Activities list. You must save 
the type of event for the activities to appear.

6 In the Description field, enter a description of the milestone event.

7 In the Customer Responsibility field, choose the customer contact who is the key 
contact and owner of the milestone event.

Repeat the procedure until you have entered all key milestone events. Review the 
recommended activities for each milestone before adding new milestones.

To add associated activities to each milestone

1 Follow the procedure, “To add a milestone,” to create a customer milestone.

2 In the Our Activities list, add a new activity record and complete the fields.

a In the Type field, choose the activity type from the list.

b In the Display In field, choose where you want the activity to appear.

Options are Activities Only, Calendar and Activities, and To Do and Activities. 
If you choose Calendar and Activity as the display method, you must enter a 
start date for the activity for it to appear in the calendar.
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c In the Resources text field, describe the resources required to support the 
activity.

d If the activity will be delegated, for example, from a manager to a member of 
the sales team, click the hyperlink in the Owner field, and query for the new 
owner in the Employees list.

The default owner is the User ID of the activity creator.
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Developing a Relationship Strategy
Information captured in the Relationship Strategy view helps sales professionals 
develop a relationship strategy for each of the key players for an opportunity. The 
view allows sales teams to share their understanding of the business and personal 
decision issues for each contact.

To add relationship strategy information

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity.

2 Click the Target Account Selling view tab.

3 From the Show drop-down list, select Relationship Strategy.

4 In the Relationship Strategy list, click New.

5 From the Add Contacts dialog box, select the contact or contacts you want to 
add, and then click OK.

NOTE: All contacts added in the Organization Map automatically appear in the 
Contacts list, and all contacts added in the Contacts list appear in the 
Organization Map.

6 In the Relationship Strategy list, complete the Business Agenda, Personal 
Agenda and Relationship Strategy fields for each contact.

You only need to complete this information for key players in the organization, 
based on their role, level of influence, and rank.

To add decision criteria

1 In the Relationship Strategy list, select a contact.

2 In the Decision Criteria Key Issues list, click New.

3 In the Add Issues form, click Go. 

4 In the Add Issues dialog box, select the issue, and then click Add.
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5 In the Decision Criteria list, complete the Rank and Comments fields for the 
issue.

6 Drill down on the hyperlink in the issue Name field to view more information.

NOTE: The administrator may want to create a record called Custom that users 
can select from the list of decision criteria. This record can be used to track 
issues that are unique to the contact and do not already exist in the database.
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Viewing PRIME Activities
The PRIME Activities view helps sales professionals develop the necessary action 
steps to execute the strategy and win the opportunity. The PRIME acronym 
underscores the initiatives that are used: 

■ Prove your value

■ Retrieve missing information

■ Insulate against competition

■ Minimize your weaknesses

■ Emphasize your strengths

These activities can be assigned with due dates to members of the sales team and 
automatically appear in individual calendars and activity lists. Use this view to 
update the entire sales team, and to measure progress while implementing the sales 
strategy. 

All the activities created in the PRIME Activities view automatically appear in the 
Activities view associated with the opportunity. Your sales organization may wish 
to standardize on one of these views

Activities created in the Our Activities list in the Milestones view also appear in the 
PRIME Activities list, providing a method for tracking. (In the Customer Milestones 
list, you must select the milestone to see the associated activities.) 

Using this view, you can create activities that are not specific to milestones, such as 
follow-up actions associated with Assessments and the Organizational Analysis.

To add PRIME activities

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity.

2 Click the Target Account Selling view tab.

3 From the Show drop-down list, select PRIME Activities.

4 In the PRIME Activities list, add a new record and complete the fields.

Identify the actions and resources required to implement your strategy, and then 
select a member of your sales team who is responsible for the activity.
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Adding Notes
The Notes view consolidates comments (for example, notes and directions) created 
by various members of the sales team. These can be marked for general viewing or 
can be kept private. The Notes view allows the sales team to aggregate and track 
observations about the opportunity throughout the sales process.

To add a note

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity.

2 Click the Target Account Selling view tab.

3 From the Show drop-down list, select Notes.

4 In the Notes list, add a record, and in the new record, add a description.

5 From the drop-down list, select Public Notes or Private Notes.
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Creating TAS Opportunity Plan and Initial Plan Reports
You can automatically create reports to make it easier to review your TAS plans. 
These can be printed or emailed to share with your sales team. Available reports 
include the TAS Opportunity Plan and TAS Initial Plan reports. You can configure 
the Opportunity Plan report to print specific sections.

The TAS Opportunity Plan Report prints all the Assessments completed for Our 
Company and all competitors on the three most recent dates. The TAS Initial Plan 
Report prints all the Assessments completed for Our Company and all competitors 
on the one most recent date. 

Using the separately licensed Proposals module, you can apply the TAS Proposal 
Template to generate an editable Microsoft Word document of the TAS Opportunity 
Plan Report.

To create a report

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity.

2 Click the Target Account Selling view tab.

3 From the application-level menu, choose View > Reports.

The Reports dialog box appears.

4 From the Select a Report drop-down list, select the report, and then click Run.

■ To print specific sections of the Opportunity Plan report, click the check 
boxes associated with the sections in the Configure Opportunity Plan dialog 
box, shown in the following figure, and then click Finish.
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This chapter describes how sales professionals can use Miller Heiman's Strategic 
Selling methodology within the Siebel Sales application to close new business. The 
Strategic Selling module is a separately licensed product. Using the Strategic Selling 
module, sales professionals can enter sales objectives, assess buying influences, 
understand their competitive position, and create an action plan to execute the 
competitive strategy. This information is available in a report, called the Blue Sheet. 
For information on Strategic Selling administrative tasks, see Applications 
Administration Guide.
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Using Strategic Selling to Support the Sales Process
The Strategic Selling software module in Siebel Sales provides full support for the 
Strategic Selling methodology from Miller Heiman. Sales professionals can reinforce 
and use the Strategic Selling sales process within Siebel Sales, applying the sales 
methodology and other sales tools to close new business. 

Siebel Strategic Selling software provides the following features:

■ Support for the Strategic Selling methodology (a separately licensed service 
available through Miller Heiman, Inc.)

■ Assessment of the opportunity compared to the ideal criteria

■ Analysis of key contacts and development of a relationship strategy

■ Tools to improve your position based on your sales objective

■ Support in developing an action plan to execute your sales strategy

■ Automatic generation of a Blue Sheet report 
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Strategic Selling Views and Procedures
The Strategic Selling module consists of five views and a number of subviews. 
Information provided in these views comprises the Strategic Selling methodology. 
A Blue Sheet Report can be automatically generated from the Strategic Selling 
module.

The procedures associated with the following Strategic Selling views describe how 
to use the Strategic Selling module.

1 Single Sales Objective. Position form with Ideal Customer Assessment and Ideal 
Customer Criteria subviews. For more information, see “Meeting the Single Sales 
Objective” on page 304.

2 Buying Influences. For more information, see “Adding Buying Influences 
Information” on page 306.

3 Position Summary. With Information Needed subview. For more information, see 
“Adding Position Summary Information” on page 307. 

4 Possible Actions. For more information, see “Adding Possible Actions” on 
page 308.

5 Best Actions. For more information, see “Viewing and Adding Best Actions” on 
page 309.

■ Blue Sheet Report. For more information, see “Creating a Blue Sheet Report” on 
page 310.
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Business Scenario for Strategic Selling
This scenario provides an example of the business process performed by a sales 
manager using Strategic Selling. Your company may follow a different process 
according to its business requirements.

A sales representative joins the sales team for a new opportunity. Before he makes 
any calls into the account, the sales representative plans to perform a Miller Heiman 
Strategic Selling analysis of the opportunity. The sales representative locates the 
opportunity in his opportunity list and then selects the Strategic Selling view tab.

Single Sales Objective
In the Single Sales Objective view, the sales representative reviews the information 
typically shown at the top of the Strategic Selling Blue Sheet. He gauges his general 
feeling about the opportunity. He notes that two fields have been carried over from 
the Siebel account form—the dollar volume of business that he is currently doing 
with the account and the amount that he plans to do with the account over the next 
year or more. These two fields are read-only. 

The sales representative proceeds to assess his competitive position and determines 
the timing for his priorities. He selects the Strategic Selling Assessment template 
and evaluates the opportunity to determine how it compares against an ideal 
customer. Based on his evaluation, the opportunity is automatically scored.

Buying Influences
The sales representative then navigates to the Buying Influences view. Contacts 
associated with the opportunity automatically are shown in the view. He adds new 
contacts and assesses his relationship strategy with each of them. Each contact can 
play a variety of roles in the evaluation, and each buyer can have a reason for 
participating in the evaluation. The personal win and business results tell the sales 
representative and his team the benefits for his contact, and the ratings show how 
well the sales representative has covered all aspects of the opportunity. The sales 
representative then enters evidence to support his ratings.

Position Summary
In the Position Summary view, the sales representative completes a description of 
his company’s strengths and weaknesses (red flags) in the deal. He also identifies 
information required to close this opportunity.
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Possible and Best Actions
Now that he has set his Single Sales Objective and completed his customer and 
competitive analysis, the sales representative creates an action plan for his team to 
win this opportunity. He goes to the Possible Actions view and adds a list of possible 
actions generated during a collaborative session with his team. The actions the 
team will take are marked Best. These automatically appear in the Best Actions view 
where the sales representative assigns them to sales team members and marks the 
due date for each action. These activities automatically appear on the assignee’s 
calendar, to-do list, or activities list, based on the choice in the Display In field for 
each activity. The sales representative can check this list at any time as the deal 
progresses to track the status of the activities.

Blue Sheet Report
After the sales representative has finished entering and updating his Strategic 
Selling information, he can generate a Blue Sheet report that he can print or email 
to share with his team.
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Meeting the Single Sales Objective 
Siebel Strategic Selling helps sales professionals meet their sales objectives for the 
account. By assessing and testing their position, sales professionals can make sure 
their sales teams evaluate the probability for meeting the Single Sales Objective, as 
taught in the Miller Heiman Strategic Selling process. The software module also 
helps sales professionals analyze whether or not they are working on the right sales 
objective, or an objective where closing the deal meets both the customer's needs 
and the sales professionals' long-term goal for the account. Sales professionals can 
evaluate the opportunity compared to an Ideal Customer profile, providing an 
understanding of their position and underscoring the best strategy to take.

To assess your position

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity.

2 Click the Strategic Selling view tab.

The Strategic Selling Position form, Ideal Customer Assessment list, and Ideal 
Customer Criteria list appear with the Opportunity form.

3 In the Position form, complete the fields to identify the competition for the 
opportunity and assess your position.

The following table describes the fields in the Position form.

Field Comments

Adequacy of Current Position Select the value that best describes how you feel 
about your current position. Examples of values 
are Euphoria, Great, OK, Secure, Comfort, and 
Worry.

My Position vs. Competition Select the value that describes your position 
compared to your key competitors. Examples of 
values include Only Alternative, Front Runner, 
Shared, and Zero.

Timing for Priorities Select the value that describes the timing for your 
priorities. Examples are Urgent, Active, Work It In, 
and Later.
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Assessment criteria are taught by Miller Heiman instructors in the Strategic 
Selling methodology workshop.

4 In the Ideal Customer Assessment list, click New.

5 In the new record, click the select button in the Name field to choose the Ideal 
Customer Criteria template, and then click Save. 

An explicit Save is required for the assessment criteria to appear.

6 In the Ideal Customer Criteria list, query to select a value for each assessment 
criterion.

The following illustration shows an Ideal Customer Assessment record, and the 
Ideal Customer Criteria list shows the criteria associated with the assessment.

Click the select button in the Value field to view each value and its description. 
The opportunity assessment is automatically scored based on the selected 
values.

The Assessment Score and its percentage of the Max Score, defined in the 
Assessment template, appear in the Ideal Customer Assessment list.
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Adding Buying Influences Information
The Buying Influences view helps sales teams identify the role each contact plays 
and each contact’s reason for participating in the project. The personal win and 
business results recorded in this view help the sales professional to understand the 
outcome benefit for the contact. By understanding the business and personal 
agendas of their contacts, sales professionals can form effective relationships and 
consider where to dedicate resources.

To add buying influence information

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity.

2 Click the Strategic Selling view tab.

3 From the Show drop-down list, choose Buying Influences.

4 In the Buying Influences list, click New.

5 In the Add Contacts dialog box, select contacts you want to add, and then click 
OK.

To enter new contacts, click New in the Add Contacts dialog box.

6 In the Buying Influences list, complete the fields for the contact.

a Indicate the role of the contact by placing a check mark in each applicable 
field.

Fields include Economic Buyer, User Buyer, Technical Buyer, and Coach.

b Enter information in the Personal Win and Business Results fields for each 
contact.

c Select a Rating and Mode for each contact.

Examples of Rating are +2 Interested, and +4, Strongly Supportive. 
Examples of Mode are Growth, Trouble, and Overconfident.

d Enter your Evidence to Support Rating in the text field.
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The Position Summary view helps sales professionals identify Red Flags and 
Strengths to use in the opportunity. With this information, you can identify and 
track information needed to improve your competitive position.

To add position summary information

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity.

2 Click the Strategic Selling view tab.

3 From the Show drop-down list, choose Position Summary.

4 In the Position Summary form, complete the Strengths and Red Flag fields.

Strengths and Red Flags help you determine your strengths and weaknesses for 
closing this opportunity.

5 In the Information Needed form, click New.

6 In the new record, identify what information is needed, and designate a source 
for the information in the What and From Whom fields.

NOTE: Records in the Information Needed list also appear in the Activities list for 
the opportunity. The Activity Type is Information Needed.
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Adding Possible Actions 
In the Possible Actions view, the sales team can brainstorm feasible actions for 
advancing an opportunity and then create an action plan based on Best Actions.

To add possible actions

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity.

2 Click the Strategic Selling view tab.

3 From the Show drop-down list, choose Possible Actions.

4 In the Possible Actions list, click New.

A new row appears in the Possible Actions list.

5 In the new record, select the check box in the Best field to mark this action as 
best.

All actions flagged as Best appear in the Best Actions view.

6 In the What field, enter a description of the action.

Repeat Step 5 through Step 6 to enter all the best actions your sales team can 
accomplish.
308 Siebel Sales User Guide Version 7.5, Rev. A



Strategic Selling

Viewing and Adding Best Actions
Viewing and Adding Best Actions 
The Best Actions view presents the actions in the Possible Actions view that the 
sales team has selected as the best choices to advance the opportunities. This view 
helps keep the entire sales team on the same page by providing one location for 
action planning and logging status. You can assign best actions to people on your 
opportunity team and these actions appear in their activities list. It also helps teams 
monitor cumulative progress towards sales goals.

To add best actions

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity.

2 Click the Strategic Selling view tab.

3 From the Show drop-down list, choose Best Actions.

The possible actions you previously selected as best automatically appear in the 
Best Actions list.

4 Click New in the Best Actions list, and complete the fields for the new record.

The following table describes the fields for a Best Action.

Field Comments

What Enter the description of the action in the text field. This description appears 
in the Activities list for the Opportunity. You can set the Display field to 
display the best action in your Calendar and Activities lists, your To-Do and 
Activities lists, or Activities Only.

Who The default is the user that created the Best Action. You can assign the 
action to another employee or person on your sales team.

Start Automatically populated. An action must have a start date to appear in the 
Calendar.

Due Click the Calendar control and choose the completion date for the action.

Status Indicate the status for an action by selecting it from the list of values.

Display Indicate where you want the action to appear by selecting from the list of 
values. Options are Calendar and Activities, To-Do and Activities, and 
Activities Only. The default is Calendar and Activities. 
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Creating a Blue Sheet Report
Creating a Blue Sheet Report
The Blue Sheet uncovers and communicates key information at a glance. It helps to 
focus your team’s attention on essential business and contact information. You can 
print the Blue Sheet or email it to your manager and team in report format or as an 
HTML document.

To create a Blue Sheet report

1 Navigate to the Opportunities screen, and in the Opportunities list, select the 
opportunity.

2 Click the Strategic Selling view tab.

3 From the application-level menu choose View > Reports.

4 In the Reports dialog box, select the Blue Sheet report, the language and locale.

5 Click Run Now.

Click Schedule to run the report at a later date and time.

For more information on creating reports, see Siebel Reports Administration Guide.
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account assessment, completing 45
account categories 175, 177
accounts

account assessment, completing 45
activity, associating with an account 42
business scenarios 36, 37, 52, 92, 210, 

224, 238, 251, 275, 302
contacts, adding to account 41
creating 38
defined 35
global 48
manager approval, viewing 270
offerings, adding to Business and Service 

Units 255
opportunity, adding to 43
partners, adding 264
references, designating as 240
updating information in external 

systems 46
viewing credit profile information 47

actions, selling plans 308, 309
activities

business scenario 124
defined 124
delegating 129
messages and activities, associating 143
new activity, creating 125
references, adding to 241

activity plans 132
alerts

assigning to a message 138
message alerts, sending 138

ASI 33
accounts 46
contacts 33

assessments
opportunity, associating to 71
Target Account Selling, completing 280

attachments
contact, associating with 29
literature, enclosing with 

correspondence 153
literature, sending as email 

attachment 170
messages, associating a message 

with 142
reference attachments, viewing 242, 

243
audience of guide 11
Auto Quote 183

B
best actions view, adding 309
billing address, adding to quote 207
Browse Catalog 187
Business and Service Unit, adding 253
business scenarios

accounts 36, 37, 52, 92, 210, 224, 238, 
251, 275, 302

activities 124
competitors 112
contacts 22
correspondence 146
D&B data scenarios 92
decision issues 106
Enterprise Selling Process 251
literature 168
messages 134
opportunities 53
presentations 224
products 116
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proposals 210
quotes 180
Strategic Selling 302
Target Account Selling (TAS) 275
tracking information with 

categories 174
buying influence information 306

C
categories

See also accounts; contacts; opportunities
about 173
business scenario 174

competitive analysis
company comparisons, viewing 114
customer questions and opportunities, 

associating 108
information, adding and updating 283

competitors
business scenario 112
competitor comparisons, viewing 114
opportunity, associating with 113

contacts
account, associating with 27
accounts, adding to 41
adding 23
attachment, associating with 29
business scenario 22
buying influence information, 

adding 306
categories, adding 175, 177
defined 21
opportunity, adding to 74
opportunity, associating with 28
organization charts, adding to 79
profile, creating and defined 31
promoting personal 30
recipients, adding to 

correspondence 152
sync list, adding to 32

updating information in external 
systems 33

correspondence
business scenario 146
creating 147
fulfillment center, sending 

correspondence to 158
fulfillment requests, monitoring status 

of 159
labels, previewing 157
letter templates, creating 147
letter, previewing 157
literature, enclosing 153
personal correspondence templates, 

creating 161
recalling 160
recipients, adding 152
server, requesting literature files 

from 154
credit profile

accounts 47
customer acquisition

D&B 92

D
D&B integration

about D&B data 94
business scenarios 92
D&B accounts, promoting 96
D&B report, viewing 98
data, viewing 95
D-U-N-S number, about 94
prospect lists, creating 97

D&B. See D&B integration
Data Universal Numbering System (D-U-N-

S), about 94
decision criteria, adding 294
decision issues

business scenario 106
details, displaying and screen 

example 108
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E
email

email messages, sending 144
literature attachments, sending 170

Enterprise Selling Process
Business and Service Unit, adding 253
business scenario 251
manager approval, viewing 270
offerings, adding to Business and Service 

Units 255
organizational analysis 258
overview 250
partners, adding 264

ESP. See Enterprise Selling Process

F
fax, literature attachments, sending 170
fulfillment centers

correspondence, sending to 158
requests, monitoring status of 159

G
Global Accounts 48
guide

audience of 11

K
key concepts, TAS methodology 274
key product features, viewing product 

information 117

L
labels

previewing 157
templates, creating 147

letters
personal correspondence templates, 

creating 161
previewing 157
templates, creating 147

line items. See quote line items

literature
business scenario 168
correspondence, enclosing with 153
email, sending as attachment 170
viewing 169

locking presentations 236
locking proposals 222

M
mail merge fields, about creating 161
manager approval, viewing 270
marketing resources, balancing tool 253
messages

activities, associating with 143
alerts, assigning to a message 138
attachments, associating with 142
business scenario 134
email messages, sending 144
marked as private, about 134
message alerts, sending 138
messages you created, viewing 139
new messages, creating 136
opportunity, associating a message 

with 141
your messages, viewing 139

methodology, Target Account Selling 274
Microsoft PowerPoint

presentation component file, 
modifying 233

proposal components, modifying 220
Microsoft Word

proposal draft, editing 213, 227
milestones, adding 292

N
New Contact form, adding additional 

information 23

O
offerings, adding to Business and Service 

Units 255
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opportunities
account, adding to 43
assessment, associating to an 

opportunity 71
Auto Quote, using 183
business scenario 53
categories, adding 175, 177
competitors, associating with 113
contacts, adding to an opportunity 74
defined and examples 51
message, associating a message 

with 141
position summary information, 

adding 307
primary team member, changing 69
products, associating to an 

opportunity 76
proposals, creating 212
Sales Pipeline Analysis graph, 

displaying 87
Sales Pipeline Phases graph, 

displaying 88
single sales objectives, adding 304
strategy sessions, adding actions to 308
tactics, adding 296

orders
billing information, adding 207
quotes, creating from 206
shipping information, adding 207

organization chart, viewing 288
organization charts, maintaining 79
organizational analysis

about 258
creating 258, 287

P
partners, adding 264
personal correspondence templates, 

creating 161
position summary information, 

adding 307
presentation

locking 236

presentation components
adding from other locations 232
defined 228
modifying 233
from Presentation Table of Contents 231
sequence numbers, role of 229
from Siebel Encyclopedia 232

presentation sections
defined 228

Presentation Table of Contents 231
presentations

business scenario 224
creating 226
overview 225
printing 235
structure, viewing 228

primary team member, changing 69
printing presentations 235
printing proposals 221
product image, viewing 117
products

Browse Catalog, adding products 187
business scenario 116
opportunity, associating to 76
product comparisons, viewing 118
product information, viewing 117
quotes, customizing 197

profile, contacts, creating for 31
proposal components

adding from other locations 219
defined 214
modifying 220
from Proposal Table of Contents 217
sequence numbers, role of 216
from Siebel Encyclopedia 218

proposal sections
defined 214

proposals
business scenario 210
components, adding 217
creating 212
defined and overview 211
locking 222
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printing 221
proposal draft, generating and 

editing 213, 227
structure, viewing 214

Proposals Table of Contents 217
prospects

lists, creating from D&B data 97

Q
quote line items

about 184
Browse Catalog, adding products 187
line item details, adding 184, 195

quotes
assistance 203
bill to, adding information 207
Browse Catalog, adding products 187
business scenario 180
creating 181
customized quotes, saving 198
customizing quotes 197
generating from opportunities (Auto 

Quote) 183
orders, converting to 206
repricing 202
revising 202
shipping, adding information 207

R
references

about 239
accounts, designating as reference 240
activities, adding 241
attachments, viewing 242, 243

repricing quotes 202
revenues

charts, viewing 88

S
sales methods, about 61

sales pipeline graphs
Sales Pipeline Analysis, displaying 87
Sales Pipeline Phases, displaying 88

sales stages, selection criteria 44
sales strategy workflow diagram 19
sales tactics, adding 296
Save as Favorite function 198
shipping information, adding 207
Siebel Encyclopedia

presentation components, adding 232
proposal components, adding 218

Siebel Enterprise Selling Process (ESP). See 
Enterprise Selling Process

single sales objective, entering 304
Strategic Selling

best actions, adding 309
business scenario 302
buying influence information, 

adding 306
overview 300
position summary information, 

adding 307
possible actions, adding 308
single sales objective, entering 304

T
Target Account Selling

See also TAS tools
business scenario 275

TAS tools
assessment, completing 280
competitive analysis information, 

adding 283
decision criteria, adding 294
milestone, adding 292
organizational analysis, creating 258, 

287
tactics, adding 296
Target Account Selling overview, 

completing 278
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alternate templates for 

presentations 226
letter and label templates, creating 147
personal correspondence templates, 

creating 161

W
Word. See Microsoft Word
workflow

sales strategy diagram 19
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